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Audience

Preface

This user manual isintended for devel opment engineers who create components for use with
SoC Designer, Synopsys Platform Architect, or SystemC. It assumes familiarity with the follow-
ing technologies:

» Hardware design verification

e C/C++ programming language

* Verilog programming language

» The Cycle Model Compiler

About This Guide

This guide provides all the information needed to compile RTL as Cycle Moddls, generate plat-
form-specific components, and manage interactions between Cycle Models and platforms. The
following chapters are included:

e Chapter 1. Introduction

»  Chapter 2. Understanding the Cycle Model Studio Interface

e Chapter 3. Compiling RTL into a Cycle Model

»  Chapter 4. Creating Components for Specific Platforms

* Appendix A. ARM-supplied Transactors for SoC Designer

* Appendix B. User-Defined Transactors with SoC Designer

» Appendix C. ARM-Supplied RTL Models
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Conventions

This book uses the following conventions.

optional text.

Convention Description Example

courier Commands, functions, sparseMem t SparseMemCreate-
variables, routines, and New () ;
code examples that are set
apart from ordinary text.

italic New or unusual words or Transactor s provide the entry and exit
phrases appearing for the pointsfor data...
first time.

bold Action that the user per- Click Closeto close the dialog.
forms.

<text> Values that you fill in, or <platform>/ represents the name of
that the system automati- various platforms.
cally supplies.

[ text] Square brackets[ ] indicate | SCARBON_HOME/bin/modelstudio

[ <filename> ]

[ textl | text2 ]

The vertical bar | indicates
“OR,” meaning that you
can supply textl or text 2.

SCARBON_HOME/bin/modelstudio
[<name>.symtab.db |
<names>.ccfg ]

Also note the following references:

» Referencesto C codeimplicitly apply to C++ aswell.

* Cdide, Sside, and test side refer to code or operations written in C or originating in C. Sim-

ilarly, simulation side refers to code and operations residing within the simulation side of

the verification environment.

* Filenamesendingin .cc, .cpp, or .cxx indicate a C++ sourcefile.
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Additional Documentation

listed in the following table.

Document

Contents

Cycle Model Sudio Installation
Guide

Providesinstructions for installing the Cycle
Models software products, as well asinforma
tion about system reguirements, environment
variables, and licensing.

Carbon Transactors Overview

Overview of architecture and usage of some of
the ARM transactors.

Transactor User Manuals

Many manuals describing the interfaces, regis-
ters, 1/0O, packet handling, and validation envi-
ronments for the supported transactors.

Using Carbon Transactors with
SystemC

Describes the process for integrating Cycle
M odels containing transactors into a SystemC
environment.

Cycle Model Sudio SystemC
User Manual

Describes the process for integrating a Cycle
Model into a SystemC devel opment environ-
ment, and examines the case of replacing an
existing module in a design with a Cycle
Model.

ARM Cycle Model API Reference

Information about Cycle Model API files, data
types, and functions.

ARM Cycle Modd Sudio System
API Reference

The Cycle Model Studio System APl isa
library of C functions that allows you to man-
age Cycle Model componentsin asimulation
system.

ARM Cycle Model Database API
Reference

C library to access the Cycle Model database.

RTL Syle Guide

How to write your code to optimize runtime
performance.

ARM provides extensive documentation covering the installation of Cycle Models products, the
use of transactors, and performance enhancements. Documents supporting these features are

ARM DUI 0958E
ID111516
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Glossary

C-sde/S-side

Cycle Model

Cycle Modél
Studio

Component

ESL

HDL

io.db

RTL

SOC or SoC

SoC Designer

S2T

symtab.db
T2S

Transactor

Software side. The environment that controls the transactors via
interface modules.

A software object created by the Cycle Model Studio (or Cycle
Model Compiler) from an RTL design. The Cycle Model contains a
cycle- and register-accurate model of the hardware design.

Tool for the automatic generation of hardware-accurate software
models. It creates a Cycle Model, and it also takes a Cycle Model as
input and generates a component that can be used in SoC Designer,
Platform Architect, or SystemC for simulation. It is a graphical tool,
providing a user-friendly method to manipulate ports, registers and
memories; add transactors to the Cycle Model; and set up variables
for profiling.

Building blocks used to create simulated systems. Components are
connected together with unidirectional transaction-level or signal-
level connections.

Electronic System Level. A type of design and verification methodol-
ogy that models the behavior of an entire system using a high-level
language such as C or C++.

Hardware Description Language. A language for formal description
of electronic circuits, for example, Verilog.

Theio.db isasubset of the full symtab.db. It includes only the design
1/Os, clocks, and any nets that were specified in directives.

Register Transfer Level. A high-level hardware description language
(HDL) for defining digital circuits.

System-on-a-Chip

High-performance, cycle accurate simulation framework which is

targeted at SOC hardware and software debug aswell as architectural
exploration.

Signal-to-transaction. The component drives the transaction into the
SoC Designer or Platform Architect environment.

A symtab.db file is a database of the entire design.

Transaction-to-signal. SoC Designer or Platform Architect drivesthe
transactions into the component.

Transaction adaptors. You add transactors to your component to con-
nect your component directly to transaction level interface ports for
your particular platform.
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Chapter 1

Introduction

The Cycle Model Sudio is agraphical tool designed for the generation of hardware-accurate
software models. It is designed to simplify the task of compiling an RTL hardware model into a
Cycle Model, generate platform-specific components for simulation environments (such as SoC
Designer, Platform Architect, and SystemC), and tune Cycle Models for optimal performance
during simulations.

1.1 Virtual Prototype Methodology

Figure 1-1 shows how Cycle Model Studio shortens the design flow process by running RTL
and software debugging tasks concurrently.

ARM DUI 0958E
ID111516

Copyright © 2016 ARM Limited. All rights reserved. 17
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Traditional Debug Methodology

Architecture >> RTL Design>> RTL Debug>> Fab>> SW Debug >

! !

Architectural Physical
Model Prototype
Available Available

Virtual Prototype Methodology

Architecture >> RTL Design>> RTL Debug>> Fab>
! ! !

Architectural > SW Debug >
Model
Available ¢
Virtual Physical
Prototype Prototype
Available Available

Figure 1-1 Virtual Prototype Benefits

Asyou can seein the figure, using the Cycle Model Studio enables you to perform software

debugging earlier in the cycle so that your fina product is available sooner. Also, some addi-

tional RTL debug issues may be uncovered during software debug.

The Cycle Model Studio Graphical User Interface (GUI) manages all aspects of the Cycle

Model compile and runtime processes.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved.
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1.2 Overview of Cycle Model Studio Functions

Figure 1-2 is used throughout this manual. Red borders surrounding a yellow Cycle Model Stu-
dio component indicate which Cycle Model Studio function is being described in the chapter.

Cycle Cycle Model
(Leten ) => vt Sl => | Joomme

libdesign.lib

Cycle -
: SoC Designer Iﬁu,
Model Studio E") -
Component Glatfé)rr;[:\rrr]%hlte(DE> Component
Generator y

Cycle Model Studio
Component Tuning

Figure 1-2 Cycle Model Studio Process Flow

The overall processis described below:

1. CreateaProjectin Cycle Model Studio, and then add the Verilog design and library filesto
the project.
2. Compile the project using the Cycle Model Compiler. This creates the Cycle Model.

3. Generate a component that is compatible with your simulation environment. Cycle Model
Studio supports SoC Designer, Platform Architect, and SystemC.

4. Configure the generated component. This enables you to specify the connection interface
between your Cycle Model and your simulation environment.

5. Run and tune your simulation using the component.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 19
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1.3 Understanding Cycle Model Studio Configuration Options

Cycle Model Studio can be configured to run in either of the following ways.

*  Running the compile functions on a Linux server and running the post-compile functionsin
a Microsoft Windows environment.

*  Running both compile and runtime functions on a Linux server.

Refer to the Cycle Model Sudio Installation Guide for more information regarding these
options.

1.4 Starting Cycle Model Studio

You should follow the instructions in the Cycle Model Sudio Installation Guide to make sure
you have installed all components successfully, and that the appropriate environment variables
have been set, before starting Cycle Model Studio.

Follow the steps below to start Cycle Model Studio:

For Linux, from your working directory, enter:

${CARBON HOME}/bin/modelstudio

For Windows:
From the Sart Menu, select Programs ->ARM ->Cycle Model Studio
or

From Windows Explorer, go to the location where Cycle Model Studio isinstalled (the
CARBON_HOME), go to the \Win\bin directory, and launch modelstudio.exe.

ARM DUI 0958E
ID111516
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Chapter 2

Understanding the Cycle Model Studio Interface

Cycle Model Sudio provides an integrated environment that places system validationin parallel
with the hardware development flow. The Cycle Model Compiler within the Cycle Model Stu-

dio takes an RTL hardware model and creates a high-performance linkable object, called a

Cycle Modd, that is both cycle and register accurate. The Cycle Model provides the capability
for interfacing with your validation environment.

In addition, Cycle Model Studio can compile models that are compatible for use with specific

design platforms, such as SoC Designer, Synopsys Platform Architect, and SystemC.

The Cycle Model Studio supports a variety of Compile and Runtime functions. Compile func-
tionsinclude:

Loading Projects and Files
Configuring Compile Settings
Assigning Directives
Checking code

Compiling the Cycle Model

The Cycle Model Studio Runtime functionsinclude:

Running Cycle Models

ARM DUI 0958E
ID111516
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2.1 Reviewing GUI Features and Functions

The Cycle Model Studio graphical user interface (GUI), shown in Figure 2-1, includes a Menu
bar, Toolbar, and a variety of Viewsthat can be docked or undocked to suit your viewing prefer-

ences.
Project Explorer view Main Menu Toolbar Properties view
Project6.carbon  .dM Cycle Model Studio - [SOC Desiner Component] x
amm File Edit jew Build Project Model Kits Window Help ElEE]
o e N e D [Defaurt 5 - © E s
ave ec| mpile = SoC Designer CoWare SystemC Delete
Project Explorer ® Aibdesian.svmtab.db\ .. Propertiey E]
x = C ; [ & ‘ - sic Desfaner Component Properties | G |
~ (# Project6.carbon _ |iDeletc;| (e ey TRnsactor: (AHE. Lite Master E32T....0, | | Add Transactor | | Add Parameter | |:= || nlb [ Reset All || Reset
~ == ARM Cycle Model: libdesi... S— L )\ ) p— = =
(4 libdesign.symtab.db Item Id/Value Size Mode Type Ham b
L d=] ffqeratgd Files ~ Cumpo_nent Ports ‘ - Concﬁgingr;tm-sﬁzeg;aatiosn
_;Sb e 1 3 ﬁ:ﬂi Eﬂggiiiﬁtﬁlﬂi : Export tu,spystem?: fal |
< == SoC Designer Component (© poutl bugs493_01.poutl 1 Include Files
=# libdesign.ccfg c ‘gppoutZtP . bug8493_01.pout2 1 ;lg:f(f;;ﬁg:
‘:ﬁ mx:buges9s ol.h - i:r;en arameters . . Use Static Schedulin fal
B i, ||| P Main view ettt
Clock Generators Component Type Of|
Loadfile Extension
Transactar Nafinition File [~
( [2)
\Portﬁ/ \Register? \Memoriey \ProfiI?‘
Console [E5]
$CARBON_HOME/bin/make -f Makefile.carbon Start Finished -
make: *** empty string invalid as file name. Stop.
Error: Makefile finished with exit status = 2
Error List view
Vconsole Error List
[ S—
. Design Hierarchy view
Console view g y
Figure 2-1 Cycle Model Studio Graphical User Interface
The Cycle Model Studio Main menu provides access to the main functional areas of the GUI.
File Edit View Build Project Model Kits Window Help
» File- Open, close, or import projects and files.
« Edit - Perform cut, copy, paste, and editing functions. Set Model Studio preferences.
* View - Show or hide the different view windows.
» Build - Check your code and compile your project into a Cycle Model.
» Project - Manage project settings.
* Window - Move the focus to open windows.
» Help - Open the Cycle Model Sudio User Manual PDF, or view version information.
ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 22
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2.1.1 Using the File Menu

Use the File menu to:

Create new projects and files

Open existing projects and files

Close the current project

Save the current project or file

Perform advanced find operations to find files or strings within files
Define drive mappings (for Windows users compiling on a Linux machine)
Exit the Cycle Model Studio

2.1.1.1 Creating a New Project

Selecting File > New displays the New Project dialog, shown in Figure 2-2.

~ Project from existing ARM Cycle Model Studio Command (.cmd) file
ARM ~w Project from existing ARM Cycle Model Studio database (.symtab.db .io.db)

am Project from existing ARM Cycle Model Studio CoWare Wizard (.ccfg)
~= Project from existing ARM Cycle Model Studio SoC Designer Wizard (.ccfg)
~= Model to be generated from a ARM Cycle Model Studio Model Kit (.modelKit)

(T T>)

[Empty Project |

Name: [Project? Create Directory for Project

Location: [fhome,fcds.l’projecti' ] | Browse... |
| cancel || ok |

Figure 2-2 New Project Dialog Box

Note:  Windows Only: If you are running CMS on Windows, a * Remote Compilation” panel

appears at the top of this dialog box to configure compilation of your RTL project on a
Linux machine. Select the Mapped Drive to be used to perform remote compilation of
the Cycle Model. Click Map Network Drive... to map a network drive if no drives have
been set up. See Drive Mappings on page 27 for more infor mation.

Note:  Windows Only: If the project you are working on does not need to have the RTL com-

piled using the Cycle Model Compiler on a Linux machine, you can uncheck the “ This
project will be compiled remotely” box. This enables you to configure and compile
components that run exclusively on Windows. The project types that require the Cycle
Model Compiler are removed from the list when you uncheck this box.
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To create anew project:

1. Inthe New Project dialog box, you have the following choices:

Note:

Empty Project - Select this option if you are starting a new project from scratch, and
have not previously used the Cycle Model Compiler.

Project from existing ARM Cycle Model Sudio Command (.cmd) file - Select this
option if you have an existing command file containing RTL source files and specific
compile settings, from a previous Cycle Model compile that you wish to use to start
your new project.

Project from existing ARM Cycle Model Sudio database (.symtab.db) - Select this
option if you have an existing database file from a previous Cycle Model that you wish
to use to initiate a new project.

Project from existing ARM Cycle Model Sudio CoWare Wizard (.ccfg) - Select this
option if you have an existing configuration file from the old CoWare Wizard product
and you wish to continue customization of the component.

Project from existing ARM Cycle Model Sudio SoC Designer Wizard (.ccfg) - Select
this option if you have an existing configuration file from the old SoC Designer Wizard
product and you wish to continue customization of the component.

Model to be generated from ARM Cycle Model Sudio Model Kit (.model) - Select this
option if you are using an existing .model generated from Cycle Model Studio.

You can import an existing .ccfg file into a project as well, as described on page 36. In

that case you will have accessto the RTL filesto further configure the Cycle Model. The
options above still allow customization of Component settings, but will not include RTL
source.

2. Inthe Name field, enter the name for your new project.

3. Inthe Location field, browse to the location where you will store your new project.
4. Click OK.

Note:

Select the checkbox “ Create Directory for Project” to automatically create a new
directory using the name of the project.
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2.1.1.2 Opening Projects and Files

Select File > Open to open an existing Cycle Model Studio project or file. Selecting Open dis-
plays the Open Project dialog, shown in Figure 2-3.

1. Select File>Open > Project to display the Open Project dialog (Figure 2-3), or select File

> Open > Fileto display the Open File dialog.

=] Open Project x
|E” home || Projact1|
|Places Name v Size | Modified (-]
&% Search | Linux TP
{#) Recently Used | |[@| Projectl.carbon 2.1 KB Monday
[ Desktop
[ File System
B | Carbon Project | £ |

| cancel || Open |

Figure 2-3 Open Project Dialog Boxes

2.

If you select Open and Project, browse to an existing project and click the Open button to
open that project. You can also use the Open Recent Project option to open any of the most
recently opened projects.

If you select Open and File, browseto afile of the type listed in the Files of Typefield, and
click the Open button to open the selected file in atext editor window.
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2.1.1.3 Opening a Recent Project
File> Open Recent Project provides alist of recently-opened projects. Select a project from
thelist to open that project.

2.1.1.4 Closing a Project
Select File > Close Project to close a project while keeping Cycle Model Studio open.

2.1.1.5 Saving All Files
Select File > Save All -to save all files associated with the current project.

2.1.1.6 Saving the Current File

Select File > Save to save the current file,

2.1.1.7 Using the Find Option

Select File > Find in Files... to search for specific strings within the files in your project, or
anywhere on your drive. When you select this option, the Search for string in Files dialog box
appears (Figure 2-4).

Search for string in Files

Find what:

I v

Look in:

[Entire Project -

Find options
[] Match case
] Match whole word
[ Use:
Look at these file types:

dok ok | w |

Clear console window

[ Find Al |

Figure 2-4 Search for String Dialog Box

1. Enter the string you want to find in the Find what field.

2. Define the scope of the areato be searched in the Look in field.
3. Set any additiona options you want

4. Click Find All.

The files that contain the search criteria are displayed in the Console window. Click on each
entry in the Console window to display the file that contains the string in the Main view area.
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2.1.1.8 Using the Drive Mappings option (Windows Only)

The Drive M appings... enables you to manage the Windows Network drive to Linux directory
mappings. This menu option is available only for Windows users who are compiling on a
remote Linux system. At least one drive mapping must be set up before you can define a new
project. When you select this option, the Network Driveto Unix Directory Mappings dial og box
appears (Figure 2-5).

Metwork Drive to Unix Directory Mappings E]g|

Currently defined mappings:

Rermove

[ Ok H Cancel l

Figure 2-5 Windows Network Drive Mappings Dialog Box

You can add new drive mappings or remove existing drive mappings. Click Add to add a new
drive mapping; the Map Network Drive to Unix Path dialog box appears (Figure 2-6).

Map Network Drive to Unix Path

The purpose of this dialog is ko define what the equivalent Unix path is For a netwark,
drive latter,

1. Choose a network drive letter:
Z: (siliconitonacki) |'V_*

Z1 Misilicankanacki)
1 (siliconioireleaseitest)

2. Equivalent Unix Path {i.e. /home/username)

3. Yerify connectivity and path mapping

Unix Server:
Werify, .

Username:

o [Coma

Figure 2-6 Windows Map Network Drive Dialog Box

1. Select apreviously-mapped network drive that links a Windows drive |etter to an areaon a
Linux machine.

Enter the Linux path on the machine where the project files will be located.
Enter the name of the Linux Server and the Username to be used to log in to the server.

After you have entered thisinformation, click the Verify button to verify that the mapping
is set up correctly. You must enter the password for the remote Linux server before verifica-
tion can complete.
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2.1.1.9 Exiting Cycle Model Studio

Selecting File > Exit closes all open projects and exits Cycle Model Studio. If any changes have
not been saved, you are prompted to save the changes before closing the project.

2.1.2 Using the Edit Menu

Use the Edit menu to:

* Set CycleMode Studio preferences

e Cut, copy, paste, and perform other editing functions

Note:  The editing functions are available only when an itemis open in the Main window, such
asasourcefile.
2.1.2.1 Setting Preferences

Selecting Edit > Preferences enables you to set Cycle Model Studio preferences that apply to
all created projects:

» General Preferences — Set project-wide preferences, such as behavior on startup, log file
creation, Visual Studio version, and environment variable value and application.

» Text Editor Preferences — Affect how text is displayed in the Main window.
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Figure 2-7 shows the General Preferences dialog box.

Automatically Load Design Hiearchy
General [ Automatically load changed files into the Source Code Editor
Number of logs to save: |5 ||
4 : Visual Studio Version (used to select nmake.exe) |VS2013 | w |
Text Editor o
Startup Home Page (changes will be seen on next start) |Default 2
Use the following environment variables to convert filepath(s):
@ Variables are per-Project
() Variables affect all Projects
Variable v | Current Value 4
[J CARBOMN_ARCH Linux64
[] CARBON_COMNFIGURATION Linux/Default
[J CARBON_FM_HOME fo/release/SoCD/CIBuilds/socd-master-320/Linux64/...
[J CARBON_HOME fo/release/CMS/mainline/PRODUCT
[J CARBON_NO_DIAGS e
-
[J CARBON_PROJECT fhomej/cds/Projectl =
() | Apply |[ cancel |[ ok |

Figure 2-7 Cycle Model Studio Preferences

Automatically Load Design Hierarchy — Automatically |oads the Design Hierarchy view,
described in “Using the Design Hierarchy View” on page 56, when you start Cycle Modd Stu-
dio.

Automatically load changed filesinto the Source Code Editor — If awindow in CMSis
open to asource file, and that file is changed outside of the CMS GUI, then if this optionis
enabled the window is automatically updated with the changed version.

Number of logs to save box — Enables you to specify the maximum number of log filesto
save for each project. When that number is reached, old files are deleted as new files are writ-
ten.

Visual Studio Version (used to select nmake.exe) drop-down menu — Applies only to the
Windows version of Cycle Model Studio. It allows you to specify which version of Microsoft
Visua Studio you are using. Cycle Model Studio usesthis setting to determine which version of
nmake.exe to use when building Windows SoCD components.

Use the following environment variablesto convert file path(s) — Enables you to select
environment variablesto be used in place of hard-coded file path values. This can be helpful
when multiple users are working on a single project, and when a source control systemisbeing
used.

For example, if Verilog files are stored in a source control system under the RTL directory (e.g.
RTL/CPU/filel.v or RTL/IMEM/mem?2.v), you could create the RTL_HOME environment vari-
able for each user who needs access to the source files. Asyou add files to the CM S project,
they are written into the Project file as $(RTL_HOME)/CPU/filel.v (instead of /home/cds/
tonacki/Projects/RTL/CPU/filel.v). When another user has the same environment variable set to
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their local work area, for example, /home/cds/bsmith/Projects/RTL, they are ableto successfully
open the Project file.

You can select whether the environment variables are used for the current project only, or for al
projects.

Important: This environment variable must be selected (checked) in the Preferences page
BEFORE you begin adding source RTL filesinto the project.

2.1.3 Using the View Menu

The View menu allowsyou to tailor the Cycle Model Studio user interface (Ul) to your needs by
adding or removing Ul components. To add or remove Ul components, click to select or dese-
lect the listed views.

v Design Hierarchy Chrl+T, Ctrl+D

v Console Chel+T, el
w  Error Lisk Chrl+T, CErl+E
v Project Explorer ChrlH+-T, Chrl+x
v Properties Chrl+-T, Chrl4+P

Figure 2-8 Cycle Model Studio View Menu

Note that the Main view window cannot be removed or hidden.

2.1.4 Using the Build Menu

The Build menu provides the functions needed to compile, check, recompile, and clean Cycle
Models.

2.1.4.1 Checking for Errors

Use Build > Check to check the project components, such as environment variables and paths,
for any errors prior to compiling the Cycle Model. This performs the same functions as the
Check button.

2.1.4.2 Exploring the Modules and Nets Hierarchy

Use Build > Explore Hierarchy to display modules and nets in the Design Hierarchy window
without having to first perform a compile of your RTL source. Thisis useful if you know you
will be assigning directives to the netsin your design. This option takes less time than perform-
ing a Compilein the usual way, then assigning directives to nets, and then having to Compile a
second time.
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2.1.4.3 Compiling

Use Build > Compile to compile Verilog RTL into a Cycle Model. The compiler uses the cur-
rently-selected Configuration (and all defined settings) to perform the compilation. On Win-
dows, you are prompted to configure remote server information — refer to “ Reviewing Remote
Compile Requirements’ on page 60.

See“ Configuration Manager” on page 34 for more information on defining configurations. This
performs the same functions as the Compile button.

2.1.4.4 Stopping Compilation
Use Build > Stop Compilation to cancel any compilethat isunderway. This performsthe same
functions as the Stop button.

2.1.4.5 Recompiling
Use Build > Recompile to clean out previously generated files (using the Clean functionality
described below), and then compile the Cycle Model.

2.1.4.6 Using Batch Build...

Use Build > Batch Build... to build al defined configurations. When you select this option, the
Batch Build dialog box appears (Figure 2-9).

®:Default Euild
® Optimized —

Rebuild

Clean

Select All

Deselect All

Close

Figure 2-9 Batch Build Dialog Box

All defined configurations appear in this dialog box. Select or deselect the configuration that
you want to compile and then click Build. See “ Configuration Manager” on page 34 for more
information on defining configurations.

2.1.4.7 Cleaning Files

Use Build > Clean to remove al files generated during a compile. This option removes all old
filesthat could possibly be stale. Note that the next compile will take a much longer time than
usual, in order to create al the files from scratch again.
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2.1.5 Using the Project Menu

The Project menu provides access to the Compiler settings, Component build operations, and
Configuration Manager options.

Model Kits Window Help

Compiler Settings...
Run Script...
Configuration Manager...

Import ARM Cycle Model Studio Command File

Create SoC Designer Component...
Create CoWare Component...
Create SystemC Component...

Figure 2-10 Cycle Model Studio Project Menu

Note:  Some of these options may be unavailable, depending on the type of license you have
purchased from ARM.

2.1.5.1 Configuring Compiler Settings

Project > Compiler Settings enables you to configure the parameters needed for compiling
Cycle Models. After you select a specific Compile Property Set, all changes you make in the
Properties pages are applied to that Configuration, and used the next time you compile any proj-
ect using that configuration.

Note: Thisisequivalent to selecting the Cycle Model or RTL Sources entry in the Project
Explorer view, and then editing entries in the Properties view.
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To select acompile properties set, or configure your compile properties:

1. From the Project menu, select Compiler Settings to display the Compiler Options dialog,
shown in Figure 2-11.

Configuration Menu

b d Compiler Options

Active( Default) v |

[ Compller Propectles | v]

Property

List
Mame Walue &
\\EI Bazic Optiohs j

Configuration:

u] 2
-0 libTestProject1.a
Cornpiler Control 32-hit compile, 32-bit mocel
General Camnpile Control

i i{-attributeFile )

C-attelbut=Fll =] \

Attributes file to be passed to the compier
\ & oK
\ \

Property Description Property Value

Figure 2-11 Compiler Options Dialog Box

2. Atthetop of the dialog, click the down-arrow in the Configuration menu to select the con-
figuration for which you want to set the Compile Properties. (For instructions on creating
new configurations, refer to Creating New Compile Properties Sets). You can define unique
sets of properties that contain different compile settings. After you select a Configuration
name, your modifications apply to that Configuration.

3. Click any property value field to edit that particular property.

When you have completed your configuration, click OK to save the settings. These new
property settings are used the next time you compile any project using the selected Config-
uration.
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2.1.5.2 Using the Run Script Option

Use Project > Run Script to execute a script. This displays the Execute Script dialog box (Fig-
ure 2-12).

Cycle Model Studio provides the Execute Script option to support speciaized functionality.
Consult with ARM Technical Support for more information.

u Execute Script

Siript File: II | [:]

|:| Use Script Debugger Fun Script l [ Close ]

Figure 2-12 Execute Script Dialog Box

2.1.5.3 Creating New Compile Properties Sets
Use Project > Configuration Manager to create a new Compile properties set. This displays
the Edit Configurations dialog (Figure 2-13):

1. Click New to create a new property set. The Create Configuration dialog box appears with
the default configuration name <New>.

Mew. .. -

Copy... |
Remaove |

Renarme |
Create Configuration 2 x|

Mew Configuration Mare:

I Special

Copy settings From:

Note: Copying settings will copy all compiler options and
component configurations.

Edit Configurations 2lxl
Default Haw

oK Opized

CopY...

Remaove

Rename

Close:

[kl

Figure 2-13 Configuration Manager Dialog Boxes
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2. Typeanew nameto replace <New> for your new property set and click OK. You are
returned to the Edit Configurations dialog box.

3. Click Closeto closethe dialog.
From the Project menu, select Compiler Settings... to display the Compiler Options dialog.

5. Select the new Compile Properties Set you have created, and edit the property parameters
as needed (see Configuring Compiler Settings for more information).

6. Click the OK button to save your settings.

2.1.5.4 Adding RTL Sources

Select Project > Add RTL Sources... to add RTL source filesto your project. When you select
this option, the Select RTL Sources dialog box appears (Figure 2-14).

i} Select RTL Source(s) x

|§‘ |?”[‘a_ij hlei HE” Projactl‘

Location: ‘

Places Name ~ | Size Modified |||
@ Search inux 14:2
3 Recently Used

7 Project]
& hlei

(& Desktop
|| File System
(@] Documents
& Music

& Pictures

[&] videos

(& Downloads

G0 |7RTL Sources | 3 ‘

‘ Can[eliH Open ‘

Figure 2-14 Select RTL Sources Dialog Box

Select the RTL source file you want to add and click Open. The sourcefile is added to the
sourcefilelist in the Project Explorer view. The new file or files are used the next time you
compile your project.
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2.1.5.5 Importing a Command File

Project > Import ARM Cycle Model Studio Command File enables you to import an exist-
ing Command (.cmd) file into the current project. This applies all the command settings that
exist in the Command file to the current project. Thisis useful if you have created a Command
file with many custom settings that you want to apply to other Cycle Model Studio projects.

Note that you can create a new project and apply the Command file to the new project as well.

2.1.5.6 Importing a Wizard File

Project > Import ARM Cycle Model Studio Wizard File enables you to import an existing
Wizard (.ccfg) fileinto the current project. Thisisuseful if you had previously generated a com-
ponent using the SOC-V SP Component Generator for SoC Designer or SOC-V SP Component
Generator for Platform Architect.

Typically, this option is used by customers who used one of the older Wizard products (listed
above) and who now want to continue the customization of the Component using Cycle Model
Studio. In these cases, the initial project should be created using the existing Command file
(described on page 24) so that all RTL sources and Cycle Model compile settings are available
for further configuration.

Warning:  The Cycle Model namein Cycle Model Studio must be the same as the Cycle Model
name used when you initially created the .ccfg file using the Wizard. The .ccfg file
contains the name of the original Cycle Model and will cause a compilation error if
the same name is not used. You can define the name in the Compiler Properties
page using the -o option.

When you select this option, the Import Pre-existing Wizard dialog box appears (Figure 2-15).

Import pre-existing ARM cycle models Wizard x

ARM cycle models supports two kinds of .ccfg files, SoC
Designer and CoWare, please indicate what kind of .ccfg file
you are importing into this Model Studio project.

Indicate import type
@ [SoC Designer ) CoWare

Filename to import:

cancel || oK |

Figure 2-15 Import ARM Cycle Models Wizard Dialog Box

Select whether thefileisa SoC Designer or Platform Architect (CoWare) wizard file, browseto
thefile location, and click OK to import the file into the project.

Note:  You can create a new project based only on the .ccfg file, as described on
page 24. However, in that case you will not have accessto the RTL filesto further con-
figure the component.
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2.1.5.7 Creating a SoC Designer Component

Use Project > Create SoC Designer Component... to create an SoC Designer-compatible
component from the Cycle Model. System engineers use the component in SoC Designer to
build a simulatable system and perform validation and debug operations.

See “ Starting and Configuring the Project” on page 82 for compl ete details.

2.1.5.8 Creating a Platform Architect Component

Project > Create Platform Architect Component... creates a Platform Architect-compatible
component from the Cycle Model. System engineers use the component in Platform Architect
to build a simulatable system and perform validation and debug operations.

See “Platform Architect-Specific Instructions’ on page 134 for complete details.

2.1.5.9 Creating a SystemC Component

Project > Create SystemC Component... creates a component that can be linked directly into
a SystemC design environment.

See “ Creating Components for SystemC” on page 139 for complete details.

2.1.6 Using the Window Menu

The Window menu provides control for the various view windows within the Cycle Model Stu-

dio GUI.
Close Chrl+F4
Close all
Tile:
Cascade
Mexk Chrl+Tab
Presvious Chrl+5hift+Tab

Reset Windows

1 Zi/Projects/Project/Directives
v Z ZifProjects/Project).  ivicvectBank, v

Figure 2-16 Cycle Model Studio Window Menu

Close — Closes the particular view or panethat is currently active (the one that is checked in
thelist).

Close All — Closes all project panes, including the active one.
Tile— Displays multiple components within aview side by side, replacing the tabbed view.

Cascade — Displays multiple components within aview in a cascading format, replacing the
tabbed view.

Next — Displays the next element when multiple elements are present in aview.

Previous — Displays the previous element when multiple elements are present in a view.
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Reset Windows — Resets the windows to their default locations. Thisis useful if you have
undocked some of the view windows and want to move them all back to their default positions.

2.2 Using the Toolbar

The CM S Toolbar provides access to some of the most frequently-used actions.

-

3 o ans o c 5]
\Default | 2] o Designer CoWare SystemC

e
Save All Check Compile

Figure 2-17 Cycle Model Studio Toolbar

Note:  Some buttons may be unavailable depending on the type of license you have purchased
from ARM.

The Save, Delete, and New Dir ective buttons are context-sensitive and are available only when
certain configuration settings are displayed in the Main view window.

There are tool tips for the buttons so that a brief button description appears as you float the
mouse cursor over each button. The buttons include:

» SaveAll — Savesal open project files.

* Check — Checksthe design for errors.

» Compile — Compiles the project.

» Stop — Usethisbutton to stop an in-process compile.

e CompileProperties Set selection — This drop-down menu enables you to select a specific
set of Compile properties to be used for the next compile of the project. You can define
multiple compile property sets so that you can create Cycle Models with different attributes.
See " Creating New Compile Properties Sets’” on page 34 for more information.

» SoC Designer — Creates an SoC Designer-compatible component from the Cycle Mode.
See “ Starting and Configuring the Project” on page 82 for complete details.

» CoWare— Creates a Synopsys (formerly CoWare) Platform Architect-compatible
component from the Cycle Model. See “Platform Architect-Specific Instructions’ on
page 134 for complete details.

» SystemC — Creates a component that can be linked directly into a SystemC design
environment. See “Creating Components for SystemC” on page 139 for complete details.

* Remodeling Wizard — Launches the Remodeling Wizard.
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2.3 Using the View Windows

The Cycle Model Studio provides many view windows that perform different tasks as you build
and compile your projects. The possible views include:

* Project Explorer (Section 2.3.1)

* Main (Section 2.3.2)

*  Properties (Section 2.3.3)

» Console (Section 2.3.4)

e Error List (Section 2.3.5)

» Design Hierarchy (Section 2.3.6)

2.3.1 Using the Project Explorer View

Use the Project Explorer view to manage your projects and to compile Cycle Models.

Project Explorer E3]
}.

< 2 Projectll.carbon
= a1 ARM Cycle Model: libProj...
#: Compiler Directives
| J libProjectll.symtab.db
~ 3 RTL Sources
< I RTL Medel
=] flatten.v
=| vector.v
= I Generated Files
[~ libProjectll
i Files
Zl libProjectll.ccfg
Z mx.top.h

F mx.top.cpp
Z Makefile libProjectll.mx

Figure 2-18 Cycle Model Studio Project Explorer Window

The Project Explorer view displays:

* Projects

» Project-related Verilog RTL source files and models

» Platform-specific (Platform Architect, SoC Designer, or SystemC) components
» Cycle Model Studio-generated files
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Use the Project Explorer view to perform avariety of tasks, such as.

» Compiling Cycle Models from RTL

»  Configuring Compile properties

»  Generating platform-specific models

»  Configuring path and platform parameters

Note: Someitemsinthe Project Explorer are affected by the order in which they are listed; for
example, thelist of RTL Sourcefiles. You can move the files up or down in the Explorer

tree view using the Move Up & and Move Down & buttons.

To use the Project Explorer view:

» Click to select any node in Project Explorer view. In many cases, selecting anode displays
its configuration information in the Properties view.

» Double-click an item to activate it. When an item is activated (for example, an RTL source
file or adirectivesfile), its contents are displayed in the Main view (see Section 2.3.2).

* Right-click an item to display a context-sensitive menu of available actions for that item,
and select the action to execute it. Thisis shown in Figure 2-19.

Project Explorer £

;.

.l Projectll.carbon

¥ Create CoWare Component...

Create SOC Designer Component...
- Create SystemC Component...
Add RTL Source(s)... Project Explorer
Add RTL Library... (3]
Compiler Settings... = [
v _[)' i Ili.l;IPur;i.eJcltﬁJ < A ARM Cyc!e Model: libProj...
#: Compiler Directives

2 Files . :
< w» SoC Designer Component | J libProjectll.symtab.db
~ O RTL Sources

i libProjectll.ccfg

B

B mx.top.h = I3 RTL Model
F mx.top.cpp 2 Delete
Z Makefile.libProjectll.mx < & Gener L] Library File
B =~ |[ibF  Find File...
i Files

Figure 2-19 Project Explorer Context Menus

The same options are a so available from the Project menu. See “Using the Project Menu”
on page 32 for more details.
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2.3.2 Using the Main View

Use the Main view to view and configure project settings. When you:

* Click onceon afilein the Project Hierarchy — the Properties window displays properties
for that file.

» Double-click afilein the Project Hierarchy — the Main view displaysthefile's contents. In
the Main view, you can edit the file, or valuesin the configuration window.

Asshown in Figure 2-20, the Modules and Nets directives display when you double-click the
“Compiler Directives’ option. The Directives file appears when you double-click the directives
file (if one exists for your project). The Verilog file content displays when you double-click the
fileinthe RTL Folder list.

Simole W\ /Directives\ /examnole dif\

Net Observe | Deposit Force Other 1 Other2 Other3 Other4 Others
icky.in O O
icky.out (] ]

simnple.v\ /Directivest example.dirt
1 observesignal icky.out
2

/simnle.v\ (e e Aol A
module icky(out,in,clk); =

output [3:0]
input [3:0] in;

input clk;

1
2
3
4
5
W\W [ // index is longer (strlen) than the net name.
7
8
9

wire i 100 = in[0]; // carbon observeSignal
wire i 101 = in[1];
wire i 102 = in[2];

10 wire i 103 = in[3];

12 {/ net name is longer than the index.

13 reg outa 0,outa 1,outa 2,outa 3; m
14 always @(posedge clk)

15 begin

16 outa 0 =1 100;

17 outa 1 =1 101;

18 outa 2 =i 102;

19 outa 3 =i 103; [~

[ B

Figure 2-20 Sample Contents of Main Window

There are many other files that appear in the Main view as you define the settings for your proj-
ect.

Use the close button ( ) to close the active file in the Main view when you no longer want it
displayed.

To adjust the font size in these text windows, set the Text Editor Preferences from the Edit
menu. To make temporary changes to the font size, use the key sequence Ctrl+<Number Pad
+> to increase the font and Ctrl+<Number Pad -> to decrease the font.
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2.3.3 Using the Properties View

Use the Properties view to display all properties associated with a selected item, and edit those
properties as needed. Editable and read-only fields vary, depending on the item selected in the
Project Explorer view. Property views (sets) are provided for:

Projects (Section 2.3.3.1)

Cycle Model Compiler (Section 2.3.3.2)
RTL Folders (Section 2.3.3.3)

RTL Files (Section 2.3.3.4)

Compiler Directives Files (Section 2.3.3.5)

The Properties view (Figure 2-21) includes three elements:

Property Type Field
Property Parameters Window
Parameter Help Window.

Property Type Field Property Parameters Window
| Compiler Properties ’[ / 8 |
‘?‘ ‘g‘ Reset All | Reset
Name Value [

-inlineSingleTaskCalls false
-inlineTasks false
-noFlatten false
-tristate X

= Net Control

-bufferedMemoryThreshold 16384
rharl-OnpR falea E

<multi-thread
false
Use this option to generate a thread-safe model. Multi-threading is supported in the ARM

cycle models API, with some exceptions. So, you may want to enable this option if you
intend the model to be used in a multi-threaded environment.

RN

Parameter Help Window

Figure 2-21 Cycle Model Studio Sample Properties Window

If the Property Typefield:

The Parameter Help Window at the bottom displays additional information about sel ected

Displays one item — The parameters displayed in the Properties window apply to that item.

Is blank — The properties displayed may apply to multiple items.

items.
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2.3.3.1 Project Properties

The Cycle Model Studio Project (.carbon file) contains al the data required to configure the

Cycle Model Studio environment and manage Cycle Models, including all the files that are gen-
erated during the compile process. The Project properties are listed in the properties view (Fig-
ure 2-22). For descriptions of individual items, select the item and view the information in the

Parameter Help window.

| Project Properties

|i= |4}
Name

< Custom Build
Epilogue Script

Epilogue Script Arguments

Epilogue Script Execution

Post Compilation ModelStudio Script
Post Compilation Script

Post Compilation Script Arguments

— General Properties
Filtered Instances
Filtered Messages
(Project Directory)

Remote CARBON_HOME
Remote Command Prefix

Remote Server
Remote Username

Remote Working Directory

-~
-

‘Reset All || Reset

Value

local

fhomejcds/t...

(Target Directory)

fhomefcds/tl/Projectl/Linux/Default

The software platform specific home directory for this

project

Figure 2-22 Project Properties Window

Some of the Project properties are required to be filled, some are optional, and some are read-

only fields.

* Read-only fields are in parentheses; for example, (Project Directory).

* Required fields include Remote CARBON_HOME, Remote Server, Remote Username,
and Remote Working Directory. For Windows users, these fields are filled automatically

from the values entered in the Drive Mapping dialog box, as described in “ Drive Mappings’

on page 27.

Note that the following environment variables are available whenever Cycle Model Studio
launches a program (for example, an Epilogue script):

CARBON_PROJECT=<project directory>

CARBON_CONFIGURATION=<platform>/<name>
CARBON_OUTPUT=$CARBON_PROJECT/$CARBON_CONFIGURATION

CARBON_MODEL =<design.name>

For example, the following values would be available for scripts:

CARBON_PROJECT=/home/username/CycleModel §/Projects/Project1
CARBON_CONFIGURATION=Linux/Default
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CARBON_OUTPUT=/home/username/CycleM odel §/Proj ects/Project1/Linux/Default
CARBON_MODEL=libdesign.a

2.3.3.2 Compiler Properties

You use the Compiler propertiesto configure global parameters to be applied when compiling
your Cycle Models. These parameters display when Cycle Model or RTL Sourcesis highlighted
in the Project Explorer view.

The Compiler properties are saved in a Compiler Settings Property Set. You select the Compiler
Property Set from the drop-down menu in the toolbar. After you select a specific Compile Prop-
erty Set, all changes you make in the Properties pages are applied to that Configuration and
used the next time you compile any project using that Compile Property Set.

You can define multiple compile property sets so that you can create Cycle Models with differ-
ent attributes. See “ Configuration Manager” on page 34 for more information.

The Compiler Properties are organized into the following categories:

e Basic Options

»  General Compile Control

* Input File Control

* Module Control

* Net Control

e Output Control

* Verilog Options

Enter information in the parameter fieldsin any of the following ways:
* Clicking a drop-down menu and selecting the appropriate value.

» Clicking a Browse button and navigating to afile.

» Clicking the field and entering text.

Options you change from their default settings are indicated in bold text.

For descriptions of individual parametersin any of the categories, select the item and view the
information in the Parameter Help window.
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Basic Options Parameters
The Basic Options parameters are shown in Figure 2-23.

Properties E5]

: Compiler Properties o
= |44 ] [Reset All || Reset
Name Value —

| = Basic Options - E

-0
_O )
Figure 2-23 Cycle Model Compiler Basic Options Parameters

The -0 option defines the default Cycle Model name. This name defaults to
lib<project_name>.lib when running Cycle Model Studio on Windows, and to
lib<project_name>.a when running on Linux.

General Compile Control Parameters
The General Compile Control parameters are shown in Figure 2-24.

I
Properties [E5]

: Compiler Properties =3

n oy |

| = General Compile Control

-annotateCode false
(-attributeFile)
-clockGlitchDetect true
-compileLibOnly false
'j 4
-L
-Lf
-licg false
-profileGenerate false
-profileUse false
-synth true
-topLevelParam

p Input File Control [~

Additional Options

Additional options to be passed to the compiler

Figure 2-24 Cycle Model Compiler General Control Parameters

The Additional Options parameter enables you to add special compile parameters that are typi-
cally not required. See the Cycle Model Compiler User Manual for more information, and con-
sult with ARM Technical Support for guidance.
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Input File Control Parameters
The Input File Control parameters are shown in Figure 2-25.

Properties ®

i Compiler Properties o |
[i= ][44 [Reset All || Reset
Name Value |

I» Basic Options

| b General Compile Control

| = Input File Control
-directive
-f
-showParseMessages false 153

Figure 2-25 Cycle Model Compiler Input File Control Parameters

The -directive option enables you to specify a directivesfile to be used during compilation of
the Cycle Model. Directives are compiler commands that control how the Cycle Model Com-
piler interprets and builds a linkable object. See “ Directives File Properties’ on page 50 for
more information.

Module Control Parameters

The Module Control parameters are shown in Figure 2-26. They control compilation settings
that affect modules.

Properties [E5]
iCompIIer Properties 2
|:=||44] [Reset All || Reset
Name Value |[~]
| = Module Control |
| -checkpoint true
-flattenParentThreshold 10000
-flattenThreshold 25
-flattenTinyThreshold 10
-inlinesingleTaskCalls false
-inlineTasks false
-multi-thread false
-noFlatten false
-tristate b [~

Figure 2-26 Cycle Model Compiler Module Control Parameters
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Net Control Parameters
The Net Control parameters are shown in Figure 2-27. They control compilation settings that

affect nets.

Properties

@ =

i Compiler Properties

~
<

=

iName
| = Net Control

| Reset_A_I_I_| Reset

Value [il

-bufferedMemoryThreshold 16384

-checkQOB false

-doNetVec true

-g false
-memoryCapacity 4194304
-netVecMinCluster

-netVecPrimary false
-netVecThroughPrimary true

-no-0O0B false

-sanitizeCheck false
-waveformDumpSizeLimit 1024 =l

Figure 2-27 Cycle Model Compiler Net Control Parameters

Output Control

Parameters

The Output Control parameters are shown in Figure 2-28. They control the data that is output
from the compile process.

Properties

@ =

i Compiler Properties

~
<

= |44 ] | Reset All || Reset
| Name Value (4]
= Qutput Control
-noCModelWrapper false (
-noFullDB false
-phaseStats false
-profile false
-q false
-reportNetVec
-stats false
-version false
-W false [~]

Figure 2-28 Cycle Model Compiler Output Control Parameters
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Verilog Options Parameters

You can use the Verilog Options parameters (Figure 2-29) only with Verilog design files. They

control how Verilog parameters are handled during the compilation process.

Properties ®
iCompIIer Properties 24
|i= || 2l | | Reset All || Reset
Name Value £l
~ Verilog Options

-2001 false

-allow false

+define+

-duplicate

-enableQutputSysTasks false

+incdir+ =

-keepfirst false

+libext+

+maxdelay false

+mindelay false

-noPortDeclarationExtensions false

-no_translate false

-override false

+protect[.ext] false

-sverilog false

-eunth nrefiv rarhnn E

Figure 2-29 Cycle Model Compiler Verilog Options Parameters
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2.3.3.3 RTL Folder Properties

Figure 2-30 RTL Folder Properties

You display the RTL Folder properties page by selecting the RTL folder in the Project Explorer

view (named RTL Model in our sample). The RTL Folder properties, shown in Figure 2-30,

allow you to define the:

* nameof the RTL folder
» name of the Verilog library in which thefilesin this folder should be placed

» Verilog compile options to apply to the filesin this folder when the project is compiled

Enter information in the parameter fieldsin any of the following ways:

» clicking adrop-down menu and selecting the appropriate value

» clicking a Browse button and navigating to afile

Mame

Yalue

.

R

TL Folder Properties
- =yhdlLib

- -ylogLib

- Folder Name

=} Yerilag Options

- +define+
- +incdir+
- HibExk+

RTL Model

» clicking the field and entering text

[

For descriptions of these parameters, select the item and view the information in the Parameter
Help window.

Note:

The compiler property settings you make here override the Cycle Model project com-

piler settings. These settings apply to the filesin this folder only.
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2.3.3.4 RTL File Properties

You display the RTL File properties page by selecting afile within the RTL Model in the Project
Explorer view. The RTL File properties, shown in Figure 2-31, allow you to define compiler
properties unique to a specific file that is part of your project.

Mame Yalue =
=t General
{ i (Absolube Path) Z:1JProjectsvicPriarity v
- (Configuration) Default
- (Relative Path) o EPriorby
B (F.emote Path) { lhomecdstonackifProjectsVicPriority v
i e LibraryFile False
=} Werilog Options 1
- +define+
- Hincdir+
- +libext+ j

Figure 2-31 RTL File Properties

Note:  The property settings you make here override the compiler settings for the project and
the RTL Folder. The settings made here apply to the current file only.

For descriptions of these parameters, select the item and view the information in the Parameter
Help window.

2.3.3.5 Directives File Properties
Directives control how the Cycle Model Compiler interprets and builds a Cycle Model. There
are three waysto apply directives to your project:
* Using adirectives file— Discussed below.

e Manualy applying directives to modules and nets — See “ Applying Directives to Modules
and Nets’ on page 70.

» Embedding directives in Verilog source as comments — See “ Embedding Directivesin
Verilog Source Files’ on page 75.

To use adirectivesfile, you must specify the existing file name and location using the
-directive Compiler Property. After you define this property, the name appearsin the Project
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Explorer. When you click the directive file name (<name>.dir) in the Project Explorer tree, the
path and file display in the Properties view, as shown in Figure 2-32.

[Eumpiler Properties - l
Reset All || Reset
Name Value &
= Input File Control SPeC|f_y
-directive example.dir - Directives
f File
-showParseMessages false
= Module Control
Then...
Project Explorer E3) !examnle.diP\
- - 1 observeSignal icky.out
& L X 2

= [ Project2.carbon
¥~ ARM Cycle Model: libProj... / Double-click to view or edit
— % Compiler Directives - Directives file contents

= I3 RTL Sources
= I3 RTL Model
=] simple.v
~ |23 Generated Files
b~ libProject2
3 Files

Click to view Directives

file location
Properties £
[nirectlves File Properties s
Reset All || Reset
Name Value

+ Properties
(File Path) jw/farm627/hleifcms_r2_trunk/testive...

Figure 2-32 Directives File Parameters
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2.3.4 Using the Console View

The Console view, shown in Figure 2-33, displays all process events that occur during and after
compiling RTL into a Cycle Model.

Note: The consoleview isread only.

Console E3]

$CARBON_HOME/bin/make -f Makefile.carbon build

ARM CYCLE MODEL COMPILER BEGIN COMPILATION
fofwork/hleifCMS_R2/bin/cbuild -f Default.f.cmd

CBUILD, ARM Cycle Model Compiler, Version mainline

All Rights Reserved. Use, disclosure or duplication without
prior written permission of ARM Inc. is prohibited.
Copyright (c) 2002-2016 by ARM Limited., All Rights Reserved.
For technical support send email to support-esl@arm.com
MNote 83: Tagging output with .

0 warnings, 0 errors, and 0 alerts detected.

MNote 2039: Performing backend compile...

MNote 111: Successfully created libProject2.a.

0 warnings, 0 errors, and 0 alerts detected.

FINISHED MODEL COMPILATION

ARM CYCLE MODEL COMPILER FINISHED COMPILATION
ARM CYCLE MODEL COMPILER MAKEFILE COMPLETED

Console | Error List | Design Hierarchy

Figure 2-33 Cycle Model Studio Console Window

Colors are used in the Console view to call out important compilation information (see Figure
2-34). The colors that are used, and their meaning, include:

Red — An error discovered in the Cycle Model Studio configuration information
Dark Red — An error discovered in the Cycle Model Compiler configuration information

Blue — A warning message about the Cycle Model Studio configuration

@

CAREON BEGIN COMPILATION ~
Infreleaseftest/release-C2007_11_5950_0211-2003-02-11/treed/bin/cbuild -f Default.f.omd

Mote 1053 Cyele through vector net “WicahbifReg, MxtvICIntEnable',

e w25 Wic_carbon HEURST: Warning 1029 A deposit net does nok Fan ouk to any live logic,

i e 26 Wic_carbon HMASTER:: Wharning 1029: A deposit net does nok fan ouk to any live logic,

i 27 ic_carbon HMASTLOCK: Warning 1029: A deposit net does not Fan oot o any live logic,

i 40 Wic_carbon, SCAMEMABLE: Warning 1030; A force net does not Fan out o any live logic,

i3 ic_carbon, SCAMIMHCLE: Warning 1030: A Force net does nok fan ouk (o any live logic,

Mote &3 Tagging output with 'SIG=Carboninternal’,

e e 148: Error 43004 Module or UDP ;¢ YicahbifReg 3 not defined,

Error 43: There were errors or alerts during design population, cannok continue,

Mote 110; There were errors or alerts during the Internal Representation Construction phase (PopulateMucleus), cannok conkinue,

Swarnings, Z errors, and 0 alerts detected.

make; ¥*** [libCarbonDemo.lib] Ervor 1

Error: Makefile finished with exit status = 2 !
Process Terminated ¥

Figure 2-34 Console Window Messages
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To display the location of the error in the source file in the Main view window, double-click

highlighted messages.

2.3.5 Using the Error List View

TheError List view displays Errors, Warnings, and M essages generated during the compile pro-
cess. The buttons along the top of this window display the total number of messages of each
type. The buttons also enable you to filter (remove) certain messages from the list. The buttons

are:

e Errors— Critical errorsthat stop the generation of the Cycle Model

¢ Warnings — Warning messages that could affect the generation of the Cycle Model

* Messages — Informational messages

» Filtered — Used to filter certain messages

Help for each error message is displayed at the bottom of the Error List window, as shown in

Figure 2-35.

Error List

|. Q5 Errors | | 1\, 0 Warnings | | (i) 1 Messages | | 7 Filtered |

Description
port test is not defined
error is an unknown type
i 100 is not declared
module icky ignored due to previous errors
There were errors or alerts during the HDL Language Parsing phase (LangParse), cannot continue.

BEEEE
L= RN M R VR N )

Figure 2-35 Error List Window

File

UL L e N L T
5 51171

simple.v
simple.v
simple.v
simple.v

6
18
1

B &=

Line Message

51556

51128

51072
110

Error message descriptions can help you determine the cause of aproblem and provide potential

waysto fix it.

To usethe Error List view:

1. Click any of the Select / Deselect buttons to hide or redisplay Errors, Warnings, or Informa-

tional Messages from the view (Figure 2-36).

Select / Deselect Buttons Filtered Button

| Q 5 Errors ‘ | 1\ 0 Warnings ‘ | (i) 1 Messages | | 7 Filtered |

Description
Syntax error near wire
port test is not defined
error is an unknown type
i_100 is not declared
module icky ignored due to previous errors

c0/0000
[« QLW QRS Rl ¥V RN 8 RN

Console | Error List | Design Hierarchy

Figure 2-36 Error List Window Buttons

There were errors or alerts during the HDL Language Parsing phase (LangParse), cannot continue.

®

File | Line Message

simplev 9
simplev 5
simplev 6
simple.v| 18
simplev 1

51137
51171
51556
51128
51072
110
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2. Tonavigateto the location of asourcefile error in the Main view window, double-click any

error, warning, or message (Figure 2-37).

fexamnle_dil\ [I']irerriue.;\ f:simole.\h

3 input [3:0] in; (4]

4 input clk; -

5 output test;

6 error

7

8 /I index is longer (strlen) than the net name. |3

9=  wire i 100 = in[0]; // carbon observeSignal

10 wire i 101 =in[1];

11 wire 1 102 = in[2];

12 wire i 103 = in[3]; ]

13

14 /I net name is longer than the index.

15 reg outa 0O,outa 1,outa 2,outa 3;

16 always @(posedge clk)

17 begin

18 outa 0 =1 100: [~
(< D]

Figure 2-37 Error Location in RTL File

3. Right-click any item to display the Error List Options menu (Figure 2-38).

L [1 1000
@z g . a.  Cy . 7 visit cahbifReg.y | 391
|3 |Vic_carbon HEURST: & deposit net does nat Fan out ko any live logic, “ Filter Message Wic.w 25 1029
_g 4 |¥ic_catbon HMASTER: A deposit net does not Fan out to any live logic, = Clear Al Wic.w 26 1023
_g 5 |Wic_carbon HMASTLOCK: & deposit net does not Fan out ko any live logic. ﬁ— Wic.w 27 1023
_;5 & |Vic_carbon, SCAMEMABLE: A Force net does not Fan out to any live logic, Wic,w 40 1030
_;5 7 |Vic_carbon, SCANIMHCLE: A Force net does not Fan out to any live logic, / Wic,w 41 1030

/

Options Menu/

Figure 2-38 Error List Context Menu

4. Right-click any Error List view item for which afile exists. This displaysthe Error List

Options menu.
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5. Select the Open in Design Hierarchy option to see the hierarchical view of the item (Figure

2-39).
rror List #
& 1 Errors I 1, 6 Warnings I (i) 0 Messages I “F Filkered
Description File Line | Message
L 1 |Unbroken combinational cycle of size 1 detected., 1000
i) |2 |Met Vic_carbon,uvicAhbifReqg. MxtYICIntEnable: Cycle node 171 VicahbifReg.»

"G visit

JS 4 . . does nat Fan out ko any live logic, 26 1029
(|5 | vic_carbon HMASTLOCK: & depasit net dom live: lngic. W Filter Message 7 1029
L & | Vic_carbon, SCAMEMABLE: A Force net does not Fan out to arnry mﬂ_.\ " Filter Instance 40 1030
_;5 7 |Wic_carbon, SCAMINHCLE: A Force net does not Fan out ko any live logic, 1030
=% Clear All
Design Hierarchy |
Module | Infa =1 | Mame | Size | Infarmation I;I
[=}- Mic_carbon 583 nets, 23 inskances HELRST Scalar  Depositable —
- UDvicRewand (MicRewand) 3 mets, O instances HCLK Scalar  Visible Input Clock
- UDvichectBank (VicvectBanlk) 12 nets, 0instances HMASTER Scalat  Depositable
- Ul OvicYectBank (VicvectBank) 1Z nets, 0 instances HMASTLOCK Scalar  Depositable
- Ul 1¥icYectBank (VicvectBank) 1Z nets, 0 instances HPROT Scalar  Visible Input
- a1 2¥icvectBank (VichectBank) 12 nets, 0 instances HRDATA [31:0] Wisible Cutput AsynoOutput
- Ul BicvectBank (VicvectBank) 12 nets, 0 instances HREADYIN Scalar  Visible Input
- Ul 4vicvectBank (VicvectBank) 12 nets, 0instances HREADYQUT Scalar  Visible Cutput
- u1SWicvectBank (WicviectBanlk) 12 nets, 0instances HRESETn Scalar  Visible Input MReset
- ul¥icResand (MicRewand) 3 nets, 0 instances HRESP [1:0]  Visible Cutput
- ul¥icYectBank (VickectBank) 12 nets, 0instances LI HSELYIC Scalar  Visible Input ﬂ

Figure 2-39 Error List Link to Design Hierarchy
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To filter the errors, warnings, and messages that are displayed in the Error List view:

Right-click theitem(s) in the error list that you wish to filter out.

From the Error List Options menu, select Filter Message to remove all instances of the
message from the Error List view.

3. Toredisplay (cancel the filtering of) any messages you have previoudly filtered out, click
the Filtered Button (Figure 2-40).

Errar Lisk

I i) 1 Errors I I\ B Wéarnings I i) & Messages I W Filtered

Filter / Unfilter
Figure 2-40 Error List Window Filtered Button

2.3.6 Using the Design Hierarchy View

Use the Design Hierarchy view, shown in Figure 2-41, to show design structure and manage the
functions of design modules and signals. The Design Hierarchy provides two panes: the left dis-
plays the modules in the design tree, and the right pane displays the nets associated with the
design modules.

Design Hierarchy ®
Modules: Load Design Hierarchy  Nets; Matching: [ Explicitly Observable [ Explicitly Depositable
Module Info Name A Range Direction Size Type Attributes Flags(as cor
e clk Input 1 Scalar Clock PEdgeTrigger
 Libraries ) _ i 100 1 Scalar  AsyncOutput Observable
b WORK /w/farm627/hlei/cms_r2_trunktest/vector/Proj... i 101 1 Scalar
i 102 1 Scalar
i 103 1 Scalar
b in [3:0] Input 4 Array Async BothEdgeTrigger
b out [3:0] Output 4 Array o
| | 1] ‘ E\_

Console | Error List | Design Hierarchy

Figure 2-41 Cycle Model Studio Design Hierarchy Window

To use the Design Hierarchy:
* Inthe Modules pane:

— Click any module in the |eft pane to display the nets associated with that module in the
right pane. If the module contains Verilog parameters, the Nets pane shows the
parameters for each instance.

— Right-click amodul e to set the observeSgnal directive or the depositSignal directive on
al the netsin the module, or just for that instance of the module.

— Right-click any module in the |eft pane to display the RTL code for the module, or the
RTL code for just that instance of the module, in the Main view.

* Inthe Nets pane:

— Right-click anet to set the observeSignal, depositSignal, or forceSgnal directive.
— Right-click anet to display the location in the RTL code where the net is |ocated.
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—  When nets have sub-components, click the plus sign to expand the net to view the
elements.

— When editing and tuning components, drag nets from the right pane to ports, registers,
memories, and profiles (see Chapter 4, Creating Components for Specific Platforms).

» Usethe Filter field and the check-boxes (Explicitly Observable, Explicitly Depositable) to
restrict the view of the netsin the Nets window. Thisis useful when looking for specific
nets within the design.

Note:  Any netsdisplayed in red are not visible (not observable). If you require access to any
of these nets, you must explicitly set the observeSignal directive.
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Chapter 3

Compiling RTL into a Cycle Model

The Cycle Model Compiler takes an RTL hardware model and creates a high-performance link-
able object, the Cycle Modédl, that is cycle and register accurate. The Cycle Model provides an
API for interfacing with your validation environment. The Cycle Model Compiler fitsinto the
design flow as shown in Figure 3-1.

Cycle Cycle Model
i Model Studio - i
E> Compiler E> —bdesigna_

libdesign.lib
]
Cycle n
: SoC Designer
Model Studio X
Component E>Glatf§rg1té0\nr]%hlteCD|:> |]| Component
Generator Y

<

Cycle Model Studio
Component Tuning

Figure 3-1 Cycle Model Studio Process Flow - Cycle Model Compiler
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This chapter provides information regarding the Cycle Model Compiler functions that are sup-
ported by the Cycle Model Sudio. For comprehensive information regarding the Cycle Model
Compiler, refer to the Cycle Model Compiler User Manual.

This chapter includes the following sections:

* Reviewing Remote Compile Requirements
* Cycle Model Compiler Inputs

» Cycle Model Compiler Directives

e Compiling RTL with Cycle Model Studio

3.1 Reviewing Remote Compile Requirements

Cycle Model Studio requires that your RTL hardware description be compiled on Linux. How-
ever, it ispossible to run the Cycle Model Studio on Windows and control a compile process
that is running on Linux. This section describes how to set up Cycle Model Studio on Windows
to manage remote compilation on a Linux server.

If you are running on Windows, when you initially click Compile, the Remote Server Configu-
ration dialog displays (Figure 3-2).

‘@ Remote Server Configuration @

Remate Server

Server Mame:  release-testz
Username:  qa-rick.
Remake Environment
Rermoke Working Directary:

Thomefqa-rick/Carbon/ProjectsiProject 1

Remote Cammand Prefix: (optional)

Remoke CARBON_HOME {use if vour login script does not already define)

Jworkipublic/CMSisepSPRODUCT]

[ [o]4 ] | Cancel

Figure 3-2 Remote Server Configuration dialog
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Complete the fields as follows:

* Server Name —Name of the Linux machine used for compilation.
* Username — Username for access to the Linux machine.
» Remote Working Directory — The directory where compilation occurs.

* Remote Command Prefix (optional) — Script to run after logging in - for example, one
that defines CARBON_HOME and also places CARBON HOME/bin into the Linux path.

» Remote CARBON_HOME — Location where CARBON_HOME resides on the remote
Linux machine: the directory where Cycle Model Studio isinstalled.

Note: The project must not reference any files that reside outside the scope of the defined
Remote Working Directory. For example, source files located in a Linux path /library
are not opened by Cycle Model Sudio; however, they still compile on the remote
machine. This also means that errors might not be easily attributed to those files.

Click OK when this dialog is complete. You are prompted to enter the password for the Linux
account.

These settings are reflected in the Cycle Model Studio Project Properties window (Figure 3-3).

Properties (3]
Project Properties s
i= (&1 Reset All || Reset
Mame Value [

Filtered Instances
Filtered Messages
{(Project Directory) Swifarme2 7 /hlei. ..

Remote Command Prefix
Remote Server

Remote Usermame
Remote Working Directory
General Properties

Messages which are filtered by source locator.

Figure 3-3 Cycle Model Studio Project Properties

Cycle Model Studio performs a check to ensure that these directories exist when executing a

remote compilation. Refer to the Cycle Model Sudio Installation Guide for more installation
information.

Important note regarding SSH: Cycle Model Studio comes with re-distribution of PUTTY'’s

plink program (http://www.chiark.greenend.org.uk/~sgtatham/putty/) and uses plink to open up
the remote Linux shell.
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3.2 Cycle Model Compiler Inputs

A Cycle Model can be generated only by the Cycle Model Compiler. The Cycle Model Com-
piler reads the following files, in order, and generates a Cycle Model for the design.

1. Optionsfiles— Contain command options that provide control and guidance to the Cycle
Model Compiler (sometimes these are called “ switches™).

2. Directivesfiles— Contain directives that control how the Cycle Model Compiler interprets
and builds a Cycle Model.

3. Verilog design and library files— Golden RTL of the hardware design.

Options

Directives | —] — > Cycle Model

Cycle Model
Compiler

Design |

Figure 3-4 Cycle Model Compilation Overview

3.2.1 Cycle Model Compiler Options

You use the Cycle Model Compiler propertiesto configure parameters to be applied when com-
piling your Cycle Models. These parameters display when Cycle Model or RTL Sourcesis high-
lighted in the Project Explorer view. They are organized into a variety of categories.

3.2.2 Cycle Model Compiler Directives

Directives are compiler commands that can be contained in adirectivesfile or embedded in Ver-
ilog source code. Directives control how the Cycle Model Compiler interprets and builds alink-
able Cycle Model. As previously mentioned, Cycle Model Studio can manage two types of
compile directives: Net directives and Module directives. Net directives provide access to spec-
ified signalsin the Cycle Model from the external environment. Module directives identify a
module in the design hierarchy that you intend to be hidden in the Cycle Model. For more infor-
mation, refer to the Cycle Model Compiler User Manual.
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3.3 Compiling RTL with Cycle Model Studio

The Cycle Model Studio provides accessto al the features needed to configure the compile pro-

cess to your needs. You can:

o Define compiler properties
» Define sourcefiles

* Adddirectives

» Usecompiler options

e Compilefor Verilog
To compile RTL using the Cycle Model Studio you must follow the tasks listed below:

* Create your project

* AddRTL sourcefiles

o Define compiler properties

e Compilethe project

» Definedirectives for modules and nets

» Recompile the project
3.3.1 Creating your Project
Follow the steps below to create a project.
1. IntheFile menu, select New, and select Project.

i Open Y S Fle..  Ctri
Open Recent Project 4

Figure 3-5 New Project from File Menu
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2. The New Project dialog box appears.

s

w= Project from existing ARM Cycle Model Studio Command (.cmd) file
ARM ~w Project from existing ARM Cycle Model Studio database (.symtab.db .io.db)
w= Project from existing ARM Cycle Model Studio CoWare Wizard (.ccfg)

~= Project from existing ARM Cycle Model Studio SoC Designer Wizard (.ccfg)
a+ Model to be generated from a ARM Cycle Model Studio Model Kit {.modelKit)

(I [l [>)

[Empty Project |

Name: [Project? ] Create Directory for Project

Location: [,-'home,-'cds,l’;:rrojecti'r ] | Browse... |
[ cancel | [ ok ]

Figure 3-6 New Project Dialog Box

The top part of the New Project dialog box appears only for Windows users who are per-
forming remote compilation on a Linux machine. At least one drive mapping must be set up
before you can define a new project. For Windows users, follow the next step. For Linux
users, skip to step 8 on page 65.

3. For Windows users, select the Mapped Drive to be used to perform remote compilation of
the Cycle Model. Click Map Network Drive... to map anetwork drive if no drives have
been set up, and the following dialog box appears.

Metwork Drive to Unix Directory Mappings E|rg|

Currently defined mappings:

add. ..

Rermove

[ Ok H Cancel l

Figure 3-7 Windows Network Drive Mappings Dialog Box

This dialog enables you to manage the Windows Network drive to Linux directory map-
pings. You can add new drive mappings or remove existing drive mappings.
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4. Click Add to add a new drive mapping and the following dialog box appears.

Map Network Drive to Unix Path

The purpose of this dialog is Eo define what the equivalent Unix path is for a network,
drive letter.

1. Choose a network drive letter:

|

Z: (siliconkonacki)

W1 Osiliconioireleasetkest)

2. Equivalent Unix Path {i.e. /home/username}

3. ¥erify connectivity and path mapping

Unix Server: |

wiarify,.,
Usernarne: |

o ot ]

Figure 3-8 Windows Map Network Drive Dialog Box

5. Perform the following stepsin this dialog box:
»  Select the network drive that has already been set up in Windows.
» Enter the Linux path to be equated to the network drive letter.
* Enter the name of the Linux Server and your valid Username.

¢ Click the Verify button to verify that the mapping is set up correctly. You must enter the
password for the remote Linux server.

6. Oncethe verification is successful, click OK to return to the Network Drive dialog.

Metwork Drive to Unix Directory M. .. E|Pg|

Currently defined mappings:

Z1 = thome/cdsftonacki add...

Remove

[ Ok H Cancel l

Figure 3-9 Completed Windows Network Drive Mappings Dialog Box

7. Click OK to return to the New Project dialog.

8. Select the type of new project that you want to create. See the list of project types on
page 24 for a description of the different methods you can use to create a new project.

9. Inthe Namefield, enter the name for your new project.
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10. In the Location field, browse to the location where you plan to store your new project.
11. Click OK.

Note:  Select the checkbox “ Create Directory for Project” to automatically create a new directory
using the name of the project. The project files are placed in that directory.

3.3.2 Adding RTL Source Files
Follow the steps below to add RTL source files to the project.

1. From the Project menu, select Add RTL Source(s)... You can aso right-click the project in
the Project Explorer view and select Add RTL Source(s)... The Select RTL Source(s) dialog
box appears.

Compiler Settings...

Run Script...
Configuration Manager...
Add RTL Source(s)...
Add RTL Library...
Import ARM Cycle Mo -
Import ARM Cycle Mo ||

Select RTL Source(s) x

@ @‘ﬂ] CMS_R2 E;\ru:tn:.

Create SoC Designer Location: | ]

Create CoWare Com

= P |Places |Name v | Size | Modified I
Create SystemC Com g search & Project1 13:52
Launch the Remodelil & Recently Used | [ Project2 13:56

2 Project2 B flatten.v 405 bytes 10/05/2016
& hlei Ei gatesly 441 bytes 10/05/2016
& Desktop B gates2.v 465 bytes 10/05/2016
[ File system gates3.v 489 bytes 10/05/2016
ST B observe.v 639 bytes 10/05/2016
. imple.v 588 bytes 14:21

[& Music & simp

& Pictures Bl sparsev 233 bytes 10/05/2016

& videos # Bl underscore.v 475 bytes 10/05/2016 |
i B userhintl.v 13KB  10/05/2016

(& Downloads &

B vectorv 29KB  10/05/2016

Figure 3-10 Add RTL Source Files

2. Browseto and select your project’s RTL sourcefile or files.
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3. Click Open to add the RTL filesto your project. The result is shown in Figure 3-11.
Project Explorer ]

aE (%]
iz Project2.carbon
— = ARM Cycle Model: libProj...
< ¥ Compiler Directives
=) example.dir
[ libProject2.symtab.db
~ |2 RTL Sources
] simple.v
g flatten.v
=] gatesl.v
E)] gates2.v
E] gates3.v
E] observe.wv
E] sparse.v
E] underscore.v
=] userhintl.v
] vectorv
< |3 Generated Files
[ = |ibProject2
3 Files

Figure 3-11 RTL Source Files in Project Explorer

Note:  The compilation of the project is affected by the order of RTL Source filesin the Project
Explorer. You can move the files up or down in the Explorer tree view using the Move

Up & and Move Down & buttons.
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3.3.3 Defining Compiler Options and Compiling the Cycle Model

By default, the initial compiler settings allow you to compile your project immediately into a
Cycle Model. The -0 option (under Basic Options) defines the default Cycle Model name. This
name defaultsto lib<project_name>.lib when running Cycle Model Studio on Windows, and to
lib<project_name>.a when running on Linux. Many other options exist; fine-tune these to cre-
ate the best Cycle Model for your application.

Follow the steps below to define the Cycle Model Compiler properties.

1. From the drop-down list in the Button bar, select the Compiler Configuration you want to
use to compile the Cycle Model. The Compiler Configuration contains the unique compiler
options to be used when you click the Compile button.

|/ ARH

Save All Check Compile Default

Figure 3-12 Compiler Configuration Selection

You can have many different sets of compiler properties that include different settings
depending on the stage of development you are in. For example, you could have the Default
standard set, a compiler set that includes the use of adirectivesfile (-directive), and so
forth. You create new sets of compiler properties using the Configuration Manager option
under the Project menu.

2. Inthe Compiler Properties panel (Figure 3-13), set the desired option values. A brief
description of each option appears at the bottom of the view in the Parameter Help Window.
See Chapter 3 of the Cycle Model Compiler User Manual for more detailed information.

Compiler Properties =
=8 Reset All || Reset
Name Value
~ Basic Options

Compiler Control 64-bit compile, 64-...

o] 2

— General Compile Control
Additional Options

-annotateCode false
(-attributeFile)
-clockGlitchDetect true
-compileLibOnly false
- 4
-L
-Lf
-lic false
_anﬁlnﬁannr:fn falca ,ZI
-0
libdesign.a

Use this option to specify the name of all output files for the
ARM Cycle Model. You must specify an extension for object
files of either '.a', which generates a traditional archive, '.so',
which generates a linked shared library, ".lib*, which
generates a static Windows library, or '.dll' which generates
a Windows DLL. The file argument can be a full path or a
relative file name.

Figure 3-13 Cycle Model Compiler Properties Window
3. Click the Compile button in the Button bar.This creates the initial Cycle Model.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 68
ID111516 Non-Confidential



3.3.4 Defining Directives and Recompiling the Cycle Model

Directives are compiler commands that can be contained in a directives file, or embedded in
Verilog source code. Directives control how the Cycle Model Compiler interprets and builds a
Cycle Model. There are three ways to apply directives to your project:

e using adirectivesfile

* manualy applying directives to modules and nets

* embedding directivesin Verilog source as comments

As mentioned in the previous section, you can use a directives file that affects the compilation

result of your Cycle Model by using the -directive option. Thisisaso described in “Direc-
tives File Properties’ on page 50.

After you define the directives for the modules and nets in your design, you must recompile the
Cycle Model.
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3.3.4.1 Applying Directives to Modules and Nets

You can assign directives to modules and nets within your Cycle Model. This alows you to
control the handling of modules and nets. Follow the steps below to define the module and net
directives for the project.

Adding Module Directives

1. Inthe Project Explorer view, select Compiler Directives. The Directives view displaysin
the Main view. Note the Nets and Modules tabs at the bottom of the view.

Project Explorer ® /Directives\

|T| Met Observe Deposit Force Otherl Other2 Other3 Other 4 | Other 5

iZil Project2.carbon
w ~= ARM Cycle Model: libProj...

b #% Compiler Directives
| J libProject2.symtab.db
+ |2 RTL Sources
= [ RTL Model

= | Generated Files
P wm libProject2
i) Files

\Nets/ \Modules/

Figure 3-14 Cycle Model Studio Nets Directives Window

2. Inthe Design Hierarchy, click any module to display the nets.

Design Hierarchy =
Modules: Load Design Hierarchy Nets: Matching: [ Explicitly Observable [ Explicitly Depositable
Module Info Mame - | Range Direction Size Type Attributes Flags(as cor E
o clk Input 1 Scalar Clock PEdgeTrigger
~ Libraries i i_100 1 Scalar AsyncQutput Observable =
I WORK /w/farm627/hleifcms_r2_trunk/test/vector/Proj... i 101 1 Scalar
i_102 1 Scalar
i_103 1 Scalar
B [3:0] Input 4 Array Async BothEdgeTrigger
I out [3:0] Output 4 Array =
@ G
Consale | Error List | Design Hierarchy
Figure 3-15 Modules and Nets in Design Hierarchy Window
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3. Drag and drop modules to the Directives pane in the Main view, and apply directives to

them (see Figure 3-16). Note that you can only place modulesin the Modules tab, and nets

in the Nets tab.
fDirectivesﬁ
Module Directive 1 Directive 2 Directive 3 Directive 4 Directive 5 Directive 6
top depositSignal flattenModuleContents

* Module Drag and Drop

5]
e

[T D

Load Design Hierarchy Nets: Matching: [ Explicitly Observable [ Explicitly Depositabl
Name ~ | Range Direction Size Type Attributes
: . = in [4:0] Input 5 Array
« Libraries ) Input 1 Scalar
I WORK fwifarm627/hleifcms_r2_trunk/test/vect... Input 1 Scalar
Input 1 Scalar
Input 1 Scalar
Input 1 Scalar
1 Scalar
[ T | [>]

Console l Error List | Design Hierarchy |

Figure 3-16 Add Module to Module Directives Window

4. Oncethe Moduleisin the Directives pane you can apply a single directive, or multiple
directives, by selecting a Directives column and selecting the directive from the list. You
can aso select the directive from the Properties window, as shown below.

/Directives\

Module | Directive 1 | Directive 2 | Directive 3 | Directive 4 Directive 5 | Directive 6

<Nothing=>
allowFlattening
depositSignal
disableOutputSysTasks
disallowFlattening

enableOutputSysTasks

flattenModuleContents
hidemodule
observeSignal
substituteEntity
substituteModule

/Directives\ .. Properties =
Module Directive 1 Directive 2 Directive 3 | Directive 4 | Directi [mp = ]
depositsignal flattenModuleContents ———
- . Reset All || Reset |

Name Value

~ Module Directives
allowFlattening
depositSignal true
disableOutputSysTasks
disallowFlattening
enableOutputSysTasks
flattenModule 2

a | [>]

WS/ Modules,

Figure 3-17 Set Module Directives in Directives Window and in Properties

(<]
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One additional way to set two key directives (Observe and Deposit) to al nets within a
moduleisto right-click the module in the Module window and select the directive.

Design Hierarchy

Modules: Load Design Hierarchy

Module Info
- top
stage_a_0 (sub) fo/work/hlel/CMS_R2/test/vector/vector.v:50

Instance
Ivector/vector.v:52

| Deposit > Module  ectorvectory:ss
stage a_¢  VisitModule  jjcms_R2test/vector/vector.v:54
stage2_a| Visit Instance i/CM5S_R2/test/vector/vector.v:60
stage2_a_1 (subj fo/work/hlei/CMS_R2/test/vector/vector.v:61

S AL N e s v

Figure 3-18 Set Module Directives in Design Hierarchy

You can set the observeSgnal directive or the depositSgnal directive on al the netsin the
module, or just for that instance of the module. Once you click the directive option, the
module is automatically moved to the Modules tab in the Directives window and the
selected directive (Observable, etc.) is set for that module or instance.

/Directives\

Module Directive 1 Directive 2

Directive 3 | Dil
top depositSignal flattenModuleContents

[>]
\Nets/ \Modules/

Figure 3-19 Set Module Directives Results
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Adding Net Directives

1. Dragand drop netsto the Netstab in the Directives pane and apply directives to them (see

Figure 3-20).

collapseClock
exposeSignal
fastReset
ignoreSynthCheck
scDepositSignal

slowClock
tieNet

[Directives\ .. Properties ®
Net Observe | Deposit Force Other 1 Other 2 Other3 Other4 Other5 |top.in0_split 2
topstage a lout M [ observesignal depositSignal =i -
top.stage_a_l.rst ¥l O [ observesignal ‘_:HZ_” ‘ML“‘” et
top.in O O Name Value g
= Net Directives E
asyncReset |
depositSignal i
depositSignalFrequent
depositSignalinfrequent
exposesignal ||
factReset v
Net Drag and Drop e
\Nets/\\MnduIes/
Design Hierarchy i
Modules: ¥ Load Design Hierarchy Nets) Matching: [* [ Explicitly Observable [ Explicitly Depositable
Module Info ‘ ‘Name \ A Range  Direction Size  Type  Aftributes Flags(as compiled) HE
! Pl [AE] Input 5 Array |
stage_a 0 (sub) fo/work/hlei/CMS_R2/test/vector/vector.v:50 1 {
stage_a_1 (sub) /fo/work/hlei/CMS _R2/testjvector/vector.v:51 inL_split 1 Senb
stage_a_2 (sub) fojwork/hlei/CMs_R2/test/vector/vector.v.52 %nz_sth 1 Scalar
stage_a_3 (sub) /fo/work/hlei/CMS_R2/test/vector/vector.v:53 m3_sth 1 Scalar
stage_a_4 (sub) fe/work/hlei/CMS_R2/test/vector/vector.v:54 in4_sth 1 Scalar
stage2_a_0 (sub) fo/work/hlei/CMS_R2test/vector/vector.v:60 b in Mt 14:0] 5 Array
stage2_a_l Esu{)) futwurklhle!lcMS_RZ/testfvectorNeclor‘v:61 o in_split 0 1 Scalar o
Console ‘ Error List ‘ Design Hierarchy
Net Observe Deposit Force | Other 1 Other 2 Other 3 Other 4 Other 5
top.stage_a_l.out ] depositSignal
top.stage_a_l.rst ] ] observeSignal
fop.in O [N <Nothing> |
asyncReset

Figure 3-20 Add Net to Net Directives Window and Set Directives

2. Oncethe Net isin the Directives pane you can apply a single directive, or multiple direc-
tives, by selecting a Directives column and selecting the directive from the list. The three
most common net directives (Observe, Deposit, and Force) are provided as check boxes to

make selection easier.
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You can also select the directive from the Net Directives Properties window as shown

below.

/Directives\ .. Properties ®
Net Observe Deposit Force Otherl Other 2 Other 3 Other4 Other5 | top.ino_spiit B
top.stage_a_l.out ] depositSignal (2 ——
top.stage_a_1.rst ] [ observeSignal |jH‘i| ‘M‘ e

top.in m m Name Value

< Net Directives
asyncReset
depositsignal
depositSignalFrequent
depositSignalinfrequent
exposesSignal
fastReset

W\Modules/

Figure 3-21 Set Net Directives in Properties Window

One additional way to set the common net directives (Observe, Deposit, and Force) isto
right-click the net in the Net window and select the directive.

®

Nets: Matching: [J Explicitly Observable [J Explicitly Depositable

Name A | Range Direction Size Type Attributes Flags(as compiled) 8
b in [4:0] Input 5 Array

in0__split 1 Scalar H
in1__split 1 Scalar
in2__split 1 Scalar
M..;L.__E 1 1 S
ind_split Navigate to RTL location SCalaT
[] observeSignal Directive Array
in_split. 0[] depositSignal Directive Scalar

&

[] forceSignal Directive

Figure 3-22 Set Net Directives in Design Hierarchy

Once you click the directive, the net is automatically moved to the Net tab in the Directives
window and the selected directive (Observable, etc.) is checked.

See Chapter 4 of the Cycle Model Compiler User Manual for a complete description of all
the available compiler directives.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 74
ID111516 Non-Confidential



3.3.4.2 Embedding Directives in Verilog Source Files

As an alternative to the previous section of applying directives to modules and nets, directives
may be embedded in Verilog source as comments. The prefix ARM_cM, shown in the examples
below, is automatically recognized by the Cycle Model Compiler.

An embedded directive is associated with anet or amodule. A sample section of a Verilog file
is shown below:

module top(inl, in2, clkl, clk2, out, ena);
input inl, in2;

input ena; // ARM CM tieNet 1'bl

output out;

input clkl;

input clk2; // ARM_CM collapseClock top.clkl
reg a; // ARM CM observeSignal

// ARM _CM depositSignal
always @(posedge clkl)

if (ena)
a <= ~inl;
wire out; // ARM CM depositSignal
flop u2(out, in2, clk2, ena);
endmodule

To use aprefix other than ARM_cM to identify embedded directives, you must specify acompiler
option.

To embed directives in source files, you can edit the files using an external editor, or you can
edit the file within the Cycle Model Studio.

1. Double-click asourcefileinthe RTL Sourceslist and the fileis displayed in the Main view.

Project Explorer B /Directives\ Nector.;}\ .-
x| 72 A
+ 1 Project6.carbon 73 endmodule
= ARM Cycle Model: libProj... 74
i Compiler Directives 75 module sub ( clk, rst, in, out );
|l libProjecté.symtab.db 76 input clk;
= |3 RTL Sources 3 .
< 2 RTL Model 77 ;nput _rst,
T 78 input in;
+ [ Generated Files 79 output out;
p = libProjecté 80
© Files 81 reg q; // ARM CM observeSignal
82
83 always @(posedge clk) begin
84 if (rst)
85 q<=0;
86 else
87 q <= in;
88 end
89 assign out = q;
20
921 endmodule
92
(<] n ] E|_
Figure 3-23 Add Directives in RTL Source File
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2. Addthedirectivesto the modules and ports. Sample directives are shown in aVerilog filein
the figure above.

3. Click the Compile button to recompile the Cycle Model with the selected directive settings.
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Chapter 4

Creating Components for Specific Platforms

This chapter describes the process for creating Cycle Models for specific platforms. Cycle
Model Sudio can create models for multiple platforms, as described in the following sections:

Understanding the Process

Starting and Configuring the Project
SoC Designer-Specific Information
Using the Component in SoC Designer
Platform Architect-Specific Instructions

Creating Components for SystemC
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4.1 Understanding the Process

Cycle Model Studio manages the process of creating models for specific platforms so that
changes made to the source RTL automatically regenerate any components derived from that
RTL (see Figure 4-1).

Cycle Cycle Model
l:> Model Studio |:> libdesign.a
Compiler libdesign.lib

Cycle -
Model Studio |l (" o, 2 oaehtect
Component SvstemC ‘:> Component
Generator y

Cycle Model Studio

Component Tuning

Figure 4-1 Cycle Model Studio Process Flow - Component Generation

After compiling the Cycle Model from your source RTL, the next step isto generate a compo-
nent that is compatible with your simulation environment.

4.1.1 Cycle Model Studio Component Generator Overview

The Cycle Model Studio tool can package a Cycle Model in the form of an SoC Designer, Plat-
form Architect, or SystemC component. Refer to the section Starting and Configuring the Proj-
ect for general instructions and information about configuration options. For important
information about the different component output formats, refer also to the relevant section:
SoC Designer-Specific Information, Platform Architect-Specific Instructions, or Creating Com-
ponents for SystemC.

The Cycle Model Studio tool has several powerful features that allow you to integrate more
tightly with the SoC Designer environment, for example:

Transactor Adaptors
Connect your component directly to transaction-level interface ports.

Clock and Reset Generators

Note: Clock and Reset Generators are not supported for Platform Architect components.
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The clocks are an abstract construct that merely indicate when it is time for your component to
execute another ‘cycle.” HDL designstypically require aternating signal values of 0 and 1. The
Cycle Model Studio tool’s clock and reset generators automatically stimulate your Cycle Model
with signal values on every clock pulse, or on the schedule you set up. Refer to “Clock Inputs
and Clock Generators’ on page 148 for more information.

Debug Registers
RTL signals deep inside the Cycle Model may be made available as named debug registers for
read and write during simulation.

Debug Memories
HDL memories may be made available for debugging by adding a memory to the memoriestab
(see“Memories Tab” on page 110).

Profiling
Capture Cycle Model state datain aform that can be easily analyzed using the SoC Designer
profiling tools.

Note: Profiling is not supported for Platform Architect components.

Ties and Disconnects
Cycle Model input ports (e.g. test inputs) may be tied to a constant value instead of exposed as
component ports.

Cycle Moddl output ports may be left unconnected (disconnected), instead of exposed as com-
ponent ports.

Port Expressions

The value of signal ports may be modified by providing a C language expression. Thisis often
useful to bridge the gap between an abstract and RTL signal interface (for example, to convert
an integer value into a bit mask).

Pseudo-Transactors

Some common Port Expressions have been packaged in the form of Transactors for your use.
For example, the Interrupt_Master and Interrupt_Slave transactors handle conversion of integer
interrupt numbers into bit masks, and vice-versa.

TheNull_Input and Null_Output transactors may be used to add extra SoC Designer portsto the
component that are not connected to the Cycle Model. Thisis useful for matching the port inter-
face of abehavioral component for which the component will be substituted. See Appendix A
for more information.
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4.1.1.1 Transactors

SoC Designer supports transaction-level port interfaces, but Cycle Models typically communi-
cate at the pin level. Transaction adapters (known as Transactors) are provided to convert
between several common transaction level interfaces and the Cycle Model pins.

Note: If you are creating a model for Platform Architect, note that the term used in the GUI
changes from“ Transactor” to “ Protocol.”

Refer to the SoC Designer User Guide or Platform Architect documentation for details about
the difference between transaction-based and signal-based communication in the selected envi-
ronment.

The transactors you add to your component in the component typically add new SoC Designer
transaction ports, and hide Cycle Model ports.

For example, an AHB_Slave T2S converts AHB transactions to signal value changes (T2S
means “transaction to signal”). When you add an AHB_Slave T2S transactor to your compo-
nent in the Cycle Model Studio tool, a new transaction slave port is created in the component
for incoming AHB transactions. You must use the Cycle Model Studio tool to connect the trans-
actor to the appropriate Cycle Modd signal ports. Each Cycle Model signal connected to the
transactor is no longer exposed as a port.

The resulting component may be connected to a transaction master port.

4.1.1.2 Component Clocking

The component generated by the Cycle Model Studio tool uses cycle-based scheduling. Refer to
the SoC Designer User Guide or Platform Architect documentation for information about cycle-
based scheduling.

The component has a clock input port named ‘clk-in". Thisis acycle-based clock, not an RTL
signal port. The clk-in port determines how frequently the component is called to execute a
cycle. For more information about clocking options, refer to “Clock Inputs and Clock Genera-
tors’ on page 148.

» If you connect the clk-in port to the clock master port of another component (e.g., aCDIV
clock divider), then that component determines when the component runs acycle.

» If you do not connect the clk-in port to anything, then the component is driven by the simu-
lator reference clock, running one cycle per time unit.

The component is a subclass of C++ class sc_mx_module. It implements the two methods —
update () and communicate () — which are called by the clock master to which the clk-in
port is connected.

In the communicate () method, all output ports that have new values are driven.
Intheupdate () method, the Cycle Mode is executed.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 80
ID111516 Non-Confidential



4.1.1.3 Clock Generation

In SoC Designer cycle-based scheduling, thereis no signal value (i.e., 1 or 0) associated with a
clock slave port. The SoC Designer clock dave port is only a mechanism for configuring when
the component communicate () and update () methods are invoked.

Note: Clock Generators are not supported for Platform Architect components.

You can drive the Cycle Model clock signal ports using a Cycle Model Studio clock generator.
A clock generator applies 0 and 1 signal valuesto the Cycle Model clock signal ports every time
the component’supdate () methodiscalled. A clock generator may be configured to run at the
same speed, faster, or slower than the SoC Designer reference clock.

Note: Rather than creating a clock generator, ARM recommends creating a clock input trans-
actor and exposing the clock input port externally.

For additional information on the use of clock generators, refer to “ Clock Inputs and Clock
Generators’ on page 148. For instructions on creating a clock generator, refer to “ Specifying
Generated Clocks’ on page 91.

ARM DUI 0958E
ID111516

Copyright © 2016 ARM Limited. All rights reserved. 81
Non-Confidential



4.2 Starting and Configuring the Project

Use the Cycle Model Studio Project Explorer view to begin.

1. IntheProject Explorer, right-click the Cycle Model to display the context menu.

2. From the context menu, select:
— Create SOC Designer Component for SoC Designer
— Create CoWare Component (for Platform Architect)
— Create SystemC Component (for SystemC)

Project Explorer 3]
}.

~ 2 Project7.carbon

$t compil{ Create CoWare Component...

| ] libProje¢  Create SOC Designer Component...
= 2 RTL S0y Create SystemC Component...
va F_tTL Add RTL Source(s)...
AV pddRTL Library...

— | Genera
b aw [ippn  Compiler Settings...

= Files
= »m SpC Designer Component
= libProject7.ccfg
%3 mx.top.h
] mx.top.cpp
%] makefile.libProject7.mx

Figure 4-2 Select the Type of Component to Create
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The new component, and its associated output files, are displayed in the Project Explorer as
shown in Figure 4-3.

Project Explorer 3]
x

3 || &

-l Project7.carbon
= = ARM Cycle Model: libProj...
#: Compiler Directives
[ libProject?.symtab.db
= [ RTL Sources
= |3 RTL Model
=] vector.v
< |29 Generated Files
B oa libProject?
=3 Files
=4 libProject7.ccfg
%] mx.top.h

] mx.top.cpp
%] Makefile.libProject7.mx

Figure 4-3 Component for SoC Designer in Project Explorer
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4.2.1 Editing the Component Properties

Use the Component Properties view (shown in Figure 4-4) to edit the component properties.

' SOC Designer Component Properties 2]

I = || 4] | [Reset All || Reset

Name Value SoC Designer

+ Component Generation properties
C++ Compile Flags
Export to SystemC false
Include Files
Linker Flags
Source Files
Use Static Scheduling false

< Component Properties
Component Name apb_slave
Component Type Other
Loadfile Extension
Transactor Definition File
Waveform File

Waveforms None

+ Properties
(IODB File) ../libProjectl.symtab.db
(Output Directory) fhome/fcds/tlussier/CM5_example/CMS_TEST/transactor_...

, CoWare Component Properties V] |

(=)(24) | Reset All || Reset |

Name Value

= Platform Architect
Force Update false .
Module Name apb_slave properties
(Top Module) apb_slave

< Properties
(IODB File) ../libProjectl.symtab.db

(Output Directory) /home/cds/tlussier/CMS_example/CMS_TEST/transactor_compy...

Figure 4-4 SoC Designer Component Properties

The component properties differ depending on the type of component you are working with; for
example, SoC Designer components have “Waveform File” and “Waveforms™ properties, while
Platform Architect components do not display these properties. When a property is selected,
information about that property is displayed in the lower-right information panel of the CMS
GULI.

4.2.1.1 Naming the component

By default, the name of the top-level module is used for the component, the SoC Designer C++
class name, and the * . cpp and * . h files generated by Cycle Model Studio. The Cycle Model
Studio project name is not used. This name is shown in the Component Name or Model Name
field.

To change the component hame:

1. Click in the Component Name field (for Platform Architect, Module Name) to highlight the
current component name.

2. Typethe new name.
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4.2.1.2 Specifying Force Update

Force Update (supported for Platform Architect only) specifies that callsto
sc_prim channel::request update areforced for al input changes. If thisis not speci-
fied, request update iscaled only for clock, reset, and feed-through inputs.

4.2.1.3 Enabling Waveform Generation

For SoC Designer
To use the dump to waveform feature:

1. InthePropertiesview, under the Component Properties section, click the Browse buttonin
the Waveform File field to display the Output File dialog (Figure 4-5).

[=)- Component Properties
Component Mame ¥ic_carbon
Loadfile Extension
Transackor Definition File

W aveform File
waveforms Mone

& = @l
Lookin:  [f)/nome/cas/tonac kKVProjects/ProjectzDd oo o@mE
[ Computer | Linux
9 tonacki

File name: SaMe

SRR R = ave File (*.dump * ved *fsdb) Cancel |

Figure 4-5 Enable Waveforms in SoC Designer Component

2. Inthe Output File dialog, browse to the location of an existing wave file, or create a new
file namein the File namefield, and then click Save.

3. Click the drop-down menu from the Waveforms field and select the waveform file format
you want to use, as shown in Figure 4-6.

[=)- Companent Properties
Compaonent Mame ¥ic_carbon
Loadfile Extension
Transactor Definition File
‘Waveform File

A

waveforms Mane [
Mone
FSDE
WD
Figure 4-6 Waveform Type
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Note: By default, design elements larger than 1024 bits are not dumped to waveform files. To
allow elements larger than 1024 bits to be dumped, increase the maximum size using the
-waveformDumpSizeLimit compile option under Net Control.

For Platform Architect
To dump data to waveforms for Platform Architect:

add

-DCARBON DUMP_VCD=1
or

-D CARBON_ DUMP_FSDB

to scsh preprocessor options.
For example:

::scsh:: cwr append simbld opts preprocessor -DCARBON DUMP FSDB=1
Note: By default, design elements larger than 1024 bits are not dumped to waveformfiles. To
allow elements larger than 1024 bits to be dumped, increase the maximum size using the
Cycle Model Compiler -waveformDumpSi zeLimit option under Net Control.
4.2.1.4 Setting Compiler and Linker Flags

The Cycle Model Studio allows you to customize your component by adding C++ Compile
flags, with paths to include files, macros, etc., and Linker flags, with pathsto include libraries,
source files, etc.

Note: This functionality is not supported for Platform Architect.

To use the Compiler and Linker flag feature:

1. Inthe Component Properties view, click the Value cell in the C++ Compile Flags row to
enable the text field (Figure 4-7).

—|- Companent Generation
C++ Compile Flags |

Include Files
Linker Flags
Source Files

Figure 4-7 Compiler and Linker Files and Flags
2. Enter the required compile flags.

Note: If you are creating a model to be used as a Swap & Play memory controller, add the fol -
lowing C++ Compile Flag:

-DCARBON MEMORY RESTORE_PORT <portnames
where <portname> isthe port with the lowest memory address region.

3. Click the Value céll in the Include Filesrow to add additional include filesto be passed into
the generated M akefile.

4. Click the Value cell in the Linker Flags row and enter any required Linker flags.
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5. Click the Value cell in the Source Files row to add additional source filesto be passed into
the generated Makefile. For example, if you plant to use disassemblies (see “ Creating Dis-
assembly Views’ on page 117), then you must list here the source files to be used.

4.2.2 Component Editing View

The Component Editor provides tabs to access ports, registers, memories, and profile (SoC
Designer only). Double-click the .ccfg file in the Project Explorer to display the Component

Editor (Figure 4-8).
|/ bProjecti.cofg™, x
x Transactor: |AHB Slave_T2= j i =
Delete | Lndo Fedo ' — - Add Transactor | Add Parameter
Item [1crvae | size [=!
= Component Ports
12 HADDR Yic carbonHADDR 12
© HBURST Wic_carbon HBURST 1
2 HCLK Yic_carbonHCLK 1
) HMASTER Wic_carbon HMASTER 1
(2 HMASTLOCK Vic_carbon HMASTLOCK 1
-2 HPROT Yic_carbonHFROT 1
-2 HRDATA Yic_carbonHRDATA 32
- (2 HREADYIMN YWic_carbon HREADYIN 1
- (& HREADYOUT Vic_carbonHREADYOUT A1
- %) HREZSETN Vic_carbonHRESETR 1 |
- &) HRESP Vic_carbonHRESP 2
) HSELWIC Vic carbon HSELWIC 1
= ey H=IAE } slelg E 3
-2 HTRAMNS ic_carbonHTRAMNS 2
) HWDATA, Wic carbonHWDATA 32
-2 HWRITE Wic carbonHWRITE 1
- (2) SCANENABLE Vic_carbon SCAMNEMNABLE
) SCANINHCLEK Wic_carbon SCANINHILEK 1 |
Ports /% Registers /' Memories /% Profile /
| ] I 0%
= |
N ]
Component Editor Tabs for SoC Designer
libProiect7.svmtab.db
X - B =
Delete | | yndo | | Redo Transactor: | AHB_Lite 2 Add Transactor| |Add Parameter
Item Id/Value Size Mode Type
< Component Ports
) clk top.clk 1
@ in top.in 5
® out top.out 5
(2 rst top.rst 1
Component Parameters
RTL Ties
RTL Disconnects
Reset Generators
Clock Generators
anta/ \Rea is’rers/ \MEM w
Component Editor Tabs for Platform Architect
Figure 4-8 CMS Component Editor
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4.2.2.1 Ports Tab

Use the options on the Ports tab to connect the Cycle Model’s inputs and outputs to the compo-
nent’s signals and drivers.

The Ports window is composed of sectionsin atree-like structure: Component Ports, Compo-
nent Parameters, RTL Ties, RTL Disconnects, Reset Generators (not available for Platform
Architect), and Clock Generators (not available for Platform Architect). You use thiswindow to
define and configure the ports that are exposed in the completed component.

Component Ports Window

By default, the Component Ports section of the tree is expanded. The first column lists the ESL
ports mapped to the corresponding RTL portsin the second column. Initialy, there is a one-to-
one correspondence of port namesin the RTL and ESL Portslists. The RTL portsthat are dis-
played include all the primary 1/Os of the Cycle Model, plusinternal signals that were marked
with the directive observeSgnal/scObserveSignal or depositSignal/scDepositSignal when the
Cycle Mode was compiled with the Cycle Model Compiler.

Each RTL port may be connected to the following sources:

» ESL Input or ESL Output

* Generated Clock
* Generated Reset
 Tie

» Disconnect

» Transactors

These connections are established by selecting one or more RTL ports (use Ctrl-click to select
multiple ports) and then selecting an entry from the right-click context menu. The context
menu offers different functions depending on the type of port, or nhode, you select in the Ports

tab. Thisis shown in Figure 4-9.

= Component Ports
-3 HADDR

- HBURST

- (3) HCLKE

=5 HMASTER
-2 HMASTLOCK
-3 HFROT

- ©) HRDATA
-2 HREADYIN

- HREADYOUT
-(3) HRESETn

- & HRESP

-3 HSELVIC

-3 HSIZE

- (3) HTRANS

-3 HWDATA

-3 HWRITE

- (3) SCANENABLE
- (3) SCANINHCLE
- (2) VecAddrin

- (€ VecAddrOut

Vic_carbonHADDR 12
Wic_carbon HBURST 1

Wic_carbon HCL

1

Wic_carbonHFR
Wic_carbon HRE
Wic_carbon HRE
Wic_carbon HRE
Wic_carbon HRE
Wic_carbon HRE
Yic_carbon HSE
Wic_carbon HSIZ

Vic_carbonHTR @ Change to Cutput

Wic_carbon HWE

vic_carbonHwF  Delete Del
Vic_carbonSCA w Undo Ctiez
Wic_carbon.SCA Redo ey

Wic_carbon\Wecs

Tie High —

Tie Low

Create Reset Generator

Create Clock Generator

Add Port Expression

Connect to Parameter 4
») Change to [nput

Yic_carbonWecAddrOut

32

Figure 4-9 SoC Designer Component RTL Port Connection Options
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The ESL ports are the ports through which SoC Designer or Platform Architect connect to the
component. These include signal ports (connected directly to the Cycle Model) and transactor
ports. As necessary, reconnect RTL portsto clock generators, reset generators, ties, and transac-
tor ports. You can also add additional ESL ports from the Design Hierarchy, and change the
direction of ports.

Depending on the option you select, the RTL port is moved to the applicable section. For exam-
ple, if you disconnect a port it is moved to the RTL Disconnects section. Any errors that occur
during these operations appear in the Model Studio Status Bar. These selections, and their corre-
sponding fields, are described in the following pages.

Note: If an RTL signal is connected to a Generated Clock, Generated Reset, or Tie, then it may
only have one connection.

Ports Toolbar

The Portstab includes the Ports Toolbar (Figure 4-10), which you can use to further define your
SoC Designer component.

; - b =
VNS |AHB_8Iave_T28 J Add Transactor | Add Parameter

x

Delete

Undao | Redo

Figure 4-10 Ports Toolbar
The buttons include:

» Delete— Performs different functions depending on where this operation is used. For
example, in the Component Ports section this moves an RTL port to the Disconnects sec-
tion. In the Disconnects section this operation moves the port back to the Component Ports
section to reconnect to an ESL port.

e Undo— Cancelsthe last operation.
* Redo— Performs aredo of a previous undo operation.
 Transactor: — Lists the available transactors. For Platform Architect, thisis“Protocol.”

* Add Transactor — Opens the Add SoC Designer Transaction Port dialog, where you can
add a transactor to the SoC Designer component and map the RTL ports to the transactor
ports. For Platform Architect, this button is called “Add Protocol .”

e Add Parameter (not available for Platform Architect) — Adds parameters to your compo-
nent that can be accessed in the SoC Designer environment. The parameter can also be tied
to RTL or ESL ports.
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Changing ESL Port Names

The port names shown in the list are the names to be assigned to the ports of the finished com-
ponent. By default, the input and output pin names used in the RTL code are also used in the
ESL port list. Cycle Model Studio enables you to change the ESL port names within the Com-
ponent Ports section (see Figure 4-11).

ltern [1drvalue [ size

= Component Ports

2+ HADDR Yic_carbonHADDR 12
€ HBURST Yic_carbonHBURST 64
2 HCLK Yic_carbon HCLK 1
Vic_carbon HWMASTER

B HASTERN
+) HMASTLOCK Vic carbon HMASTLOCK 64

Figure 4-11 Component ESL Port Name

To change the name of an ESL port or transactor port:

In the Component Ports section, click on the port you want to rename.

2. Typethe new name.

Tying Off Signals
You should disconnect, or tie off, any signals that do not need to change during validation, such
as scan-enable. To tie off input pins:

In the Component Ports section, select the input pin whose signal you want to tie.

2. Right-click and select Tie High or Tie L ow from the context menu.

The port is moved to the RTL Ties section along with the selected tie value, and it is
removed from the Component Ports list, indicating that this pin will not be used as an input
port. You can change the tie value later in the RTL Tieslist

(Figure 4-12) if required.

= RTL Ties

- B & Vic_carbonHPROT 1

b Tied Value 0w

- B & Vic_carbon HWDATA 32
b Tied Value O fTFFFFTT

Figure 4-12 RTL Ties list

Note: Any RTL port on which the tieNet directive has been applied is automatically marked as

tied in this pane, with the message “ Set by Compiler” .

If you decide later that a port does not need to be tied off, just right-click the port in the RTL
Ties section and select Delete from the context menu. The port is removed from the tie offs list
and appears back in the ESL portslist.

Disconnecting Signals
To disconnect any input or output pins that are not needed:

In the Component Ports section, select the pin whose signal you want to disconnect.

2. Right-click and select Delete from the context menu.
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The port is moved to the RTL Disconnectslist (Figure 4-13), and it is removed from the
Component Ports|list, indicating that this pin will not be used as an input or output port.
= RTL Disconnects

< \ic_carbonHRESETN »1 input
< \ic_carbon HRESP ©2 output

Figure 4-13 RTL Disconnects list

If you decide later that aport should be connected to an ESL port, just right-click the port in the
RTL Disconnects section and select Delete from the context menu. The port is removed from
the Disconnects list and appears back in the Component Ports section.

Specifying Generated Clocks

When you mark your design’sinput clock signals as generated clocks, the Component generator
does not create ESL ports for these signals. Instead, the Component generator creates internal
signals that are used to activate the component when SoC Designer sends a reference clock sig-
nal to the component.

Note: Clock Generators are not supported for Platform Architect.

Note: Rather than using clock generators, ARM recommends creating clock input transactors
and exposing the clock input ports externally. For more about the use of clock genera-
tors, refer to the section “Clock_generator” on page 152.

In the Component Ports section, select the signal that you want to designate as a clock.
2. Right-click and select Create Clock Generator from the context menu.

The signal and default values appear in the Clock Generators section, and it is removed
from the Component Ports ist.

3. Moadify the clock controls as necessary in the Clock Generators section, as shown in Figure
4-14.

=- Clock Generators
B- (9 Vic_carbon HCLK i

- Inltial Value Low
- Dalay 0%
-~ Duty Cycle 50%
= Frequency

- Clock Cyclas 1

- Component Cyclas 1
Figure 4-14 SoC Designer Component Clock Settings

For details about parameter settings, refer to “Clock Inputs and Clock Generators’ on
page 148.
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Specifying Generated Resets

In general, you should mark your design’s reset signals as generated resets. This prevents the
Component generator from creating unnecessary ESL ports for these signals. Instead, the Com-
ponent generator creates internal signals that activate the component when SoC Designer sends
a user-activated reset signal to the component.

Note: Reset Generators are not supported for Platform Architect.

1. Inthe Component Ports section, select the signal that you want to designate as a reset.
2. Right-click and select Create Reset Generator from the context menu.

The signal and default values appear in the Reset Generators section, and it is removed
from the Component Ports list.

3. Moaodify the reset controls as needed in the Reset Generators section, as shown in
Figure 4-15.

=- Reset Generators
= ¢ Vic_carbon HRESETH i

- Active Valus 1
- lnactive Value 0w
- Cyicles Belore 0
-~ Cyicles After 1
- Cyicles Asserted 1

= Frequency
- Aeset Cyclas 1

- Component Cycles 1

Figure 4-15 SoC Designer Component Reset Generator Settings

Resets are specified as follows:

— Active Value and Inactive Value: Specify ahex or decimal valueto be used whenreset is
active (asserted) and when it isinactive (deasserted). The default is 1 for active and O
for inactive. The values can be used so the reset generator can be applied to a bus of
reset signals.

— Cycles Before, Cycles Asserted, Cycles After:
Cycles Before is the number of cycles to wait during the reset period before asserting
the signal.
Cycles Asserted is the number of cyclesthe signal remains asserted.
Cycles After is the minimum number of cyclesthe signal remains deasserted before the
reset period ends.

— Freguency, as areset cycle-to-component cycleratio:
1:1 means one reset cycle per one component cycle; thisis the default setting
2:1 means 2 reset cycles to one component cycle
1:2 means 1 reset cycle extends across two component cycles
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The length of the reset period is determined by the longest reset waveform duration.
All reset waveforms that complete before the end of the period are extended by pad-
ding the deasserted time. See the examples below.

Active Value =1
Inactive Value =0

Frequency: 2 reset cycles per 1 component cycle = 2:1
Cycles: before, asserted, after (deasserted) =1, 2,1

<«—Asserted =2 cycles at 2:1—»

<«—Before = 1—» +—After =1—»

Active Value =1

Inactive Value =0

Frequency: 4 reset cycles per 1 component cycle = 4:1
Cycles: before, asserted, after (deasserted) =3, 3, 1

<«—Asserted = 3 cycles at 4:1-»

<+«—3Cyclesat4:1—» - Padded -

0 1 2
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Adding ESL Ports

All ports are automatically added and displayed in the Ports view. You can add additional ESL
Ports that you want to be accessible through the component. Only ports that have been marked
observable or depositable can be added to the component.

Right-click on the Component Ports node, as shown in Figure 4-16, and select “Add trans-
action port” from the context menu.

Item Id/Value Size | Mode Type
? paddr lon... sc_uint
2 pclk Delete Del .‘!ock bool
\? penable = ton... bool
(© prdata Undo Ctr+Z on... sc_uint
2 psel ton... bool
2 pwdata app_slave.pwoata 32 Lon... sc_uint

(=) nwrite anh clave nwrite 1 Con hnnl

Figure 4-16 Add Port to Component

Click on the new port and use the context menu to make further changes.

By default, the ESL Port name is the same as the RTL net name. See “Changing ESL Port
Names’ on page 90 if you want to change the port name that is exposed in the component.

Adding Transactors and Other Interface Entities

This section applies to transactors, protocols (for Platform Architect), and other entities,
referred to as pseudo-transactors, which act as go-betweens from ESL portsto Cycle Model
ports. The pseudo-transactors handle interrupt signals, input clocks driven at variable speeds,
generated output clocks, and null ports (ESL ports that are not connected to RTL ports). In the
steps below, the terms transactor and protocol include pseudo-transactor entities. See Appendix
A for more information.

To use transactors/protocols in your component, you need to specify the type of transactor or
protocol, and then map the desired RTL ports from your design to the transactor’s or protocol’s
ports. SoC Designer creates a connection to the transactor/protocol, but the connections
between the transactor/protocol and the Cycle Model are invisible to SoC Designer.
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To add atransactor or protocol:

1. Inthe Ports Toolbar, click the Add Transactor button (for Platform Architect, the
button is Add Protocol). The Add Port dialog appears (Figure 4-17).

|' i Add SoC Designer Transaction Port =
Interface Type: [AHB_Lite_Master_FS2T S ]
Mame Matching
RIL Prefis: | | AL surms: | |

+| Apply matches to unbound ports only [ ] [.Advanced Matching... ]

Port Hame v RTL Hame Potential Matches A
1
2 | exresp [ = lArterisFIexNoC.Clk
3 |haddr [ = l <ArterisFlexMNoC.Clks : Incompatible port directions
4 |hhstrh [ = l <ArterisFlexMNoC.Clks : Incompatible port directions B
5 |hhurst [ = l <ArterisFlexMNoC.Clks : Incompatible port directions
B |hdomain [ e l <ArterisFlexMNoC.Clks : Incompatible port directions
7 |hlock [ = l <ArterisFlexMNoC.Clks : Incompatible port directions
& |hprot [ = l <ArterisFlexMNoC.Clks : Incompatible port directions =

| oo || @ || Do

Figure 4-17 Add Port dialog

2. Click the Interface Type pulldown menu to display the available transactors. Select the
transactor or protocol to use for your design; the example (Figure 4-18) selects an
AXI_Flowthrough_Master transactor.

x|

|'- i Add SoC Designer Transaction Port

Interface Type: [SAXI_Flowthru_Master S ]

Mame Matching
RIL Prefis: | | AL surms: | |
+| Apply matches to unbound parts only [ ] [.Advanced atching... ]

Fort Mame % RTL Mame Fatential Matches Z

1 |araddr [ = l <ArterisFlexMNoC.Clke : Incompatible port directions

2 |arburst [ = l <ArterisFlexNoC.Clks : Ihcompatible port directions B

3 |arcache [ = l <ArterisFlexMNoC.Clke : Incompatible port directions

4 |arid [ = l <ArterisFlexNoC.Clks : Ihcompatible port directions

5 |arlen [ = l <ArterisFlexMNoC.Clke : Incompatible port directions

B |arlock [ = l <ArterisFlexNoC.Clks : Ihcompatible port directions

7 |arprot [ = l <ArterisFlexMNoC.Clke : Incompatible port directions

g | arreacy [ = lArterisFIexNoC.Clk =

(Vo |[ @i | (P2 ]

Figure 4-18 Selected Transactor in SoC Designer Transaction Port dialog

By default, Model Studio selects the most likely RTL ports to be mapped to the trans-
actor or protocol portsin the Potential Matches column. It does this by matching the
name of the port to the RTL port. Refer to the transactor’s or protocol’s user manual
for pin names.
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3. Usethefollowing options to complete the mapping of RTL ports to transactor ports:

— If your RTL pin names match the transactor/protocol pin names, and the ports are
mapped correctly for your design, click Apply. The portsin the Potential Matches
column move to the RTL Name column.

— Useregular expressions to more efficiently match port namesto RTL signals. Refer to
“Using Regular Expression Name Matching” on page 97 for more details.

— If the RTL ports adhere to the transactor or protocol naming convention, but have a
common prefix or suffix appended to the name, use the RTL Prefix and RTL Suffix
fields to identify the common prefix or suffix to use in the name matching for the port
bindings.

— Use the pulldown menu selections in the RTL Name column to select an RTL port for
each transactor or protocol port.

Note: Clicking the Reset button clearsthe list of RTL portsif you want to restart the port map-
ping.

4. Click OK. The transactor or protocol is added to the Component Ports section of the tree
(Figure 4-19).

ltern [1drvalue [ size
=- Component Ports
BF - AHB Slave [0S AHE

- Clocked By Component
-2 HADDR Vic_carbonHADDR 32
- & HBURST 3
(3 HMASTER Vic_carbon HMASTER 4
- (3) HMASTLOCK Vic_carbon HMASTLOCK 1
- (3 HFROT Vic_c§rbon.H PROT 4
- €) HRDATA Vic_carbonHRDATA 32
-3 HREADY Vic_carbonHREADYIN 1
- &) HREADYQUT Vic_carbon HREADYOUT 1
- €) HRESP Wic_carbonHRESP 2
- (2) HSEL Wic_carbon HSELYIC 1
- (2) HEIZE Wic_carbon HSIZE S
- (2) HTRAMNS Wic_carbonHTRAMNS 2
- & HWDATA 32
- & HWRITE 1
- Parameters

Figure 4-19 Transactor added to Component Ports section

The transactor or protocol added to the Component Ports section includes its name, how it
is clocked, the list of ports and their mapping to RTL ports, and the available transactor or
protocol parameters (with default settings).

To change the name of the transactor or protocal, click on its name and type a new name.

If you need to change the transactor or protocol port mapping, double-click the top-level
name and the Edit Connections dialog appears. From there you can change any port map-

pings.

Note: If you need to create and use your own transactor, see Appendix B.
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Using Regular Expression Name Matching

You can use regular expressions to more efficiently map transactor or protocol portsto RTL sig-
nals:

1. Click Add Transactor (Add Protocol on Platform Architect).

2. Onthe Add Port dialog, click Advanced Matching. The Regular Expression Name Match-
ing dialog appears (Figure 4-20).
|'-- Regular Expression name Matching |

Enter Regular Expression Pattern {then click &pply )

[ vl sy |

String to test pattern with {choose RTL signal)

[ v]

Resulting string {to match Ktor port name)

[ ]

# Capture Type

Figure 4-20 Regular Expression Name Matching dialog

3. Click the Sring to test pattern with pulldown to select one of the RTL signals you want to
match (Figure 4-21). Thisis used to test and verify your regular expression output.

4. Inthe Enter Regular Expression Pattern field, specify the regular expression to use (Figure
4-21). For details about using regular expressions, refer to the QT® Developer Network
QRegExp Class Reference.

|'-- Regular Expression name Matching x

Enter Regular Expression Pattern {then click &pply )

[ arterisPesoCuoot_(7)_(7) v |l ey |

String to test pattern with {choose RTL signal)

[ ArterisFlexMNoC boot_sw _Prot » ]

Resulting string {to match Ktor port name)

[ ]

# Capture Type

Figure 4-21 RTL signal and regular expression specified
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5. Click Apply. SoC Designer applies the regular expression pattern you specified to the test
string, and displays the result in the Resulting Sring field (Figure 4-22). Modify the regular
expression as needed and click Apply until the required string results.

|'-- Regular Expression name Matching |

Enter Regular Expression Pattern {then click &pply )

[ arterisFestoCyboot_(*)_(7) vl Apply

String to test pattern with {choose RTL signal)

[ ArterisFlexMNoC boot_sw _Prot » ]

Resulting string {to match Ktor port name)

[ AweFrat ]

# Capture Type

1|0 A Prefix =

201 Frat Prefix

L13

Figure 4-22 Resulting string

6. If necessary, assign Prefix, Suffix, or Remove to the captured name elements.

x|

|' | Regular Expression name Matching
Enter Regular Expression Pattern {then click &pply )
[ arterisFestoCyboot_(*)_(7) vl Apply
String to test pattern with {choose RTL signal)
[ArterisFIexNoC.boot_Aw_Prot » ]
Resulting string {to match Ktor port name)
[AwProt ]
# Capture Type
1|0 A Prefix =
201 Frat
Suffix
Rermave
° Cancel 0 oK
7. Click OK.

The Regular Expression Name Matching dialog closes. SoC Designer converts each RTL
signal name based on your regular expression. The converted strings are used to find poten-
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tial matches for each transactor or protocol port, and displayed in the Add Port dialog (Fig-

ure 4-23).
| ] Add SoC Designer Transaction Port =]

Interface Type: [AXI_FIowthru_Master S ]

Mame Matching

RTL Prefix: RTL Suffix:

¥ 2pply matches to unbound ports only ArterisFlesMoChboot_{*) (")
Fort Mame % RTL Mame Fatential Matches Z

1 |araddr [ = ]ArterisFIexNoC.boot_Ar_Mdr

2 |arburst [ = lArterisFIexNoC.boot_Ar_Burst ]
3 |arcache [ = ]ArterisFIexNoC.boot_Ar_Cache

4 |arid [ = lArterisFIexNoC.boot_Ar_ld

5 |arlen [ = ]ArterisFIexNoC.boot_Ar_Len

B |arlock [ = lArterisFIexNoC.boot_Ar_Lock

7 |arprot [ = lArterisFIexNoC.boot_Ar_Prot

o |arready [ = lArterisFIexNoC.boot_Ar_Heady =

(e (Voo |[ @ ][ O]

| SO

Figure 4-23 Matches resulting from regular expression

8. Click Apply to make the connections shown. The ports in the Potential Matches column
move to the RTL Name column.

If atransactor’s signals use multiple naming conventions, click Advanced M atching again to
repeat the process. Ensure that Apply matches to unbound ports only is enabled.

Editing Transactor Parameters
Note: This funcitonality is not available for Platform Architect.

Most transactors have parameters associated with them. These parameters appears as compo-
nent parameters in the SoC Designer environment. To edit transactor parameters:

1. Under the transactor, click the plus sign next to Parametersto display the full list of param-
eters. Then click the plus sign next to the selected parameter to display the Value field (Fig-
ure 4-24).
=- Parameters

= Address Bus Width {compile-time) integer
- Valug 32 Width of haddr bus,

Vaite false Replicate Data to alf byte lanes.

=- Base Address {init-time) integer

=- Big Endian {init-time) bool

=- Data Bus Width {compile-time) integer
=- Enable Debug Messages {run-time) bool

=- Filter HREADYIMN {init-time) bool

B- Size {init-time) integer

=- Subtract Base Address {init-time) bool

=- Subtract Base Address Dbg (init-time) bool
=-ahb_sizel {init-time) integer

&- ahb_start1 {init-time) integer

Figure 4-24 SoC Designer Component Transactor Parameters

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 99
ID111516 Non-Confidential



2. Inthe Valuefield, enter the new parameter value, or select the value from a drop-down
menu (Figure 4-25).

=- Parameters

= Address Bus Width {compile-time) integer

- Value 32 Width of haddr bus.
= Align Data {init-time) bool

false =L

= Base Address
= Big Endian
=-Data Bus Width e-lime) Integer
= Enable Debug Messages {run-time) bool

Figure 4-25 SoC Designer Component Transactor Parameter Values

The default value for a parameter is shown in regular text. Any value which has been over-
ridden is shown in bold text.

3. You can right-click aparameter and select Connect to RTL if you want to tiean RTL input
port to atransactor parameter. This removes the corresponding ESL port from the compo-
nent and moves the RTL port under the transactor parameter. When in SoC Designer, set-
ting the parameter value changes the value assigned to the RTL port.

Adding Unused (Null) Ports
Note: This funcitonality is not available for Platform Architect.

In the event SoC Designer requires more ports than are used by your design, you can add
unused ports. Unused ports comprise Null Inputs and Null Outputs and show up as portsin SoC
Designer, but they do not affect the operation of the generated component.

To create Null ports:

1. InthePortsToolbar, click the Add Transactor button. The Add SoC Designer Transaction
Port dialog appears.

Select Null_Input or Null_Output from the Transactor Type pull-down menu.
Click OK and the transaction port is added to the Component Ports list.

Transactor Clocking
Note: This funcitonality is not available for Platform Architect.

You can run atransactor at a different speed than the ESL reference clock by associating it with
aClock_Input or Clock_Generator pseudo-transactor. Follow the steps bel ow:

1. Create and configure a Clock_Input or Clock_Generator transactor (for specific instruc-
tions see “ Specifying Generated Clocks’ on page 91).

2. Select thetransactor in the ESL Ports list; for example, the AHB_Slave T2S.
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3. Inthe Clocked By field, select the clock pseudo-transactor that has been defined with the
different clock settings (Figure 4-26).

ltern [1drvalue [ size

= Component Ports
- 2 AHB_Slave _T28

AHB Slave T2S
Component =]
Component

> HADDR
@ HBURST

LA HMACTER

BN N)
]

Figure 4-26 Selecting the Clock to Use for a Transactor

Adding Parameters to your Component
Note: This funcitonality is not available for Platform Architect.

You can add parameters to your component that appear as object parametersin SoC Designer.
You can create init-time parameters and run-time parameters. Init-Time parameters can be
changed in the SoC Designer Canvas only. Run-Time parameters can be changed in the

SoC Designer Canvas and at runtime during simulation.

To add a parameter in the Component Parameters list, follow the steps below:

1. Right-click the Component Parameters heading and select the Add Parameter option from
the context menu. You can also click the Add Parameter toolbar button. The Add New
Parameter dialog box appears (Figure 4-27).

e Parameter | |
Mame: ||

Type: |Umt32 j
Yalue: |

Scope: & Init-Time © Run-Time

Cancel |

Figure 4-27 Add Parameter Dialog Box

scription: |

2. Define the new parameter as described below:
— Enter aName for the parameter.
— Select the Type for the parameter: UInt32 or Bool
— Enter the default Value for the parameter.
— Select the Scope of the parameter: Init-Time or Run-Time.
— Enter aDescription for the parameter.
3. Click OK and the new parameter is added to the Component Parameters list
(Figure 4-28).
= Component Parameters

= [est N integer (Init-time|
- Vaiue 16

Figure 4-28 New Parameter

Note: The new parameters you add can also be used in User Code. See “ Example of adding
Debug Bypass Code to a source file” on page 124 for more information.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 101
ID111516 Non-Confidential



Connecting Parameters to Ports
Note: Thisfuncitonality is not available for Platform Architect.

Component parameters can betied to an RTL input port or to an ESL port. When tied to
an:

* RTL port — The ESL port to which it was connected is removed from the component
visibility, and the value can be changed only in Component Parametersin SoC
Designer.

» ESL port — The value can be changed in Component Parametersin SoC Designer,
and it can be changed by connecting the ESL port. In this case, the parameter valueis
used whenever the ESL port is not connected. If the port is connected, the connection
value takes precedence over the parameter value.

Note: See “Editing Transactor Parameters’ on page 99 for information about connecting
transactor parametersto RTL input ports.

To connect a parameter to an RTL input port:

1. Right-click the parameter name and select Connect to RTL from the context menu
(Figure 4-29).

integer
16 Connect to BTL...

i) Test_Qut integer ;
~RTL Ties Delete Cel
- RTL Disconnects 1 Undo CtrieZ
- Reset Generators -~
.. Clock Generators Fedo CHrlY

Figure 4-29 SoC Designer Component Parameters

Thisdisplaysalist of the available RTL input ports to which the parameter can be
connected in the Choose RTL Signal dialog (Figure 4-30).

et Choose RTL Signal b4

Choose RTL Port(s)

RTL v

top.clk
top.in
top.rst

Cancel

Figure 4-30 Choose RTL Signal Dialog Box
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2. Select the signal from the list and click OK, and the RTL port is moved from the Compo-
nent Ports section to the Component Parameters section (Figure 4-31).

B Component Parameters

B- (1) Test_In integer (Init-time)
- Valus 16
----- Lic_carbon HWDATA RTL Port

Figure 4-31 SoC Designer Component Parameter Mapped to RTL Port

To connect a parameter to an ESL port:

1. Right-click the ESL port name and select Connect to Parameter from the context menu,
and then select the existing parameter (Figure 4-32).

"""’;II\‘\‘LJ'."'\I."‘\ LA LW = IR WL IR ) e

rbon, HYWRITE
_carbon SCANEMNABLE

) SCANENABLE 1 Tie High

- (2) SCANINHCLK Wic_carbon SCANINHCLE 1 Tie Low

-3 VecAddrin Wic_carbonVecAddrin 32

- (© Yechddrout Vie_carbonVecAddrout g2 —reate Reset Generator

- (@ fig Vic_carbon fig i Create Clock Generator

- (@ fig_in Vic_carbon.fig_in 1 Add Port Expression

i e =1 J Connect to Parameter

- (3) irg_in Wic_carbon.irg_in 1 T ————

() Isre Wic_carbon.isrc 32 () Change to lmput Data

=- Component Parameters © Ch to Cutout |

2 () HWRITE integer © hangs 1o PP

- E&‘WE' Q)S I Delete Del

& Data 00 «7 Undo Ctrh-Z
Fedo CHrl-Y

Figure 4-32 Connecting ESL Port to SoC Designer Component Parameter

2. The parameter appears under the name of the ESL port (Figure 4-33).

: HWRIT( 16)
(3 SCANENABLE Vic_carbon.SCANENABLE 1

Added Parameter

Figure 4-33 SoC Designer Component Parameter Mapped to ESL Port

Note: The parameter name does not need to be the same as the port name, but it can be useful
for the user in SoC Designer to know that both methods can be used to affect the port
value.

Using C-Expressions to Modify Port Connections

By default, the signal applied to the ESL port or transactor port in SoC Designer is transmitted
unchanged to the Cycle Model’s RTL port. You can use C-expressionsto create a more complex
connection between the ESL and RTL ports as follows:

1. Highlight an ESL input or output, or atransactor input or output, in the Component Ports
list.

2. Right-click and select Add Port Expression from the context menu. The Port Expression
field appears below the port (Figure 4-34).

Yic_carbon HREADYOQUT 1

= © HREADYOUT

Figure 4-34 Adding a Port Expression
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3. Typeany valid C-expression that references the port by its ESL name in the Port Expres-

sion text input field.

If the connection isan RTL output and ESL output, the port expression modifiesthe RTL output
data before writing it to the ESL port. For the other direction, the port expression modifies the
ESL input value before writing it to the RTL input port.

Examples of Port Expressions

Port expressions provide a mechanism to transform a signal port value between the ESL envi-
ronment and the Cycle Model. The transform is expressed as a C-expression based on the ESL
port name.

Note: Currently, port expressions can only be used on ports that are 64-bits wide or smaller.

To invert the sense of asignal named interrupt, type in a port expression:
! interrupt
To right-shift an address by two, type:

address >> 2

To shift the data by a constant amount; e.g. to shift the data right by two bits before transfer-
ringit:

my esl port >> 2

To tie off the transactor or port:

1

To change encoding from packed to one-hot:

1 << my_esl port

To change encoding from one-hot to packed, call afunction in the C-expression:

log2 (my esl port)

The name used in the port-expression text must match the ESL port name.

Apply port expressions to signal inputs or outputs. When used on an:

Input — The transformation is made after reading the signal value from the ESL environ-
ment and depositing it in the Cycle Maoddl.

Output — The transformation is made after reading the signal value from the Cycle Model
and driving it into the ESL environment.
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Using Functions in Port Expressions

To use afunction in a C-expression, add the code for the function to the User Code section of
the component integration output files. An example user code section for the port expression
log2 (my esl port) isshown here:

// CYCLE MODEL USER CODE [POST INCLUDE] BEGIN
MxU32 log2 (MxU32 value)

{

}

MxU32 result = 0;

while (value != 0)
++result;
value >>= 1;

}

return result;

// CYCLE MODEL USER CODE END

Error Checking

The component generator does limited error checking on a C-expression. If any invalid C syn-
tax or invalid identifiers are detected, these are labeled as “invalid signals’ in the ESL port list.
However, signalslabeled asinvalid can still be saved.

Itislegal to call an external function in the C-expression; however, the Cycle Model Studio
labels the function asan “invalid signal.” Aslong as avalid path to the function isincluded in
the C-expression, the expression is valid and you can ignore the warning.
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4.2.2.2 Registers Tab

The Registers tab, shown in Figure 4-35, manages a programmer’s view of logical registers
inside the RTL. These registers are accessible from the component through the CADI debug
interface of SoC Designer or Platform Architect.

For Platform Architect, the available columns are: Offset, Name, Width, Endian, Description,

and Fields.
I Carbon Website /" libFroject] cofy x
Add. . | Delete Register | Base Address Parameter: | FERIPHEASE j
OFffset | Giroup | Mame | Width | Endian | Description | Fields | Radix | Port
1 |C=0 FegGroupl | regl 32 Little Fegister Description |1 flield | Hex
210x1 FegGroupl | reg2 32 Little FRegister Description 1 field | Hex
3| 0=2 FegGroup2 |regl_1 32 Little Fegister Description 1 field | Hex

RegGroup2  [reg2 egiste ption Hex

Add Field | Delete Field | Bind to Consztant... |
Field | Bits | Arcess | Contents | Source | Memory Indes Motes
j Empty | [310] rw Unbound field

Ports M _Registers /\_Femories [\ Profile J

Figure 4-35 SoC Designer Component Registers Tab

The mapping of logical registersto RTL is controlled by Cycle Model Studio. Each logical reg-
ister isdivided into one or more fields spanning a subrange of the register’swidth. Each of these
fields can be mapped to one of the following:

» A vector or scalar register in the design hierarchy, or a bitselect/partselect of that register

» A constant index into a 2-D array of registers in the design hierarchy, or a bitselect/partse-
lect of that indexed element

* A constant literal

This section discusses:

* Registers Tab Composition

* Adding aRegister

e Setting the Base Address Parameter
» Configuring Register Fields

» Binding aField to a Constant Value
e Binding an RTL Signal to a Register
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Registers Tab Composition
The Registers tab comprises three panes:

* Register Pane— Displaysalist of thelogical registers and their attributes. You can create
any number of registers.

» Field Pane— Displaysalist of the current register fields and their attributes. Any number
of fields can be added, provided their ranges are non-overlapping.

» Design Hierarchy Pane — The lower left subpane displays the module hierarchy of the
current design. When a module instance is selected, the right subpane displays al the sig-
nals within that instance. The size of each signal is displayed, aong with additional proper-
tiesindicating whether the net is visible and/or depositable.

A net needs to be visible to be used in a component register. Nets displayed in red are not
visible. Nets displayed in blue and labeled Visible (sampled) are visible, but areread in an
inefficient manner. To fix each of these issues, use the observeSgnal directive when com-
piling the design with Cycle Model Compiler. Similarly, only signals that are labeled
Depositable can be written with new values through the component register interface. The
depositSignal compiler directive can be used to ensure this.

Adding a Register
To add anew logical register:

1. Onthe Register tab, click Add Register. A new row is added to the Register pane.

2. Double-click the appropriate cell of the table to edit the register’s attributes. For SoC
Designer, thisincludes the Register Name and Group. These fields are used by SoC
Designer for grouping and displaying the register.

3. Additionally, you can access registers defined for the component through the debug ports of
aprotocol slave transactor. To gain accessto the register, specify an Offset and a Port (SoC
Designer only) to use to access the register definition.

Setting the Base Address Parameter
Note: Thisfunctionality is not available for Platform Architect.

The base address parameter is used by SoC Designer to determine the base address when load-
ing virtual registersin the Fast Model dialog. This needsto be specified if you are planning to
use Swap & Play with a custom interconnect component.

By default, SOC Designer uses the address specified by the PERIPHBASE parameter. If you
plan to use an address other than PERIPHBASE for the register’s base address, specify the
address in the Base Address Parameter field.

To set the base address parameter, select the appropriate parameter from the Base Address
Parameter menu. This menu is populated with component parameters that have been defined as
integers (see “ Adding Parameters to your Component” on page 101).

Alternatively, you may enter the base address as a hexidecimal value.
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Configuring Register Fields
To configure register fields:

1. Click to select aregister. The Field pane displays the current list of fields. Initially,
each register has asingle field spanning its entire width.

In the Bits column, click to edit the range of afield within the logical register.
In the Access column, click to edit the field's read/write access.

Click the Add Field button to add a new field (provided there are bitsin the register
not covered by an existing field).

Binding a Field to a Constant Value
To bind afield to a constant value:

1. Sdect thefield and click Bind to Constant.
The Bind Constant dialog appears (Figure 4-36).

Register: HRESETn field: Walue Width: 1

Walue: |D|

¥ walue is Hexadecimal

Cancel | Ok I

Figure 4-36 Bind to Constant Dialog Box

2. IntheValuefied, enter the hex value and click the OK button.
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Binding an RTL Signal to a Register
You can bind signals to registers and edit their parameters as needed.

To bind aregister field to an RTL signal:
1. Dragasignal from the Design Hierarchy view to the Register pane (Figure 4-37).

libProjectlS.ccfg b, x
Offset| Group | Mame  |Width|Endian|  Description | Fields | Rasix | Port

1| 0=0 Registers | VICVectaddrd 32 Littte  Register Description 1 field | Hex

O T

Add Field  Celete Field  Bind to Constant...

Figld | Bits |.ﬁ.ccess| Contents |Source| hemory Indexl Motes

Walue [5:0] nw Vic_carbon.ul¥icectBank VICWectCntl  [5:0]

Registers /\_temories /% Profile /

Design Hierarchy
Modules Nets:  Fiter [ |  Explicy Observeable  Explicitly Depositable
|Info 21 | Name i |Range |Directi0n |Size |Type |P.ttributes |Flags(as compilec';]

383 nets, 23 instances B YICIRGStat., [31:0]  Input 32 Array

Wectaddr [31:0]  Output

VectCntl [3:0

1& nets, 0in

ulvicectBank (VicYectBank) 12 nets, 0 instances
ulz¥icvectBank (VicvectBank) 12 nets, 0 instances
- U1 FVicWectBank (VicVectBank) 12 nets, O instances

Figure 4-37 Drag Signal to Add a Register
The signal is added to the top of the Register pane, and the field within the signal is added
to the bottom of the Register pane.
Click any cdll to edit that parameter.
If the signal isa2-D array, specify the Memory Index to use for the field's value.

For both arrays and vectors, edit the Source column to specify a bitselect/partselect of the
signal’svalue, for example [31:0]. The Notes column indicates an unbound field or conflict-
ing width value between the bound RTL entity and the field.
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4.2.2.3 Memories Tab

The Memories tab, shown in Figure 4-38, allows you to define debug visibility into RTL mem-
ories during system simulation. Use this tab to make memories accessible during validation or

to specify afileto load into the memory during validation.

Item

libProiectl.svmtab.db
>
Delete

.. Properties

=

=a = I =

Undo | | Redo | |Add All Memories| id a Subcompone| S

Vvalue

idfvalue | Size

Infrequent

3%
observesignal

| Reset All || Reset

H

=]
(& I >]
\Portﬁ/ \Regisierﬁ/ \Memor\eﬁ/ \Prclil?‘
=
Load Design Hierarchy mNets: Matching: [ Explicitly Observable [ Explicitly Depositable

Name -~ | Range Direction size Type Attributes Flags(as compiled)

clock Input 1 Scalar Clock PEdgeTrigger
D> datl [34:0] Input 35 Array

sctl/Linux/Default/libProjectl. WORK B> oinl [1:0] Input 2 Array

D in2 [1:0] Input 2 Array

D> outl [34:0] output 35 Array

Figure 4-38 SoC Designer Component Memories Tab

The following sections discuss these tasks:

¢ Disabling Automatic Memory Checking

¢ Adding aMemory

»  Working with Non-Byte-Aligned Memories
e DeletingaMemory

¢ Maodifying Memory Parameters

e Changing the Memory’s Max Address

e Specifying System Address Mapping for Slave Transactors
¢ Creating Custom Code Sections

» Creating Blocks within Memories

e Specifying the Disassembler

e Creating Disassembly Views

¢ Creating Subcomponent Views

Disabling Automatic Memory Checking

By default, when you add memories or make changes using the Memories tab, Cycle Model
Studio performs validation and checks on your choices. Normally you do not notice any perfor-

mance lag unless you are working with many memories or the memories are large.

If you notice a performance lag or if you are making many changes and prefer to wait for check-
ing to occur until after you have made the changes, you can temporarily disable the checking by
deselecting the Automatically Check Memories option at the top of the Memory tab shownin

Figure 4-39.
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| %

Delete

W -

i ¥ Antomatically Check Memories
Undo Feda | | Add &)l Memories | | Add a SubComponent

Figure 4-39 Automatically Check Memories Option

After you have completed your changes, re-enable automatic memory checking to make sure
that no problems have been introduced by your changes.

Adding a Memory
To add amemory:

1. Inthe Design Hierarchy pane, select amemory instance. (If the Design Hierarchy paneis
not visible, choose View > Design Hierarchy from the main menu. Make sure that the top
moduleis selected in the Module pane.)

2. Drag the instance to the Memories window, as shown in Figure 4-40.
To specify the memories to be observed during simulation individually, or all at once:

— Individually. Highlight individual memoriesin the Nets list of the Design Hierarchy
pane. Highlight one memory at atime and drag it to the Memories box in the main
Memories tab window, dropping it where you want it to appear in the list (see Figure 4-
40).

— All at once. Click the Add All Memories button. This button searches through the RTL
design and adds all the memory instances to the Memories pane.
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Note:

libProiectl.svmtab.db

The memory must be Visible to be added to the list. It cannot be shown in red color,

which means ‘not visible'.

.. Properties

[=REs)

[ meml.meml

:]

Drop new memories here

X || e =
. i/ Automatically '
Delete | | yndo | | Redo | |Add All Memories| jd a SubCompone| Y
Item Id/Value | Size Name
~ Memories = Net Directives
Disassembler asyncﬁeslet
[ mem1l 35 {word size in bits) depositSignal

depositSignalFrequent
depositSignalinfrequent
exposeSignal

fastReset

forcesSignal
ignoresynthCheck
observeSignal

Value

(]

(]

\Port§/ \Registerﬁ/ Memorie
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Figure 4-40

Drag Memory to Memories Page

Working with Non-Byte-Aligned Memories

Note: This section appliesto SoC Designer components only.

( 0%

SoC Designer component memories must be represented in byte-aligned Minimum Addressable
Unit (MAU) format. MAU isthe minimum size of data (in bits) that can be accessed.

This section describes how to display a Cycle model that has a non-byte-aligned memory width
(for example, 11 bits) as SoC Designer component memory.

To support non-byte-aligned Cycle model memories as SoC Designer component memories, the
SoC Designer Wrapper must pad the memory word size to a byte-aligned size.

To pad the SoC Designer component view of the memory:
1. InCycle Mode Studio, access the Memories tab for the SoC Designer wrapper.

2.

Increase the "word size in bits" value to a byte-aligned value by clicking on the value in the
|d/Value column and entering the new value (see Figure 4-41).
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[ libmemtop_proi.cefa \/_memtopy ) x

>< S l é' 3] Automatically Check Memarie
Delete Unilo Fedo Adld Al Memoaries Add a SubComponent |
Itemn | Iavlue | size [~]
=] Memories
Dizassembier
E-4=r mem 1 [(wiond Sz in bits)
[l General
Max Address Ox1f werids)
System Address Mapping felick here fo addieditideiets)
Custom Code Sections
[=- Blocks
=] -% Tmem
Base Address 0x0 {bvdes)
Size Ox40 fbvdes)
[ Custom Code Sections P
[=- Locations
[l oF RTL Fath memntop.u_mem1 rmerm
= Display
Start Word Sffset Ox0 =
Eref Word Gffset Ox1f =
L58 a E‘i
Y | )

\_Ports /\ Registers J\ hemaries /\_Profile /
Figure 4-41 Changing the Word Size in Bits value

For example, if your memory has an 11-bit data width, increase the "word size in bits" from 11
to 16.

Note: Padding the SoC Designer component view of the memory does not impact the Cycle
model's memory functionality or actual width. It impacts only the SoC Designer compo-
nent memory view, including SoC Designer read and write debug accesses to the mem-
ory. That is, when you view the component’s memory in SoC Designer, the padded values
are shown.

If you load the memory using the MxScript capiMenLoadFromFile () function or the sdsim GUI
option Write memory image, you must use byte-aligned padded vauesin the file being loaded
to the memory.

If the SOC Designer wrapper does not properly pad a Cycle model memory being displayed as
SoC Designer component memory, sdsim displays awarning similar to the following when
viewing the memory:
WARNING :: sdsim does not support non-byte aligned MAU (sys_memtop.mem-
top:mem, bits per MAU=11)
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Deleting a Memory
To remove a memory from thelist, highlight the memory and click the Delete button.
If you have clicked the Delete button by mistake, click Undo to add the memory back.

Modifying Memory Parameters

You can change a memory’s parameter by selecting it (click underneath the id/Value column)
and changing the value there. Figure 4-42 shows the parameters that are currently available.

1= 5
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Item Ilalue Size =
-1 Memories
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Erd Word Sffset Ox1037
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MEE 15
= RTL
Stat Word Sffset Ox0
End Word Sffset Ox3
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= #F RTL Path mermtest_with_AHE_ARLhitS_a_mem |
— Display
Stat Word Sffset 0x2000 |
End Word Sffset Ox20ff |-
(4] [ v

\_Ports /\_Registers /\ Memories /\_Profile /

Figure 4-42 Memories Page

If aparameter appears dimmed (grey), it indicates that the parameter is read-only. Whether a
parameter is editable or not depends on the memory; aparameter that is editable in one memory
might not be editable in another.

Changing the Memory’s Max Address

Each memory is assigned a maximum address by default. The Max Addressisthe base address
of the component and the address offset into the component. If you have more than one memory
to preload in a component, the base addresses of the memories cannot overlap. In other words,
the base address and the max address of the memory cannot overlap with another memory for
the selected slave transactor.

Currently, only 32-bit wide memories are supported. The memories are assumed to be byte-
addressable. Therefore, when loading the component, the address passed into the load function
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is shifted by 2 bits to calculate the address for the memory to be loaded. The 2 bits are used to
select the byte in the word of the memory.

To change or view the Max Address, expand the Gener al heading.

Specifying System Address Mapping for Slave Transactors
Note: This functionality is not supported for Platform Architect.

You can instruct the program that is loaded into the SoC Explorer environment to initialize the
memory through one or more slave transactors. In previous versions of Cycle Model Studio,
you were allowed to specify asingle slave T2S (Transactor-to-signal) transactor. You are no
longer restricted to either asingle slave transactor nor the T2S type, but the transactor must be a
slave transactor.

To specify System Address Mapping, expand the System Address M apping heading.

Creating Custom Code Sections

When you compile the component for SoC Designer, Cycle Model Studio generates a C++
header file and source file that contain the generated code that represents the implementation.
You can add your own C++ code using the Class, Constructor, Destructor, Read, and Write sec-
tions, and include pre-condition and post-condition processing. For example, you might add
custom code that specifies how to initialize a memory component during initialization.

To add custom code, expand the Custom Code Sections heading, as shown in Figure 4-43.

ﬂibProiect?.ccfa\

2 @ = % Aut tically Check M i
v Automatica eck Memories
Delete | | yndo | | Redo | | Add All Memories | | Add a SubComponent -
Item Id/value Size (4]
— General
Max Address 0x7 (words)
System Address Map... (click here to add/ed...
+ Custom Code Sections
~ Blocks
+ 3 blocko
Base Address 0x0 (bytes)
Size 0x28 (bytes)
[ Custom Code S...
— Locations
= # RTL Path meml.meml o
[«] I El_
Figure 4-43 Adding Custom Code
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Creating Blocks within Memories

Blocks allow you to group memory units together.
To create a new block:

1. Right-click Blocks and choose Add Block.

2. Edit thefollowing fields as required.

— Base Address— Thisalowsyou to specify the base address of the component and the
address offset into the component. If you have more than one memory to preload in a
component, the base addresses of the memories cannot overlap. In other words, the
base address and the max address of the memory cannot overlap with another memory
for the selected slave transactor.

— Size— Currently, only 32-bit wide memories are supported. The memories are
assumed to be byte-addressable. Therefore, when loading the component, the address
passed into the load function is shifted by 2 bitsto calculate the address for the memory
to beloaded. The 2 bits are used to select the byte in the word of the memory.

— Custom Code Sections (see “ Creating Custom Code Sections’ on page 115 for more
information).

The L ocations section displays the following information under RTL Path (the path to the
RTL code from the top-level module):

» Display — Sart Word Offset, End Word Offset, Least Significant Bit (LSB), and Most Sig-
nificant Bit (MSB).

 RTL — Sart Word Offset, End Word Offset, Least Significant Bit (LSB), and Most Signifi-
cant Bit (MSB).
Specifying the Disassembler

Note: This functionality is not supported for Platform Architect.

To specify the name of the disassembler to use to display the disassembly view in SoC
Designer:

1. Click Disassembler.

Itermn IedMialue Size
Memories

it16_mem 15 {Werd size it i)

May Addvess O=3f {ewds)
System Address Mapping {eick here o agdleditissiele)
+ Custom Code Sections
- Blocks
=} bit1E_mem
Baze Address 0=0 (bydes)

Figure 4-44 Specifying the Disassembler

When abox appearsin the | d/Value column (Figure 4-44), enter the name of the classto
be used to disassembl e the memory. The source code that contains this class must be
specified as part of the project in the SoC Designer Component Properties page (see
“Setting Compiler and Linker Flags” on page 86).

Note: All the memoriesin a subcomponent must use the same disassembler. (See * Creating
Subcomponent Views’ on page 117 for information on subcomponents.)
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Creating Disassembly Views

Previous versions of Model Studio referred to creating “disassembly views.” This terminology
has changed. The view isnow called a subcomponent view, as described in the following section
(Creating Subcomponent Views).

Creating Subcomponent Views
Note: This functionality is not supported for Platform Architect.

If you have multiple memories within your Cycle Model, you can group them into subcompo-
nents. You can then use the subcomponent as a single debug interface for the group of memo-
ries.

To create a subcomponent view:

1. Click the Add a Subcomponent button. A subcomponent row is added to the Memorieslist
as shown in Figure 4-45.

|b Proiect?.ccfa

ltemn ld/Value Size

&=

v Automatically Check Memories
Add a SubComponent v

Add AII Memories

Disassembler

- 15 mem1l 35 {word size in bits)
— General
Max Address ox7 (words)

System Address Map... (click here to add/ed...
» Custom Code Sections
> Blocks
¢ &= SubComponent0 {drop memories here)
Drop new memories here

P e, »

i s M i ¥

Figure 4-45 Subcomponent Views in Memories Page

2. Drag memoriesinto the arealabeled drop new memories here.

3. Define adisassembler for the subcomponent. (See “ Specifying the Disassembler” on
page 116 for instructions.)

Note: All of the memoriesin the subcomponent must use the same disassembler.
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4.2.2.4 Profile Tab

Note: Thistab isavailable only for SoC Designer components.

Use the Profile tab, shown in Figure 4-46, to facilitate the measuring of eventsinternal to a
Cycle Model, and display them graphically with SoC Designer. The profiling mechanism is
organized into streams, channels, and buckets. You control when and how the output displays
during SoC Designer profiling by defining control statements for the streams’ triggers, chan-
nels, and buckets.

libFrojectt.ccfy 3, x

—Profile Streams (drag and drop nets from Design Hierarchy)

Mame Fropetties
- stream_0
[ et
Bl Triggers
B Trigger expr: 1
i channel_0 Filter expr: 0

Mame
’7|stream_0 e Stream | Add Trigger| Adg channel | ad Bucket| [Red |

Expression
(l |

' Port hap /% Registers /4 hemories /\ Profile /

Figure 4-46 SoC Designer Component Profile Tab

Streams, Triggers, Channels, and Buckets

A streamis acollection of netsthat form alogical entity whose values are measured and dis-
played during simulation. Streams can have multiple triggers that control when their channels
are activated at simulation time in the SoC Designer environment. Streams consist of one or
more channels and can view one or more RTL nets.

A trigger isaboolean C expression that determines when SoC Designer records data values for
each of the stream’s channels.

A channel represents asingle simulation event value that you wish to measure. When itstrigger
isactivated in SoC Designer, the channel’s datais displayed graphically. To display the data as:

» Integers— Set up achannel controlled by afilter (C) expression. The filter expressions
generally return the value of a specified net, but can also return the value of a computation
involving more than one net.

» A setof discrete symbolic valuesin a color-coded bar graph — Set up a channel with buck-
ets. Each bucket has a boolean C expression to determine which of the channél’s buckets
are active at any given time. SoC Designer checks buckets in sequence; the first bucket
expression to return a non-zero value resultsin a profiling event.
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Expressions control the output of a stream, channel, or bucket:

Trigger expressions are boolean C expressions that trigger a stream to record data values for
its channel; for example: posedge (clk).

Integer channel filter expressions can be C expressions that return an integer; for example:
HSIZE.

Bucket channel expressions are boolean C expressions; for example:
VectAddr > 8 (green)
VectAddr > 16 (blue)

Creating Streams

To create a stream:

1
2.

Click Add Stream to add a stream to the profilelist.
Edit the stream’s name in the Name field.
Define the nets belonging to a stream:

Open the Design Hierarchy view and select a module from the Modules list.

Select nets, one at atime, from the Nets list, and keeping the left mouse button
depressed, drag-and-drop the nets from the Design Hierarchy to the Nets section of the
desired stream (see Figure 4-47).
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Figure 4-47 Drag Nets to Stream in Profile Tab
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Defining the Triggers
To define atrigger control expression for a stream:

1. Highlight the desired Trigger expr linein the Profile Streams list.

2. Inthe Expression text entry field, enter a boolean expression that involves at least one
of the netsin the stream.

3. Todefine multiple triggers for astream, click the Add Trigger button.
Specify adifferent triggering expression for each added Trigger in the Expression field.

Note: In the control expressions, use the net name only, do not use the full path name.

Setting Up Channels and Buckets
Figure 4-48 illustrates setting up channels and buckets in the Profile tab.

Note: SoC Designer requires that every stream contain a bucket channel, so you must add at
least one bucket channel to each stream.

—Profile Streams (drag and drop nets from Design Hierarchy)

Mame | Froperties
[} stream_25
[ Mets
{ #+HRESETn Wic_carbon.ullVicvectBank, HRESETn (1)
L b wICYectaddr wic_carbon.ul LvicveckBank, vICYeckaddr (32)
E} Triggets
B Trigger expr: 1

[} channel_0 3 buckets
i bebucket D 1
- bucket_1 1

- bucket_ 2 11
“ channel_1 Filter expr: 0

—Mam

Ibucket_2 Add Stream | Add Trigger Add Channel Add Bucket | IYeIIow vl

Expression
’7 |11]

Figure 4-48 Set Up Channels in Profile Tab

To set up channels:
1. Highlight any trigger in the stream.

By default, each trigger contains one integer, or filter expression, channel. You can
keep this as an integer channel (and add other channelsif you wish) or change thisto a
bucket channel by highlighting it and clicking the Add Bucket button.

2. To add more channels to the stream, click the Add Channel button to add additional
channels to that stream.

Note: Each new channel is added under every trigger in the stream; in other
words, every trigger activates the same set of channels.
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3. If desired, change the channel’s name in the Name text entry field.

For integer channels, type a net name or a computation involving more than one net in
the Expression text entry field.

5. For channels containing a set of discrete buckets:
— Click Add Bucket. You can add multiple buckets to the channel.

— Typeaboolean control expression for that bucket in the Expression text entry field.
This expression defines when that bucket is active.

— Changethedisplay color of the bucket as desired in the right-hand pull-down
menu. Note that while the Cycle Model Studio automatically assigns a different
color to each bucket, you can override these settings as desired. If none of the
bucket conditions are met, an event on a default OutOf Range bucket is generated;
these events appear in red.

4.2.2.5 Control Expressions

Control expressions for triggers, channels, and buckets are based on nets contained in their
stream. Control expressions are C-expressions and can include C operators and the functions
posedge<net >, negedge<net>, and changed<net>. The type of C-expression used
depends on the entity being controlled:

e Trigger expressions are boolean.
» Integer channel expressions are integers.

»  Bucket channel expressions are boolean.

4.2.3 Recompiling the Model

After you have defined all the specific settings for your component using the Component Editor,
you need to recompile your project. Click the Compile button at this point to generate the
updated filesto be used with your component.
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4.2.4 Generated Output Files for the SoC Designer Component

This section describes the output files associated with a Cycle Model Studio component—the
configuration file, source files, make files, and component file (see Figure 4-49).

Cycle Model

<Cycle_Model_name>.io.db
<Cycle_Model_name>.symtab.db

VWY

SoC Designer Component Gener ation

Configuration File
<config_file>.ccfg

Source Files
mx.<component>.cpp
mx.<component>.h

M akeFile
Makefile.<config-file>.mx or
Makefile.<config-file>.mx.windows

Component for toc Designer
lib<model_name>.mx.so and lib<model_name>.mx_DBG.so or
lib<model_name>.mx.dll and lib<model_name>.mx_DBG.dl|
maxlib.<model_name>.conf
maxlib.<model_name>.windows.conf

Figure 4-49 SoC Designer Component Output Files
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4.2.4.1 Configuration Files

A configuration file, *.ccfg, isthe first of several intermediate files generated by Cycle Model
Studio. Thisfile can be used:

» By userswho are migrating to Cycle Model Studio from the SOC-V SP tool. Use this
file asinput for arun of the Cycle Model Studio, allowing you to make additional mod-
ifications to the component.

» By the Cycle Model Studio to create the customizable source files and Makefile, which
are used to generate the component.

4.2.4.2 Makefiles

The Cycle Model Studio generates a Makefile for the following platforms:

e Linux: Makefile.<config-file>.mx
* Windows. Makefile.<config-file>.mx.windows

These Makefiles use the source * . cpp and * . h files to create the component.

4.2.4.3 Customizing Component Source Files

You may want to customize a component prior to passing it to SoC Designer. For example, you
might add an SoC Designer API call to activate readDbg or writeDbg for a slave port, or
include debug bypass code for a component (see the example below).

To customize the component, edit the component source files (*.cpp or *.h). By default, the
source files take the name of the top-level module in your design. However, if you changed the
Component Name field on the Cycle Model Studio’s Properties Tab, these files use the new
name.

Review the following important rules before making any changes to component source files:

* You must make all editsinside an existing Cycle Model User Code section of these files.
This ensures that Cycle Model Studio retains your edits when you re-run the Cycle Model
Studio using the configuration file. User-created Cycle Model User Code sections are not
retained.

» Do not move the source files from the output directory.

» Empty Cycle Model User Code sections or sections containing white space are ignored.
Any Cycle Model User Code sections that are unused during component generation are
appended to the end of the generated sourceinan #if o block and awarning is generated.

» If compileor link flags are needed, enter the relevant paths in the Model Studio General
Propertiestab (see “ Setting Compiler and Linker Flags’ on page 86).

» Editing thesefiles requires familiarity with the SoC Designer API. Refer to the ESL API
Developer’s Guide for information on how to customize these files.
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To customize the component:

Edit the mx . <component > . cpp and/or mx . <component > . h files
Re-run the Make process at the command prompt:

For Linux platforms — make -f Makefile.<config file>.mx #
For Windows platforms —
nmake /F Makefile.<config file>.mx.windows #

Example of adding Debug Bypass Code to a source file

The following code is an example of adding customized code to the Cycle Model User Code
section, inside the method CompName : : debugaccess. The example shows a 4x4 matrix that
forwards transactions based on the address map defined:

// Cycle Model User Code [PRE compName: :debugAccess] BEGIN
if ((addr >= 0x00000000) && (addr <= OxOfffffff))

{
return (AXI_Flowthru Master CarbonAxiFS2T->debugAccess (dir, addr,
numBytes, buf, numBytesAccepted, ctrl));

}

{
return (AXI_Flowthru_ Master_ 1_CarbonAxiFS2T->debugAccess(dir, addr,
numBytes, buf, numBytesAccepted, ctrl));

}

{
return (AXI Flowthru Master 2 CarbonAxiFS2T->debugAccess (dir, addr,
numBytes, buf, numBytesAccepted, ctrl));

}
if ((addr >= 0x30000000) && (addr <= Ox3fffffff))

{

return (AXI Flowthru Master 3 CarbonAxiFS2T->debugAccess (dir, addr,
numBytes, buf, numBytesAccepted, ctrl));

}

// Cycle Model User Code END

if ((addr >= 0x10000000) && (addr <= Ox1fffffff))

if ((addr >= 0x20000000) && (addr <= Ox2fffffff))

Note: Implementation note for Debug Bypass Code: If overlapping memory regions exist for

two ports, debug bypass code is necessary on only one of the ports.
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4.2.4.4 Adding a Component to the SoC Designer Model Library

Cycle Model Studio creates a configuration file that can be used to add the generated compo-
nent into the model library of SoC Designer. To add the component to the model library from
SoC Designer:

Select File > Preferences.

Click on Component Library in the list on the left.

Under the Additional Component Configuration Files window, click Add.

A WP

Select either max1ib.lib<model names.conf (Linux) or
maxlib.lib<model name>.windows.conf (Windows)
depending on your platform.

Click OK.

If you want to save the preferences permanently click OK & Save. To save them for the
current session only, click OK.

o

The component is now available from the SoC Designer Component WWindow.

4.2.4.5 SoC Designer Component Files

The component file isthe final output file from the Cycle Model Studio and is the input to SoC
Designer. The Cycle Model Studio generates two versions of the component; an optimized
release version for normal operation and a debug version.

On Linux the debug version of the component is compiled without optimizations and includes
debug symbols for use with gdb. The release version is compiled without debug information
and is optimized for performance.

On Windows the debug version of the component is compiled referencing the debug runtime
libraries, so it can be linked with the debug version of SoC Designer. Therelease version is
compiled referencing the release runtime library. Both release and debug versions generate
debug symbols for use with the Visual C++ debugger on Windows.

Linux and Windows debug versions al define the macro CARBON_DEBUG when compiled.
The CARBON_DEBUG macro can be used to filter debug messages or other code that should
only be run when executing the debug version of the component.

The name of the component libraries are:

* lib<model_name>.mx.so and lib<model_name>.mx_DBG.so for Linux platforms

e lib<model_name>.mx.dll and lib<model_name>.mx_DBG.dII for Windows platforms
By default, the name of the component file is the same as the name of the Project.

See the previous section for information regarding how to register your new component with
SoC Designer.
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4.3 SoC Designer-Specific Information

You use Cycle Model Studio to create a SoC Designer-compatible component from the Cycle
Model, which includes the simulation and debugging interfaces.

Using this process, system engineers use the component in SoC Designer to build asimulatable
system and perform the following tasks:

» Architectural exploration
e System and software validation and debug
»  Embedded software development

Figure 4-50 shows the process flow from source RTL to component for SoC Designer.

RTL Code

v

Cycle Model Compil!r

Cycle Model Database File Cycle Model
lib<design>.symtab.db lib<design>.a Or lib<design>.1lib

Component Generator '

J

SoC Designer Component
<model name>.mx.dll
<model name>.mx.SO

SoC Designer '

Figure 4-50 Generating a Component for SoC Designer

The Component Generator enables you to:

»  Specify the connection interface between your Cycle Model and SoC Designer. For exam-
ple you can:

— Choose which of your Cycle Model ports are visible to SoC Designer.

— Insert and connect transactors, which shield many of your Cycle Model ports from SoC
Designer.

— Create unused input and output ports (null), if required by SoC Designer.

»  Set thetiming for the SoC Designer reference clock so that your Cycle Model’s clocks can
fully exercise your design.
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»  Specify theinternal registers and memories that you wish to observe during validation.

After you use the Cycle Model Studio to specify the settings above, Cycle Model Studio gener-

ates a component, which includes the simulation and debugging interfaces (Figure 4-51).
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Figure 4-51 Component for SoC Designer

When the component is registered with SoC Designer, the validation engineer builds a system
by connecting the component with other components via the visible input and output ports, as
shown in Figure 4-52. The engineer then simulates the system, observing the exposed internal
registers and accumulated profiling data.
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Figure 4-52 Component in SoC Designer

4.3.1 Prerequisites for SoC Designer

Before you generate the component for SoC Designer, make sure you have performed the fol-
lowing steps:

If they have not already been defined, set the necessary environment variables:

MAXSIM HOME = <SoC Designer installation directorys>
MAXSIM PROTOCOLS = <SoC Designer installation directorys/Protocols
CARBON_HOME = <Cycle Model installation directory>

Make sure that the Cycle Model output libraries are static:

For Linux: 1ib<design names.a
For Windows: 1ib<design name>.lib

To ensure that the validation engineer can access important signals in the component, use
the observeSignal and depositSignal directivesto mark any desired registers or
internal memories as observable and/or depositable.

Mark any internal registersintended to be 1/O portsin the SoC Designer component (that is,
those to be connected to a transactor or to an SoC Designer port) with scObserveSignal
Or scDepositSignal. Be aware that this can slow down performance. See “ Defining
Directives and Recompiling the Cycle Model” on page 69 for more information.

Compile your Cycle Model following the steps defined in Chapter 3. Note that the
lib<designs>.symtab.db file must be present during the Cycle Model Studio run to cre-
ate the component, but it is not required at SoC Designer runtime.
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4.3.1.1 Transactors

SoC Designer supports transaction-level port interfaces, but Cycle Models typically communi-
cate at the pin level. Transaction adapters (known as Transactors) are provided to convert
between several common transaction level interfaces and the Cycle Model pins.

Note: If you are creating a model for Platform Architect, note that the term used in the GUI
changes from “ Transactor” to “ Protocol.”

Refer to the SoC Designer User Guide for details about the difference between transaction-
based and signal-based communication in the SoC Designer environment.

The transactors you add to your component in the Cyclecomponent typically add new SoC
Designer transaction ports, and hide Cycle Model ports.

For example, an AHB_Slave T2S converts AHB transactions to signal value changes (T2S
means “transaction to signal”). When you add an AHB_Slave T2S transactor to your compo-
nent in the Cycle Model Studio tool, anew SoC Designer transaction slave port is created in the
component for incoming AHB transactions. You must use the Cycle Model Studio tool to con-
nect the transactor to the appropriate Cycle Model signal ports. Each Cycle Model signal con-
nected to the transactor is no longer exposed as an SoC Designer port.

The resulting component may be connected to a transaction master port in SoC Designer.

4.3.1.2 Component Clocking

The component generated by the Cycle Model Studio tool uses SoC Designer cycle-based
scheduling. Refer to the SoC Designer User Guide for information about cycle-based schedul-

ing.
The component has a clock input port named ‘clk-in'. Thisis an SoC Designer cycle-based
clock, not an RTL signal port. The clk-in port determines how frequently the component is

called to execute a cycle. For more information about clocking options, refer to “ Clock Inputs
and Clock Generators’ on page 148.

» If you connect the clk-in port to the clock master port of another component (e.g., aCDIV
clock divider), then that component determines when the component runs acycle.

» If you do not connect the clk-in port to anything, then the component is driven by the SoC
Designer reference clock, running one cycle per time unit.

The component, like all SOoC Designer components, is a subclass of C++ class sc_mx_module.
It implements the two methods update () and communicate (), which are called by the clock
master to which the clk-in port is connected.

Inthe communicate () method, al output ports that have new values are driven.
Intheupdate () method, the Cycle Model is executed.
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4.3.1.3 Clock Generation

Clock generators are supported for SoC Designer components only (not for Platform Architect
components).

In SoC Designer cycle-based scheduling, thereis no signal value (i.e., 1 or 0) associated with a
clock slave port. The SoC Designer clock slave port is only a mechanism for configuring when
the component communicate () and update () methods are invoked.

You can drive the Cycle Model clock signal ports using a Cycle Model Studio clock generator.
A clock generator applies 0 and 1 signal valuesto the Cycle Model clock signal ports every time
the component’supdate () methodiscalled. A clock generator may be configured to run at the
same speed, faster, or slower than the SoC Designer reference clock.

Note: Rather than creating a clock generator, ARM recommends creating a clock input transac-
tor and exposing the clock input port externally.

For additional information on the use of clock generators, refer to “Clock Inputs and Clock
Generators’ on page 148. For instructions on creating a clock generator, refer to “ Specifying
Generated Clocks” on page 91.
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4.4 Using the Component in SoC Designer

This section describes how to set up the component in SoC Designer.

For your SoC Designer run, you need only the component. No other files are necessary.

4.4.1 Setting Component Parameters in SoC Designer

You can change the settings of all parameters in SOC Designer Canvas and of some parameters
in SoC Designer Simulator. To modify the component’s parameters:

1. Inthe Canvas, right-click on the component and select Component | nfor mation. The Edit

Parameters dialog appears (Figure 4-53).

Edit Parameters - twocounter[0] (twocounter)

Properties:
Name: ltwocounterlo] l
Type: l l Loadfile Extension: l l
Version: [ l Save/Restore: [ l
IP Provider: [ l
Description: Debuggers Supported:
Port List: ~ Parameters: .
Port Name | Interface Parameter ~ | Value o k| Type
clkl SignalSlay =| |Align Waveforms true bool
clk2 Signalslay | ARM CycleModels DB Pz strin
clk-in ClockSlavy | \Dump Waveforms false v bool
outl SignalMasm Enable Debug Message: false v boolm
= G — _ s
oK ‘ | Cancel

Figure 4-53 Edit Parameters dialog

2. Double-click the Valuefield of the parameter that you would like to modify.

3. If atext field appears, type anew valuein the Valuefield. If amenu choiceis offered, select
the desired option. The parameters of relevance to the component are:

— Dump Waveforms

—  Waveform File

— Align Waveforms

— Waveform Timescale

— ARM CycleModels DB Path

These parameter options are explained below.
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4.4.1.1 Dump Waveforms

SoC Designer does not dump waveforms automatically. You must turn on waveform dumping
by setting the Dump Waveforms parameter to “true.”

4.4.1.2 Waveform File

To change the name of your waveform file, type a new name for the Waveform File parameter.
If waveform dumping has been turned on, SoC Designer automatically writes the accumul ated
waveforms to the waveform file in the following situations:

» when the waveform buffer fills
» whenvalidation is paused and when validation finishes
e attheend of each validation run

If theinitial waveform created was cyclemodel.vcd, the new files created after subsequent
simulation resets are named cyclemodel_1.vcd, cyclemodel_2.ved, etc. In your waveform
viewer, you can load the waveform file and explore the behavior of the signalsin the design.

The type of waveform file generated, * . vcd is determined by which file type you selected on
the Genera Properties tab (see “ Enabling Waveform Generation” on page 85).

4.4.1.3 Align Waveforms

When Align Waveforms is set to “true’ (the default setting), it causes the waveforms dumped
from the component to be aligned with the SoC Designer simulation time. Note that the reset
sequence is not included in the Cycle Model VCD/FSDB data when the waveforms are aligned
because it occursin zero SoC Designer simulation time.

If you want to capture the reset sequence for debugging, you can set this parameter to “false”.
This shows the reset sequence in the created Cycle Model waveform data. However, it also
means that the time shown in the Cycle M odel waveforms does not match the time shown in the
SoC Designer waveforms.

4.4.1.4 Waveform Timescale

Select the timescal e to be used in the Cycle Model waveform file using the Waveform Timescale
parameter. The default is 1 ns, but you can click the Value field to display a drop-down list of
available timescales values.

4.4.1.5 ARM CycleModels DB Path

SoC Designer only runsif the path to your databasefileis correct. This parameter is usually not
necessary because the 1ib<model names.symtab.db databasefile is embedded by default in
the Cycle Model file.

However, it is possible to generate the Cycle Model without embedding the database file (using
the -noFul1DB compiler option). In this case you would need to define the name and location
of thisfile. To specify the path to the database directory, set the ARM CycleModels DB Path
parameter to the directory that contains your 1ib<model names.*.db file,

The database path parameter is passed to carbonSetFilePath in the component’s init ()
method. For more information, see carbonSetFilePath inthe Cycle Model APl Reference.
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4.4.2 Special Cases

4.4.2.1 Components with Clock_Input Pseudo-Transactors

If your component has a clock Input pseudo-transactor, then any connection to the SoC
Designer default c1x_in port isignored. To avoid confusion, keep c1k_in unconnected in SoC
Designer.

4.4.2.2 Using $display in Windows Environment with SoC Designer
If you use $display inaWindows environment while running SoC Designer interactively, you
get the following error message:
<twocounter [0] > Unable to write to file stdout]| |stderr.

Error message is: Bad file descriptor

To fix this, redirect the output to afile. You can do this by invoking SoC Designer from a com-
mand prompt as follows:

“C:\Program Files\ARM\SoCDesigner9.0.0\Bin\Release\SDSim.1lnk” > out.txt

4.4.2.3 Using Save and Restore in SoC Designer

Unlike SoC Designer, the component is not endian-neutral. Therefore, after doing a save and
restore of the component in SoC Designer, the resulting MXR file cannot be moved to an oper-
ating system that uses a different byte order than your current platform.

4.4.2.4 Using Profiling in SoC Designer

When gathering profiling data on a Cycle Model that has been compiled with the -profile
option, you should run SoC Designer in batch mode (see the SoC Designer User Guide). Profile
data collected when running the SoC Designer Graphical User Interface includes time spent
waiting for user responses and thus gives skewed profiling results.

4.4.2.5 Flow-through Path Support for Signal Ports

Flow-through paths are supported automatically by executing the logic defined in the flow-
through paths until they settle. The Cycle Model Compiler automatically detects when a flow-
through path existsin amodel compiled from RTL. It adds code to the SoC Designer compo-
nent such that any inputs that are in a flow-through path:

1. Drivethesignal into the RTL model.
2. Executethe RTL logic defined in the flow-through path.
3. Detect changes on any RTL outputs and drive the output to any connected components.

In general, it is recommended that any models execute such flow-through paths during the com-
municate phase. All SoC Designer components created using Cycle Model Studio from RTL
initiate flow-through paths only during the communicate phase.
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4.5 Platform Architect-Specific Instructions

Use Cycle Model Studio to create a Synopsys (formerly CoWare) component from the Cycle
Model that is compatible with Platform Architect, and includes the simulation and debugging
interfaces. Using this process, system engineers use the component in Platform Architect to
build a simulatable system and perform the following tasks:

e Architectural exploration
»  System and software validation and debug
»  Embedded software development

Use the Cycle Model Studio Component Generator to:
* Load aCycle Modd database.
» Define communication interfaces to drive the design.

e Map datatypes and define which internal information inside the Cycle Model to export to
the Platform Architect environment.

»  Compile the Component and generate interfaces.

4.5.1 SystemC Modeling Language (SCML) Interface Overview

SystemC Modeling Language (SCML) is used to export internal register information and aggre-
gate register information so that Platform Architect analysistools can utilize internal Cycle
Model information. Registers can be 32 or 64 bits and are used to export internal signals, regis-
ters, and memories for analysis, including Platform Architect’s debuggers and analysis tools.

SCML assigns a shadow register that maps to the appropriate data inside the Cycle Model. It
also provides the Platform Architect environment with the ability to read internal Cycle Model
data and deposit to internal Cycle Model data.

SCML information is assembled into a register/memory bank that you define. Offsets are used

to specify the registers and memories that reside within the bank. A debug access mechanismis
provided to update or retrieve data from these SCML objects and perform the appropriate calls
to the Cycle Model API to access the Cycle Model data.

For more information on SCML, refer to the Synopsys SystemC Modeling Manual.
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4.5.2 Prerequisites

Before you generate the component for Platform Architect, make sure you have performed the
following steps:

» If they have not already been defined, set the necessary environment variables:

COWAREHOME = <Platform Architect installation directory>
CARBON_HOME = <Cycle Model Studio installation directory>
COWAREIPDIR = <Platform Architect IP directorys
(Optional. If not specified, then Cycle Model Sudio uses
$COWAREHOME/IP to identify available Platform Architect transactors.)
COWAREIPLIB = <Platform Architect installation directorys
(For important, version-specific instructions refer to Section 4.5.2.1,
COWAREIPLIB Implementation Notes on page 136.)

» Make surethat the Cycle Model output libraries are static:
For Linux: 1ib<design names.a
For Windows: 1ib<design name>.lib

e Toensure that the validation engineer can access important signals in the component, use
the observesSignal and depositSignal directivesto mark any desired registers or
internal memories as observable and/or depositable.

Mark any internal registersintended to be 1/O portsin the Platform Architect component
(that is, those to be connected to a transactor or to a Platform Architect port) with
observeSignal Of depositSignal.Beaware that thiscan slow down performance.
See “Defining Directives and Recompiling the Cycle Model” on page 69 for more
information.

» Compileyour Cycle Model following the steps defined in Chapter 3.
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4.5.2.1 COWAREIPLIB Implementation Notes
If you are running:

» Synopsys Platform Architect version K-2015.06, you must do the following to enable
Cycle Modd Studio to emit tcl files:

1. Create afile named cwr . 1ib. with the following content:

INCLUDE S$SCOWAREHOME/dmtools/data/cwr.lib
DEFINE GenericIPtemplates GenericIPtemplates

2. Point the COWAREIPLIB environment variable to the new file.
The following is an example script that shows the commands needed to properly set up the
environment:

setenv COWAREVERSION K-2015.06

setenv COWAREHOME /tools/linux/CoWare/$SCOWAREVERSION/SLS/linux
source S$SCOWAREHOME/setup.csh -pa

setenv PATH $COWAREHOME/common/bin:$PATH

After completing these steps, invoke Cycle Model Studio, create the component, and com-
pile.

4.5.3 Recompiling the Model

After you have defined all the specific settings for your component using the Component Edi-
tor, you need to recompile your project. Click the Compile button at this point to generate the
updated files to be used with your component.

4.5.4 Understanding the Platform Architect Component Output Files

The Cycle Model Studio Component Generator outputs severa file types, including configura-
tion, source, make, and component files. This section describes:

e Configuration Files

* SourceFiles

e Makefiles

» For Platform Architect

e Known Issue
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Refer to Figure 4-54 to review the process flow from Cycle Model to component for Platform
Architect.

CycleMode

<Model_name>.io.db
* <Model_name>.symtab.db

\

Platform Architect Component Generation

Configuration File
<config_file>.ccfg

Source Files
lib<component>.systemc.cpp
lib.<component>.systemc.h

MakeFile
Makefile.SystemC<config-file>.lib

Scsh Import Files <standalone>
lib<component>.SystemC.lib.tcl

lib<component>.SystemC.cmd
libcarbon.SystemC.link.tcl

Platform Architect Import Files

import.<component>.SystemC.lib.tcl
lib<component>.build.tcl

. SystemG Environment O

Note: import.<component>.SystemC.lib.tcl is used in Platform Architect to
execute script (Tools -> Execute Script).
Note: lib<component>.build.tcl is the encapsulation file used.

Figure 4-54 Platform Architect Component Output Files

4.5.4.1 Configuration Files

A configuration file, * . ccfg, isthefirst of several intermediate files generated by Cycle Model
Studio. Thisfile can be used:

By users who are migrating to Cycle Model Studio from the Platform Architect Com-
ponent Generator tool. Usethisfile asinput for arun of the Cycle Model Studio, allow-
ing you to make additional modifications to the component.

By the Cycle Model Studio to create the customizable source files and Makefile, which
are used to generate the component.
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45.4.2 Source Files

If you want to customize the component prior to passing it to the Platform Architect environ-
ment, you can edit the source files (* . cpp oOr * . h).

1. Editthe 1ib<component>systemc.cpp and/or 1ib<component>systemc.h files.

To ensure that Component Generator retains your edits if you reuse the edited source files
for afuture run, make all editsinside the designated Cycle Model User Code section of
these files (see “ Example of adding Debug Bypass Code to a source file” on page 124).

2. Re-runthe Make process at the command prompt:

make -f Makefile.coware<config file>.lib #

4.5.4.3 Makefiles
Component Generator generates a Makefile for Linux:
e Makefile.coware<config file>.1lib

This Makefile uses the source * . cpp and * . h files to create the component for the Platform
Architect environment.

45.4.4 Known Issue

When adding a transactor, the import script does not set the port direction. For example, in the
script import_Twocounter.coware.tcl the port direction is specified as “None”, which causes a
problem. The workaround is to edit the port direction in the script.

The import script of the generated component includes a line similar to the following:

::pct::add block port $block port None

The solution is to change the line to have the correct port type, for example:

::pct::add block port $block port inout
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4.6 Creating Components for SystemC

ARM délivers products that allow designers to compile their synthesizable RTL into an ultra-

high performance Cycle Model that can then be linked directly into a SystemC design environ-
ment. Thisintegration provides the speed necessary to perform software validation and perfor-
mance modeling while maintaining the investment already made in the SystemC environment.

A traditional approach to integrate implementation-level RTL into SystemC typically involves
integrating an RTL simulator viathe PL1. While this approach correctly models the implemen-
tation, it does so at arelatively slow speed. In addition, PLI introduces a substantial amount of
interconnect overhead.

The process of integrating a Cycle Model into a SystemC development environment includes:

» Building the Cycle Model using the Cycle Model Compiler.

»  Generating a component that integrates the Cycle Model into a SystemC environment.
e Compiling the design into an executable.

Refer to the CMSInstallation Guide for supported SystemC versions.

4.6.1 Prerequisites

Before you generate the component for SystemC, make sure you have performed the following

steps:
»  Set the environment variable SY STEMCHOME to the base directory of your SystemC
installation.

» Make surethat the Cycle Model output libraries are static:
For Linux: 1ib<design names>.a
For Windows: 1ib<design name>.lib

» Toensurethat the validation engineer can access important signals in the component, use
the observeSignal and depositSignal directivesto mark any desired registers or
internal memories as observable and/or depositable.

Mark any internal registersintended to be I/O ports in the component (that is, those to be
connected to atransactor or to aport) with scobserveSignal Of scDepositSignal. Be
aware that this can slow down performance. See “ Defining Directives and Recompiling the
Cycle Model” on page 69 for more information.

» Compileyour Cycle Model following the steps defined in Chapter 3.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 139
ID111516 Non-Confidential



4.6.2 Generating the Component for SystemC

1. From the Project Explorer, right-click the Cycle Model to display the context menu.
2. Fromthe context menu, select Create SystemC Component. You can also click the SystemC

button on the Button bar.

The new component and its associated output files are displayed in the Project Explorer

(Figure 4-55).

Project Explorer (]
}.

- Project8.carbon
— == ARM Cycle Model: libProj...
#: Compiler Directives
| libProject8.symtab.db
= ) RTL Sources
+ |0 RTL Model
=] twocounter.v
= I3 Generated Files
== libProjectd
2 Files

~ T

-.3] libProject8.ccfg
7 libProject8.systemc.h
i libProject8.systemc.cpp

Figure 4-55 Component for SystemC in Project Explorer
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4.6.2.1 Using the Component Properties View

Use the Component Properties view (Figure 4-56) to view the SystemC component properties,
including:

Component top module name.

Force Update — Specifiesthat callsto sc_prim channel::request update are
forced for all input changes. If thisis not specified, request update iscalled only for
clock, reset, and feed-through inputs.

Module Name — By default the SystemC module name is the same as the top module

name. You can enter a unique name to be used for the SystemC module that is generated.

Database (*.db) file location.
Output directory.

[ SpatemC Component Propertlen | v]
E
Mamne \alug |

[} Companent Properties
{Tap Module) top
Faree Update false

Madule Mame top
[E1-- Properties
{10DB File) MbProject! symtab.db

{Output Directory)  homefedafickaidevirorkiug1 71764 _debug_sessiontPrajectl/Linus/Default/SystemC

Figure 4-56 SystemC Component Properties
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4.6.2.2 Using the Ports Window for SystemC

The Ports window for SystemC provides tabs to access ports. Double-click the .ccfg file in the
Project Explorer to display the Ports Editor (Figure 4-57).

[ libProjectt symtab.ch x
Itern IIdNaJue ISize IMode |Type
[l Component Ports
i) el topek 1 Clock  hoal
(2 din topdin 1 Control - hoal
(&) dout top.dout 1 Contral  hoal
(2) enbl topenkl 1 Control - hoal

RTL Ties
RTL Disconnects
Clock Generators

Figure 4-57 Ports Window for SystemC
Thiswindow is very similar to the one used for creating components for SoC Designer except
for the following differences:
»  The Ports window for SystemC does not contain the following:
— Transactor, Add Transactor, Add Parameter feature
— Registers or Memoriestabs
— Profiletab
— Generated resets (Reset Generators section)
— “Connect to Parameter” option when right-clicking an RTL port
— Ability to add parameters to your component
— Ability to add unused (null) ports
* The Portswindow for SystemC contains two columns that the SoC Designer view does not:
— Mode — Not used in this release.

— Type— Specifies the SystemC type to be used. The default SystemC typeis based on
the size, type, and direction of the RTL port. (The size element of the SystemC typeis
determined automatically from the RTL port size.) You can select a different type from
the pulldown menu.
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» The Clock Generators for the SystemC Ports window use the SystemC sc_clock primitive
to generate the clock values. (See the SystemC reference manual for details about the
sc_clock parameters.) The parameters are:

— Initial Value (Low or High)

— Start Time (double)

— Start Time Units (SC_FS, SC_PS, SC_NS, SC_US, SC_MS, SC_SEC)
— Duty Cycle (double)

— Period (double)

— Period Time Units (SC_FS, SC_PS, SC_NS, SC_US, SC_MS, SC_SEC)

For moreinformation on using the Ports window for SystemC, see “Ports Tab” on page 88. That
section refersto SoC Designer, but for SystemC, the tool is the SystemC simulator.

4.6.3 Recompiling the Model

After you have defined all the specific settings for your component using the Ports Editor, you
need to recompile your project. Click the Compile button at this point to generate the updated
filesto be used with your component.
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Appendix A

ARM-supplied Transactors for SoC Designer

This appendix describes the transactors and other entities that are listed in the Transactor Type
pulldown list in the SoC Designer Ports tab. These entities fall into the following categories:

* Pseudo-transactors. These are not transactors, but they create port connections on the
component. These include null ports, interrupt translators, reset inputs, and
clock_inputs and outputs (see “ Pseudo-Transactors’ on page 146).

e Transactorsthat areexternal to the Cycle Model. Thisincludesthe AMBA transac-
tors. Use Cycle Model Sudio to add these transactors and their transaction ports to the
component and connect their signalsto the RTL signals (see “ Transactors that are
External to the Cycle Model” on page 159).

In addition, you can write your own transactor and use Cycle Model Studio to connect it to a
Cycle Model. See Appendix B, User-Defined Transactors with SoC Designer for more informa-
tion.
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A.1 Pseudo-Transactors

For convenience, the Cycle Model Studio includes afew entitiesin its Add Xtor pulldown list

that are not transactors. These items include:
e Null Ports (Null_Input and Null_Output)
* Interrupt Translators (Interrupt_Master and Interrupt_Slave)
» Clock Inputs and Clock Generators
* Reset Inputs

A.1.1 Null Ports

Null_Input

This creates a component input port that is not connected to an RTL signal. Thisis useful when
the component being generated must have the same ports as another component, even if some

of theinput ports are not used by the Cycle Model.

Null_Output

This creates acomponent output port that is not connected to an RTL signal. Thisisuseful when
the component being generated must have the same ports as another component, even if some

of the output ports are not used by the Cycle Model.

A.1.2 Interrupt Translators

ARM supplies Interrupt_Slave and Interrupt_Master pseudo-transactors to translate SoC
Designer interrupt signalsto RTL interrupt signals. These entities are not true transactors as

they lack transaction ports.

Component
)
Cycle
— Model (——\
Interrupt . ) Interrupt
I nterrupt _Slave TG AEREY _Master Interrupt
signa a signa
E/ \\=))
————
Figure A-1 Interrupt_Slave and Interrupt_Master Translators
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Interrupt_Master

Thisisamaster port that tells which interrupt signal was triggered. It receives up to 32 RTL
interrupt signals and transmits that information out through its master signal transaction port.
The Interrupt_Master uses the following convention:

» Each RTL signal connected to the Interrupt_Master hasan ‘id’ parameter giving the
signalNumber associated with the RTL signal.

*  Whenthe RTL signal isdriven, the Interrupt_Master port’'sdriveSignal methodis
called with this convention:

driveSignal (signalNumber, &rtlSignalValue) ;
signalNumber isfromthe‘id’ parameter. This can be set to -1 to disable the interrupt
for the specified signal .
rtlSignalvalue iSthe value coming from the Cycle Model.

Interrupt_Slave

Thisisasignal dave port that drives RTL interrupt signals to the Cycle Model. The number of
interrupt signalsis automatically set based on the number of pins detected.

Each RTL interrupt signal maintainsits state until driven by anew call to the Interrupt_Slave's
driveSignal method. The RTL interrupt signal is specified by the first parameter in the
driveSignal method. The value to which the signal is set is specified by the second parame-
ter, asfollows:

driveSignal (signalNumber, &setOrClear) ;
signalNumber iSthe bit number of the RTL signal to modify.

setOrClearislorO.

For example:
int value = 0;
port->driveSignal (3, &value); // clear interrupt 3
value = 1;
port->driveSignal (4, &value); // set interrupt 4

The above code clears bit 3 and sets bit 4 of the RTL signal value.
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A.1.3 Clock Inputs and Clock Generators

This section describes the two available clocking mechanisms — clock_inputs and
clock_generators— and when to use them.

e Clock_input

e Clock_generator

» Clock-related Parameters
» Clock_output

A.1.3.1 Clock_input

A Clock_Input creates a component input port that you can use to clock a component data port.
Itisused to drive an RTL clock input of the Cycle Model, and/or control the update frequency
of atransactor. Clock_inputs create a 1:1 pulse-to-cycle ratio. To specify a slower frequency,
use a CDIV (clock divider).

For instructions on creating a
» Clock_input — Refer to “Adding Transactors and Other Interface Entities’ on page 94.
» Clock divider — Refer to the SoC Designer User Guide.

Consider the example shown in Figure A-5, below.

Two clock dividers (CDIV1 and CDIV2) are used in combination with clock_inputs AHBclk1
and AHBclk2. CDIV1 specifies a pulse -to-cycleratio of 1:2, and CDIV 2 specifies a pulse-to-
cycleratio of 1:3. The output clocks of each clock_input initiate a 1:1 pulse frequency to the
AHBclk1 and AHBclk2 ports on the Cycle Model.

In effect, this design runsthe AHBclocks at 1/2 and 1/3 the frequency of the pulse, respectively.
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Component within SoC Designer

lAHB—- AHB T2S AHB S21 tAHB)

()
(Clock_\ j
Input

4 )

AHB AHB

1o | ||AHBCKk1
CDIV1I =P 11

: »| AHBCIK1

~ 4 L1 L lAHBdK2
Clock

- Cycle M odel
Input

AHBclk2

CDIV2 | ——p

\=))

rclk_in

Figure A-2 Clock_inputs

Figure A-3, below, shows the waveforms generated when the CDI_S2T are used in combination
with clock_inputsto run AXI clocks at the frequencies shown in Figure A-2. Note that the
waveforms are generated based on the CDIV pulses, not the master SoC Designer clock pulses.
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Master SoC Designer Clock Pulses

|
Clock_input Waveform |
l

[

Master SoC Designer Clock Pulses

CDIV1 Pulse (1:2) ‘ J
| I
| |
| |

|

CDIV2 Pulse (1:3)

Clock_input Waveform |

Figure A-3 CDIVs and Clock_Inputs

Using the Clock_input Enable pin

Clock_input alows RTL and transactors to be clocked synchronously; the Enable pin allows
you to further refine your clocking conditions. By specifying a high or low Enable signal, in
combination with code that defines your requirements, you determine the circumstancesin
which the RTL executes.

For example, you may want to power off/power on a device during a reset sequence. Connect-
ing the Enable pin to an MxStub component with code that sets Enable to low at time Zero dis-
ables clocking during the reset sequence. When the reset sequence ends, the

MxStub code sets Enable to high, re-enabling clocking.
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To use the Enable pin:

1. Create atop-level component signal slave port to act as the Enable for the Clock _Input
(in Figure A-4, user_enableisthe signa slave port).

2. Connect the new signal slave port to ascalar enable input signal to the RTL. This
requires the RTL to use the Enable signal to qualify execution of the RTL code. In Fig-
ure A-4, the RTL signal isnamed rtl_enable.

3. Drivethetop-level Enable signal (user_enablein Figure A-4) from the SoCD Canvas.

If the top-level Enable signal isleft undriven, it defaultsto Zero, so the associated trans-
actors within the component (and the qualified RTL code) never execute.

Component within SoC Designer

lAHB—- AHB T2S AHB S21 1~ AHB)

—
Clock ( \
Input

P AHB AHB

AHBclk1

L1 | AHBdkL
\ ) L1 Ll AHBdK2
f(:
Clock_
I nput

AHBclk2

1:2
CDIV1 —p

— CycleMode

CDIV2 —=9

rtl_enable

user_enable \ )
rcl k_in

Figure A-4 Use of the Enable pin

Note:  When creating a SoC Designer component wrapper, if you leave the Enable pin to the
Clock_input transactor unconnected, the Clock_input transaction is always enabled,
and no Enable port exists on the SoOCD component.

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 151
ID111516 Non-Confidential



A.1.3.2 Clock_generator

A clock_generator creates an internal clock, allowing you to specify how you want to map
component cyclesto clock cycles. Clock _generators support the creation of various pulse inter-
vals, so that you can create multiple frequencies for internal logic.

Note:  When possible, ARM recommends creating a clock input transactor and exposing the
clock input port externally, rather than creating a clock generator. The clock input
approach tends to simplify your design.

However, the clock generator approach may be required for certain configurations. For
example:

*  Memory controller with PHY and DDR — Largerratio values are required for a
CDIV-driven clock_input, due to the odd ratio clock of the PHY. Thisresultsin
inefficient simulation time.

* Non-transactor 1/0s — These ports are read and driven via the update () and
communicate () methods registered to the component's own default clock input.
The RTL logic directly connected to these ports must be driven by the same clock.

In Figure A-5 below, the component’s input clock (clk_in) is connected to the master clock, so
that the component receives periodic clock ticks from the SoC Designer master clock. You can
connect multiple clock_generatorsto clk_in; in this example, two clock_generators produce 1:1
and 1:2 pulse-to-cycle ratios to the Cycle Model.

For instructions on creating a clock_generator, refer to “ Specifying Generated Clocks’ on
page 91.
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Component within SoC Designer
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Figure A-5 Clock_generators
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Figure A-6, below, shows the waveforms generated when clock _generators specify clock cycles
that either match the component cycle (1:1 ratio) or differ from the component cycle (1:2), as
shown in Figure A-5.

Master SoC Designer Clock Pulses

0 1

|
Clock_generator Wave#orm ata l:1ratio

’7 | |

___N_
_ — - __  — —
N

Clock_generator Waveform at a 1:2 ratio |

Figure A-6 Clock_generator Waveforms at Different Ratios
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A.1.3.3 Clock-related Parameters
During reset, clocks are generated according to the parametersin Table A.1.

Note: The Enable element ( (& eEmaBLE ) that appears at the bottom of the Clock_Input
parameter list isin fact a pin for the transactor port, not a parameter. Refer to “Using

the Clock_input Enable pin” on page 150 for information about its use.

Table A.1: Parameters for Clock_inputs and Clock_generators

Parameter Description Clock_input | Clock _generator
Clock Cycles? | Thefrequency of the clock cycle. Fixed at a Any rétio.
L:1ratio.
Clock Port Determines whether the component displays | True or False. Not supported.
Visible the clock slave port.
Comp Cycles? The frequency of the component cycle. Fixed at a Any rétio.
1:1ratio.
Delay The percentage of a component cycle to Delay is Not supported.
delay before generating a clock. See Figure | applied at every
A-8 below. activation.
Delay Enable Determines whether changes to an enable Trueor False. Not supported.
during a cycle are applied to the next com-
ponent cycle.
Duty Cycle The percentage of the clock cycle for which | 0 — 99 0—99
the clock valueis high. See Figure A-9
below.
Initial Value Clock initia value. Low (0) or Low (0) or
High (1) High (1)
Initial Delay The percentage of a component cycle to Not supported. | Initial Delay is
delay before generating a clock. See Figure applied on initial
A-7 below. edge only.

a. Clock Freguency during reset is Clock Cycles per Component Cycles.

Figure A-7 shows awaveform with a2:1 ratio and an Initial Delay set to Fifty Percent.

25%

50% 25%

Figure A-7 Wave with an Initial Delay of 50%
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Figure A-8 illustrates awaveform with a 1:1 ratio, with Delay set to Zero percent and
Fifty percent.

Master SoC Designer Clock Pulses

Clock_generator Delay set to 0% (waveform at'a 1:1ratio)

o

Clock_generator Delay|set to 50% (waveform dtal:l ratio)
\—

|

[ |

Figure A-8 Wave with Delay set to 0% percent and 50%

0 ! ? 3 4
| | | |
| | |

| |
| |
|
|
|
|
|

Figure A-9 shows awaveform with a 2:1 ratio and Duty Cycle set to Twenty-Five percent.

25%

75%

0 1 2

Figure A-9 Wave with a Duty Cycle of 25%

A.1.3.4 Clock_output

Clock_output creates a component output port that you can connect to a clock output of the
CycleModsl.

If your Cycle Model generates an output clock, you must connect a Clock_Output to that clock.

In SoC Designer, all clock slaves that are connected to the Clock Output port are updated on
every cycle on which a posedge value change is observed on the Cycle Model clock output.

For instructions on creating a clock_output, refer to “ Adding Transactors and Other Interface
Entities” on page 94.
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A.1.4 Reset Inputs

Reset Inputs create a reset input port that you can connect in an RTL input of the Cycle Model.
This transactor can be used when an automatic reset pulse is desired during the reset sequence,

but also allows the ability to manually drive the reset during simulation.

Component

)

Cycle
(——\ Model

Reset

in_reset |H et - pelreset

Figure A-10 Reset_Inputs
Table A.2 describes the Reset_Input parameters.

Table A.2: Parameters for Reset_Inputs

Parameter Description

Active High Determines whether the reset is Active High (set to true) or
Active Low (set to false).

Active Value? Specifies adecimal value to be used when reset is active
(asserted). The default is 1.

Clock Cycles The frequency during the reset sequence is determined by the
ratio Clock Cycles:Comp (Component) Cycles. By default this

Comp Cycles isal:lratio.

Cycles After The minimum number of cycles the signal remains deasserted

before the reset period ends.

Cycles Asserted | The number of cycles during which the signal remains
asserted.

Cycles Before The number of cyclesto wait during the reset period before
asserting the signal.

Inactive Value? Specifies a decimal value to be used when reset is inactive
(deasserted). The default is 0.
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Table A.2: Parameters for Reset_Inputs (continued)

Parameter

Description

Use Active Value

Determines whether to use the Active/ Inactive Vaue (set to
true) or the Active High parameter (set to false).

a. The Active Value and I nactive Value parameters are used to drive a vector of
resets. The vector can be ascalar value. Vectors are sometimes used by models

with multiple cores that require individual resets.

The Active Value parameter is the value used when asserting reset, and the | nac-
tive Value parameter is used when reset is not asserted. Typically, the active and
inactive values are the sasme across all cores of the model. So for example, amodel
with four subcores using Active Low resets would have an Active Value of 0 and

an Inactive Value of 15.
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A.2 Transactors that are External to the Cycle Model

The transactors described in this section exist inside the component, but outside of the Cycle
Model. Thisincludesthe ARM AMBA transactors. Use Cycle Model Studio to add these trans-
actors and connect their ports to the appropriate RTL portsin the Cycle Model.

Component
)
ycle —\
Transactor M odel Tren
inputs| < —®| inputs
e EE— ———>
T2SPp— 4 T
— -
outputs | outputs
\ ) /)
—————
Key:
T2S: transaction-to-signa
S2T: signal-to-transaction
} Transaction port

Figure A-11 Generic Transactor External to Cycle Model

Definitions

2T stands for signal-to-transaction. The Cyclecomponent drives the transaction into SoC
Designer. The Cyclecomponent sends the transaction through the transaction master port. SoC
Designer usually receives the transaction through signal slave ports.

T2S stands for transaction-to-signal. SoC Designer drives the transaction into the Cyclecompo-
nent. The Cyclecomponent receives the transaction through the transaction slave port. SoC
Designer usually sends the transaction through signal master ports.

Arbiter: The arbiter regulates the bus masters so that only one bus master at atime can initiate
data transfer.
AHB_Master S2T|T2S, AHB_Save S2T|T2S. The term Master or Save that appearsin the

transactor name refers to the master or dave side of the AHB interface. In the next four dia-
grams, the AHB_Master_S2T|T2S transactors appear to the left of the arbiter (the AHB master
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interface has the request/grant signals). The AHB_Save S2T|T2S transactors appear to the
right of the arbiter (the AHB slave interface does not have the request/grant signals).

Scope: The scope of each transactor parameter is one of the following values:

» Compile-Time. The parameter has to be set when instantiating the adaptor in Cycle
Model Studio. The parameter cannot be set in the SoC Designer Canvas.

* Init-Time. The parameter can be changed in the SoC Designer Canvas.
* Run-Time. The parameter can be changed at runtime during simulation.
The following transactors are discussed in this section:
* “AHB Transactors’ on page 161
* “APB Transactors’ on page 181
* “APB3 Transactors’ on page 184
* “AXI Transactors’ on page 192
* “ARM926 DTCM Transactors’ on page 201
*  “CHI Transactors’ on page 203
Note: The AHB and AXI transactors are available in two different versions:. the original ver-
sion (v1), and the newer version (v2) that supports flow through. ARM recommends that

you use the v2 transactors for new projects, if possible, because the non-flow-through
transactors will be deprecated in a future version of Cycle Model Sudio.
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A.2.1 AHB Transactors

There are two variants of the AHB transactors:

AHB_Master_xxx and AHB_Save xxx: These are the origina AHB transactors that
have been available through Cycle Model Studio for many releases.

AHB Master Fxxx/AHB_Lite Master Fxxx and

AHB_Save Fxxx/AHB_Lite Save Fxxx: These flow-through versions of the AHB
transactors (v2) should be used if the Cycle Model has flow through (asynchronous)
paths in the design.

This section describes:

AHB_Master_S2T and AHB_Master_FS2T
AHB_Slave T2Sand AHB_Slave FT2S
AHB_Master T2Sand AHB_Master_FT2S
AHB_Slave S2T and AHB_Slave FS2T
AHB_Lite Master_S2T and AHB_Lite Master FS2T
AHB_Lite Master FT2S

AHB_Lite Slave T2Sand AHB_Lite Slave FT2S
AHB_Lite Slave FS2T
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A.2.1.1 AHB_ Master S2T and AHB_Master FS2T

A transactor that converts AHB Master interface signals from the Cycle Model into transactions
that are communicated through the transaction master port. S2T stands for signal-to-transaction.
These transactors can communicate with SoC Designer components that implement the CAS
AHB transaction interface.

Component
4 N\
Cycle M odedl
U _ ﬁHB_M aster_SZﬁ
with Transactor
AHB Master

—— | hbreq
| haddr
| hburst
—— 1| hprot
—— | hsize
— | htrans

I | hwdata 4’_> Arbiter]— élnge
—— | hwrite
— | hlock
— | hbstrb *
—— | hunalign *
—— | hdomain *

l«——| hrdata
<« hready
«————| hresp

- \Qgrant )/

* Optional signalsfor ARM11 extension

Figure A-12 AHB_Master_S2T Transactor
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AHB_Master_S2T and AHB_Master_FS2T parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Big Endian

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Init-time

Description: Affects the alignment of the data on the data bus. When true, the dataiis
read as “big endian” on the data bus.

Parameter: Align Data
Parameter Type: boolean
Legal Values: true, false Default = false.
Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.
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A.2.1.2 AHB_Slave T2S and AHB_Slave FT2S

A transactor that converts AHB transactions from a transaction slave port into AHB Slave inter-
face signalsin the Cycle Model. T2S stands for transaction-to-signal. These transactors can

communicate with SoC Designer components that implement the CASI AHB transaction inter-

face.

AHB
M aster

|| Arbiter

T2S

&

VA HB Slave T Zﬁ

Transactor

hresp
hreadyout
hrdata
exresp*
exreg*
memattr*
haddr
hwdata
hwrite
hready
hsel
htrans
hburst
hsize
hprot
hmaster
hmastlock
hbstrb**
hunalign**

Component

hdomai n’D
74

[ CycleMode

with
AHB Slave

-

* AHBV2 sideband signals for the Cortex-M 3. For details see the AHBv2

Protocol Bundle User Guide or the ARM Cortex-M3 r2P0 TRM.

** Optional signalsfor ARM 11 extension

Figure A-13 AHB_Slave T2S Transactor
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AHB_Slave T2S and AHB_Slave FT2S parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Base Address (for AHB_Slave T2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Base address of the AHB Slave memory region 0.
Parameter: ahb start1 (for AHB_Slave T2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Base address of the AHB Slave memory region 1.
Parameter: region start [0-5] (for AHB_Slave FT2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0x0.

Scope: Init-time

Description: Base address of the AHB Slave memory regions 0 through 5.
Parameter: size (for AHB_Slave T2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = null.

Scope: Init-time

Description: Size of memory region 0.
Parameter: ahb sizel (for AHB_Slave T2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 32.

Scope: Init-time

Description: Size of memory region 1.
Parameter: region size [0-5] (for AHB_Slave FT2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0x100000000 for region 0
0xO0 for regions 1-5

Scope: Init-time
Description: Size of memory regions 0 through 5.
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Parameter: subtract Base Address (for AHB_Slave T2S)

Parameter Type: boolean
Legal Vaues: true, false. Default = false.
Scope: Init-time

Description: When set to true, the Base Address is subtracted from the transaction
address, and the offset is sent to the RTL port. When set to false (the default value), the
transaction addressis sent to the RTL port unchanged.

Parameter: subtract Base Address Dbg (for AHB_Slave T2S)

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time

Description: Set this parameter when using the readDbg and writeDbg members of the
transactor ports. When set to true, the Base Address is subtracted from the transac-
tion address, and the offset is sent to the RTL port. When set to fal se (the default value),
the transaction address is sent to the RTL port unchanged.

Parameter: Big Endian

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time

Description: Affects the alignment of the data on the data bus. When true, the dataiis
output “big endian” on the data bus.

Parameter: Align Data

Parameter Type: boolean
Legal Vaues: true, false Default = false.
Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.

Parameter: Filter HREADYIN

Parameter Type: boolean

Legal Values: true, false. Default = false.

Scope: Init-time

Description: AHB slaves are required to have an HREADY signal as both an input and
an output. The output isthe dave’s ready status, whilethe input is the ready status of all
the dlaves on the bus (presumably calculated by the bus arbiter). Setting this parameter
to true filters out the input HREADY “HREADIN” to prevent it from reaching the

Cycle Modédl. The parameter should be set only when it is not required by the slave for
correct operation.
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A.2.1.3 AHB_Master _T2S and AHB_Master_ FT2S

A transactor that converts AHB transactions from a transaction slave port into AHB Master

interface signals in the Cycle Model. These transactors can communicate with SoC Designer
components that implement the CASI AHB transaction interface.

AHB
M aster

T2S

ﬁH B_Master T zs\\

Transactor
hgrant
hresp
hreadyout
hrdata

hbusreq

Component

haddr

hwdata

hwrite

htrans
hburst

hsize

hprot

hlock

hbstrb *

hunalign *

\k hdomai ry

Y VYVYVYVYVYVVYVYVYY III]

Cycle Model

~

with AHB Arbiter

and AHB Slave

* Optional signalsfor ARM11 extension

Figure A-14 AHB_Master_T2S Transactor
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AHB_Master_T2S and AHB_Master_FT2S parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Vaues: true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Base Address (for AHB Master T2S)

Parameter Type: value

Legal Vaues. 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Base address of the AHB Slave memory region.
Parameter: region start [0-5] (for AHB_Master FT2S)

Parameter Type: value

Legal Vaues. 0 - Max Address Size. Default = Ox0.

Scope: Init-time

Description: Base address of the AHB Slave memory regions 0 through 5.
Parameter: size (for AHB Master T2S)

Parameter Type: value

Legal Vaues. 0 - Max Address Size. Default = null.

Scope: Init-time

Description: Size of memory region.
Parameter: region size [0-5] (for AHB Master FT2S)

Parameter Type: value

Legal Vaues. 0 - Max Address Size. Default = 0x100000000 for region O
0xO0 for regions 1-5

Scope: Init-time
Description: Size of memory regions 0 through 5.
Parameter: ahbm port ID
Parameter Type: value
Legal Values: 0 - Max ID of the connected arbiter. Default = 0.
Scope: Init-time
Description: Port ID used when sending a bus request to the arbiter.

Parameter: Big Endian
Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
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Description: Affects the alignment of the data on the data bus. When true, the dataiis
output “big endian” on the data bus.

Parameter: Align Data
Parameter Type: boolean
Legal Values: true, false Default = false.
Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.
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A.2.1.4 AHB_Slave S2T and AHB_Slave FS2T
A transactor that converts AHB Slave interface signals from the Cycle Model into transactions
that are communicated through the transaction master port. These transactors can communicate
with SoC Designer components that implement the CASI AHB transaction interface.

Component

e D f N\
Cycle Model (AH B S ave_SZT\

with AHB M aster Transactor
and AHB Arbiter

| »| haddr
| | hburst
L | hprot
L | hsize
- wi| htrans
——— | hwdata AHB
] | hwrite 4’.__> Save
—— | hmastlock 2T
] | hready
] L ! hsd

] —— | hbstrb*
——— = hunalign*
—— | hdomain *

e« ! hrdata
@« !| hreadyout

y ) A\ S

* Optiona signals for ARM 11 extension

Figure A-15 AHB_Slave S2T Transactor
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AHB_Slave S2T and AHB_Slave FS2T parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Big Endian

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Init-time

Description: Affects the alignment of the data on the data bus. When true, the dataiis
read as “big endian” on the data bus.

Parameter: Align Data
Parameter Type: boolean
Legal Values: true, false Default = false.
Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.
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A.2.1.5 AHB_Lite Master S2T and AHB_Lite_Master FS2T

A transactor that converts AHB-Lite Master interface signals from the Cycle Model into trans-
actions that are communicated through the transaction master port. These transactors can com-
municate with SoC Designer components that implement the CASI AHB transaction interface.

Component

Cycle Model ﬁH B_Lite Mast 3\

with AHB Lite S2T Transactor

Master
| el haddr

| »l| hburst
L | hprot
L !l hsize
L p=| htrans
| | hwdata B
————— = hwrite
——»| hlock
—— | hbstrb *
————| hunalign *
—— | hdomain *

< I} hrdata
<« | hready
| hresp

\

\

* Optional signalsfor ARM11 extension

Figure A-16 AHB_Lite_Master_S2T Transactor
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AHB_Lite Master_S2T and AHB_Lite _Master FS2T parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Big Endian

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Init-time

Description: Affects the alignment of the data on the data bus. When true, the dataiis
read as “big endian” on the data bus.

Parameter: Align Data
Parameter Type: boolean
Legal Values: true, false Default = false.
Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.
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A.2.1.6 AHB_Lite_Master_FT2S
A transactor that converts AHB-Lite Master transactions from atransaction slave port into AHB

Master interface signalsin the Cycle Model. These transactors can communicate with SoC

Designer components that implement the CASI AHB transaction interface.
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Figure A-17 AHB_Lite_Master_FT2S Transactor
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AHB_Lite Master FT2S parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: region start [0-5]

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0x0.

Scope: Init-time

Description: Base address of the AHB memory regions O through 5.
Parameter: region size [0-5]

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0x100000000 for region 0
0xO0 for regions 1-5

Scope: Init-time

Description: Size of memory regions 0 through 5.
Parameter: Big Endian

Parameter Type: boolean

Legal Values: true, false. Default = false.

Scope: Init-time

Description: Affects the alignment of the data on the data bus. When true, the dataiis
output “big endian” on the data bus.

Parameter: ahbm port ID

Parameter Type: value

Legal Vaues: 0 - Max ID of the connected arbiter. Default = 0.

Scope: Init-time

Description: Port 1D used when sending a bus request to the arbiter
Parameter: Align Data

Parameter Type: boolean

Legal Values: true, false Default = false.

Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.
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A.2.1.7 AHB_Lite _Slave T2S and AHB_Lite Slave FT2S

A transactor that converts AHB transactions from a transaction slave port into AHB-Lite Slave
interface signals in the Cycle Model. These transactors can communicate with SoC Designer
components that implement the CASI AHB transaction interface.
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Slave

~

* Optional signalsfor ARM11 extension

Figure A-18 AHB_Lite_Slave_T2S Transactor
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AHB_Lite Slave T2S and AHB_Lite_Slave FT2S parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Base Address (for AHB_Lite Slave T2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Base address of the AHB Slave memory region 0.
Parameter: ahb start1 (for AHB_Lite Slave T2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Base address of the AHB Slave memory region 1.
Parameter: region start [0-5] (for AHB_Lite Slave FT2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0x0.

Scope: Init-time

Description: Base address of the AHB Slave memory regions 0 through 5.
Parameter: size (for AHB_ Lite Slave T29)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = null.

Scope: Init-time

Description: Size of memory region 0.
Parameter: ahb sizel (for AHB_Lite Slave T2S)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 32.

Scope: Init-time

Description: Size of memory region 1.
Parameter: region size [0-5] (for AHB_Lite Slave FT29)

Parameter Type: value

Legal Values. 0 - Max Address Size. Default = 0x100000000 for region 0
0xO0 for regions 1-5

Scope: Init-time
Description: Size of memory regions 0 through 5.
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Parameter: subtract Base Address (for AHB_ Lite Slave T2S)
Parameter Type: boolean
Legal Vaues: true, false. Default = false.
Scope: Init-time

Description: When set to true, the Base Address is subtracted from the transaction
address, and the offset is sent to the RTL port. When set to false (the default value), the
transaction addressis sent to the RTL port unchanged.

Parameter: subtract Base Address Dbg (for AHB_Lite Slave T2S)
Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time

Description: Set this parameter when using the readDbg and writeDbg members of the
transactor ports. When set to true, the Base Address is subtracted from the transac-
tion address, and the offset is sent to the RTL port. When set to fal se (the default value),
the transaction address is sent to the RTL port unchanged.

Parameter: Big Endian
Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time

Description: Affects the alignment of the data on the data bus. When true, the dataiis
output “big endian” on the data bus.

Parameter: Align Data
Parameter Type: boolean
Legal Vaues: true, false Default = false.
Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.

Parameter: Filter HREADYIN
Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time

Description: AHB slaves are required to have an HREADY signal as both an input and
an output. The output isthe dave’s ready status, whilethe input is the ready status of all
the dlaves on the bus (presumably calculated by the bus arbiter). Setting this parameter
to true filters out the input HREADY “HREADIN” to prevent it from reaching the
Cycle Modédl. The parameter should be set only when it is not required by the slave for
correct operation.
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A.2.1.8 AHB_Lite_Slave FS2T
A transactor that converts AHB-Lite Slave interface signals from the Cycle Model into transac-
tions that are communi cated through the transaction master port. These transactors can commu-
nicate with SoC Designer components that implement the CASI AHB transaction interface.

Component

% > 7 \\
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| | hburst
L | hprot
L | hsize
- | htrans
L | hwdata
] | hwrite 4’.__> ﬁiTeB_
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] —— | hbstrb*
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<« !| hreadyout
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-

* Optional signals for ARM 11 extension

Figure A-19 AHB_Lite_Slave FS2T Transactor
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AHB_Lite Slave FS2T parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Vaues: true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Big Endian

Parameter Type: boolean

Legal Vaues: true, false. Default = false.

Scope: Init-time

Description: Affects the alignment of the data on the data bus. When true, the dataiis
read as “big endian” on the data bus.

Parameter: Align Data
Parameter Type: boolean
Legal Values: true, false Default = false.
Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned
to the low bytes, even though the protocol states that data for an unaligned address
should be output on the correct byte lane. Setting this parameter to true enables aligning
of the data to the correct byte lane.

Note: Thisfield isno longer used, but is maintained for backwards compatibility.
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A.2.2 APB Transactors
This section describes:
« APB Master

e APB Slave

A.2.2.1 APB_Master

A transactor that converts APB Master interface signals from the Cycle Model into transactions
that are communicated through the transaction master port. These transactors can communicate
with SoC Designer components that implement the CASI APB transaction interface.

Component

Cycle M odél (( \\
A

_ PB_Master
with APB M aster Transactor

| paddr
L »!| pwdata

] - pi| pwrite ' T
| psel -

| | penable

l«— ! prdata

N

Figure A-20 APB_Master Transactor

APB_Master parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Vaues: true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: protocol Variant

Legal value: APB2

Scope: Fixed (not changeabl€)

ARM DUI 0958E Copyright © 2016 ARM Limited. All rights reserved. 181
ID111516 Non-Confidential



A.2.2.2 APB_Slave

Description: Specifies APB2 protocol

A transactor that converts APB transactions from atransaction slave port to APB Slave inter-
face signalsin the Cycle Model. These transactors can communicate with SoC Designer com-

ponents

that implement the CASI APB transaction interface.

T2 Pp— paddr |l |

Component

C )
(- APB_Slave \ CycleModel

Transactor with APB Slave

prdata |leg—

pwdata |- p»f —
pwrite j— o I

psel |— g |
penable [— g

N/

Figure A-21 APB_Slave Transactor

APB_S
Paramet

Paramet

lave parameters

€I Enable Debug Messages
Parameter Type: boolean

Legal Values: true, false. Default = false.
Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.

€I Base Address

Parameter Type: value

Legal Values: 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Base address of the APB Slave memory region.
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Parameter: size
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = null.
Scope: Init-time
Description: Size of memory region.
Parameter: protocol Variant
Legal value: APB2
Scope: Fixed (not changeable)
Description: Specifies APB2 protocol
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A.2.3 APB3 Transactors

This section describes:
+ APB3 Master
« APB3 Save

A.2.3.1 APB3_Master
A transactor that converts APB3 Master interface signals from the Cycle Model into transac-

tions that are communicated through the transaction master port. These transactors can commu-
nicate with SoC Designer components that implement the CASI APB3 transaction interface.

The difference between the APB Master and the APB3 Master is that the APB3 adds two sig-
nals: PREADY and PSLVERR. PREADY can be used by an APB slave component to insert
wait states to slow down the transfer. PSLVERR can be used by a slave component to signal an

error during atransaction.

Component
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with APB3 Master
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Figure A-22 APB3_Master Transactor
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APB3 Master parameters
Parameter: Enable Debug Messages
Parameter Type: boolean
Legal Values:. true, false. Default = false.
Scope: Run-time
Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Base Address
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = 0.
Scope: Init-time
Description: Base address of the APB memory region.
Parameter: size
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = null.
Scope: Init-time
Description: Size of memory region.
Parameter: PReady Default High
Parameter Type: boolean
Legal Values:. true, false. Default = false.
Scope: Run-time

Description: This parameter affects the value of the PReady signal while not in atrans-
action. When true, PReady is High between transactions. When false, PReady is Low.

Parameter: protocol Variant
Legal value: APB3
Scope: Fixed (not changeabl€)
Description: Specifies APB3 protocol
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A.2.3.2 APB3_Slave

A transactor that converts APB3 transactions from atransaction slave port to APB3 Slave inter-
face signalsin the Cycle Model. These transactors can communicate with SoC Designer com-
ponents that implement the CASI APB3 transaction interface.

The difference between the APB Slave and the APB3 Slave is that the APB3 adds two signals:

PREADY and PSLVERR. PREADY can be used by an APB slave component to insert wait

states to slow down the transfer. PSLVERR can be used by a slave component to signal an error
during atransaction.

T2S

/ APB3 Slave

Transactor

prdata
pready
pslverr

paddr
pwdata
pwrite
psel
penable

Component

\____

4 N

Cycle M odel
with APB3 Slave

Figure A-23 APB3_Slave Transactor

APB3_Slave parameters

Parameter: Enable Debug Messages

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Run-time

Parameter: Base Address

Parameter Type: value
Legal Values. 0 - Max Address Size. Default = 0.
Scope: Init-time

Description: When set to true, the adaptor outputs debug messages while running.

Description: Base address of the APB Slave memory region.
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Parameter: size
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = null.
Scope: Init-time
Description: Size of memory region.
Parameter: protocol Variant
Legal value: APB3
Scope: Fixed (not changeable)
Description: Specifies APB3 protocol
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A.2.4 APB4 Transactors

This section describes:
+ APB4 Master

» APB4 Save

A.2.4.1 APB4_Master

A transactor that converts APB4 Master interface signals from the Cycle Model into transac-
tions that are communi cated through the transaction master port. These transactors can commu-
nicate with SoC Designer components that implement the CASI APB4 transaction interface.

APB4 adds two signals. PSTRB, a byte strobe for write commands, and PPROT, which selects

the protection type.

CycleModel
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Figure A-24 APB4_Master Transactor
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APB4 Master parameters
Parameter: Enable Debug Messages
Parameter Type: boolean
Legal Values:. true, false. Default = false.
Scope: Run-time
Description: When set to true, the adaptor outputs debug messages while running.
Parameter: Base Address
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = 0.
Scope: Init-time
Description: Base address of the APB memory region.
Parameter: size
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = null.
Scope: Init-time
Description: Size of memory region.
Parameter: PReady Default High
Parameter Type: boolean
Legal Values:. true, false. Default = false.
Scope: Run-time

Description: This parameter affects the value of the PReady signal while not in atrans-
action. When true, PReady is High between transactions. When false, PReady is Low.

Parameter: protocol Variant
Legal value: APB4
Scope: Fixed (not changeabl€)
Description: Specifies APB4 protocol
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A.2.4.2 APB4_Slave
A transactor that converts APB4 transactions from atransaction lave port to APB4 Slave inter-
face signalsin the Cycle Model. These transactors can communicate with SoC Designer com-
ponents that implement the CASI APB4 transaction interface.

APB4 adds two signals. PSTRB and PPROT. PSTRB, a byte strobe for write commands, and
PPROT, which selects the protection type.
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Figure A-25 APB4_Slave Transactor
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APB4_Slave parameters

Parameter: Enable Debug Messages
Parameter Type: boolean
Legal Values:. true, false. Default = false.
Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Base Address
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = 0.
Scope: Init-time
Description: Base address of the APB Slave memory region.
Parameter: size
Parameter Type: value
Legal Values. 0 - Max Address Size. Default = null.
Scope: Init-time
Description: Size of memory region.
Parameter: protocol Variant
Legal vaue: APB4
Scope: Fixed (not changeable)
Description: Specifies APB4 protocol
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A.2.5 AXI Transactors

There are four variants of the AX| transactors:

Note:

Note:

AXI_Master and AXI_Save: These are the original AXI v1 transactors that have been
available through Cycle Model Studio for many releases.

AXI_Flowthru_Master and AXI_Flowthru_Save: These flow-through versions of the
AXI transactors (v2) should be used if the Cycle Model has flow through (asynchro-
nous) pathsin the design. These transactors are compatible with the ARM AMBA3/
AXI protocol.

AX14 Master and AXI4_Save: These transactors support the ARM AMBAA4/AXI pro-
tocol.

A component built with the original AXI transactors cannot be directly connected to a
component built with flow-through AXI transactors. The SoC Designer release provides
adaptors to connect two such components.

The AXI_Master and AXI_Save transactors are deprecated and will be removed in
2012 Q2.
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A.2.5.1 AXIl Master and AXI_Flowthru_Master
A transactor that converts AXI Master signals from the Cycle Model into transactions that are

communicated through the transaction master port. These transactors can communicate with

SoC Designer components that implement the CASI AXI transaction interface.
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AXI_Master and AXI_Flowthru_Master parameters
Parameter: Enable Debug Messages
Parameter Type: boolean
Legal Vaues: true, false. Default = false.
Scope: Run-time
Description: When set to true, the adaptor outputs debug messages while running.
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A.2.5.2 AXI_Slave and AXI_Flowthru_Slave

A transactor that converts AX| transactions from atransaction slave port to AX| Slave interface
signalsin the Cycle Model. These transactors can communicate with SoC Designer components

that implement the CASI AXI transaction interface.
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AXI_Slave and AXI_Flowthru_Slave parameters
Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Vaues: true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
Parameter: axi start [0-5]

Parameter type: value

Legal Vaues. 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Start Address of AX1 memory regions 0 through 5.
Parameter: axi size [0-5]

Parameter type: value

Legal Vaues. 0 - Max Address Size. Default = 0x10000000
Ofor regions 1-5

Scope: Init-time
Description: Size of AXI memory region O.
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A.2.5.3 AXl4 Master and AXI4_Slave

An AXI14_ Master transactor converts AX14 Master signals from the Cycle Model into transac-
tions that are communicated through the transaction master port.

An AXl4_Slave transactor converts AX14 transactions from a transaction slave port to AXI
Slave interface signalsin the Cycle Model.

The AX14 Master and Slave transactors implement a number of AX14 protocol variants includ-

ing:
e AXl4-Lite
 AXl4
 ACE-Lite
 ACE-LitetbVM
« ACE

Thisisimplemented as atransactor parameter called Protocol Variant. You can set thisvaluein
either of the following ways:

* InCMS, by accessing the Parameter pulldown menu on the Ports tab.

* In SoC Designer Canvas, by accessing the parameter on the component that contains
the transaction interface. There is one parameter per AX14 interface in the SoC
Designer component. The name is prefixed by the transaction interface name to differ-
entiate each interface's parameter.

These transactors can communicate with SoC Designer components that implement the CAS
AXI transaction interface. The following table describes the ports for the AXI14_Master and
AXI4_Slave transactors.
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Table A.3: AXl4_Master and AXI4_Slave Transactor Ports

Channel Port Master Direction Slave Direction
Write Address awid Model to transactor Transactor to model
awaddr Model to transactor Transactor to model
awlen Model to transactor Transactor to model
awsize Model to transactor Transactor to model
awburst Model to transactor Transactor to model
awlock Model to transactor Transactor to model
awcache Model to transactor Transactor to model
awprot Model to transactor Transactor to model
awuser Model to transactor Transactor to model
awvalid Model to transactor Transactor to model
awready Transactor to model Model to transactor
awqos Model to transactor Transactor to model
awregion Model to transactor Transactor to model
awdomain Model to transactor Transactor to model
awsnoop Model to transactor Transactor to model
awbar Model to transactor Transactor to model
Write Data wdata Model to transactor Transactor to model
wstrb Model to transactor Transactor to model
wlast Model to transactor Transactor to model
wuser Model to transactor Transactor to model
wvalid Model to transactor Transactor to model
wready Transactor to model Model to transactor
Write Response bid Transactor to model Model to transactor
bresp Transactor to model Model to transactor
buser Transactor to model Model to transactor
bvalid Transactor to model Model to transactor
bready Model to transactor Transactor to model
wack Model to transactor Transactor to model
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Table A.3: AXI4_Master and AXI4_Slave Transactor Ports (continued)

Channel Port Master Direction Slave Direction
Read Address arid Model to transactor Transactor to model
araddr Model to transactor Transactor to model
arlen Model to transactor Transactor to model
arsize Model to transactor Transactor to model
arburst Model to transactor Transactor to model
arlock Model to transactor Transactor to model
arcache Model to transactor Transactor to model
arprot Model to transactor Transactor to model
aruser Model to transactor Transactor to model
arvalid Model to transactor Transactor to model
arready Transactor to model Model to transactor
arqos Model to transactor Transactor to model
arregion Model to transactor Transactor to model
ardomain Model to transactor Transactor to model
arsnoop Model to transactor Transactor to model
arbar Model to transactor Transactor to model
Read Data rack Transactor to model Model to transactor
rid Transactor to model Model to transactor
rdata Transactor to model Model to transactor
rresp Transactor to model Model to transactor
rlast Transactor to model Model to transactor
ruser Transactor to model Model to transactor
rvalid Transactor to model Model to transactor
rready Model to transactor Transactor to model
Snoop Address acvalid Transactor to model Model to transactor
acready Model to transactor Transactor to model
acaddr Transactor to model Model to transactor
acsnoop Transactor to model Model to transactor
acprot Transactor to model Model to transactor
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Table A.3: AXI4_Master and AXI4_Slave Transactor Ports (continued)

Channel Port Master Direction Slave Direction
Snoop Response crvalid Model to transactor Transactor to model
crready Transactor to model Model to transactor
crresp Model to transactor Transactor to model
Snoop Data cdvalid Model to transactor Transactor to model
cdready Transactor to model Model to transactor
cddata Model to transactor Transactor to model
cdlast Model to transactor Transactor to model

AXI4_Master and AXI4_Slave parameters

Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values: true, false. Default = false.
Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.

Parameter: axi start [0-5]

Parameter type: value
Legal Values: 0 - Max Address Size. Default = 0.
Scope: Init-time

Description: Start Address of AX1 memory regions O through 5.

Parameter: axi size [0-5]

Parameter type: value

Legal Values: 0 - Max Address Size. Default = 0x10000000
Ofor regions 1-5

Scope: Init-time

Description: Size of AXI memory region O.
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A.2.6 ARM926_DTCM Transactors

The ARM926 DTCM_Slave and ARM926 DTCM_Master transactors are provided for use
with the SoC Designer model for the ARM926EJS with external Data TCM.

A.2.6.1 ARM926_DTCM_Slave and ARM926_DTCM_Master Ports

The transactor signal names are similar to the names assigned by ARM, but do not include the
“D” prefix (see the ARM926EJ-S Technical Reference Manual, rev rOp5). Refer to Figure A-28
and Figure A-29 for port directions..

Component
ARM926 DTCM_Slave Cycle M odél
Transactor with Data TCM

ICS ——M ]
ridle |— pf —
rwait ||eg— | I

T2S F raddr |L— g I
mmw [——— I
rseq |—————— ——
rwhl (— ——

rwd [—
md l@t———— |

\ Y _ Y

Figure A-28 ARM926 _DTCM_Slave Transactor
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rwait
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ARM926 DTCM
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N ¥

Figure A-29 ARM926_DTCM_Master Transactor
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A.2.7 CHI Transactors

The CHI transactors are separated into two groups: CHIInt* and CHINode*. The CHIInt* trans-
actors convert signalsfrom a CHI ICN (Interconnect) port to link layer flits, which are trans-
acted to/from a CHI Node port. The CHINode* transactors convert signals from a CHI Node
port to link layer flits, which are transacted to/from a CHI ICN port.

These transactors communicate with SoC Designer components that implement the AMBA
CHI Port Interface classes. Refer to the AMBA CHI Protocol Bundle User Guide for moreinfor-
mation.

A.2.7.1 CHIInt* Transactors

The CHIInt* set of transactors includes:

e CHIIntRNDXtor (CHI Completer)

*  CHIIntRNFXtor (CHI Completer)

e CHIIntRNIXtor (CHI Completer)

*  CHIIntRequestorXtor (CHI Completer)
e CHIIntSNFXtor (CHI Requestor)

e CHIIntSNIXtor (CHI Requestor)

* CHIIntSlaveXtor (CHI Reguestor)

This section describes the available signals and parameters for this set of transactors.
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CHIlInt* Transactor Signals
Table A.4 describes the available signals for each CHIInt* transactor.

Table A.4: CHIInt* Transactor Signals

Signal Availability Per Transactor
h | Sj | . . CHI | CHI | CHI CI::![I CHI | CHI | CHI
Channe igna Direction Int Int Int Requ Int Int Int
RND | RNF | RNI e;qor SNF | SNI | Slave
Xtor | Xtor | Xtor Xtor | Xtor | Xtor
Xtor
REQ TXREQFLIT Model to . . . .
Transactor
TXREQFLITPEND Model to . . . .
Transactor
TXREQFLITV Model to . . . .
Transactor
TXREQLCRDV Transactor . . . .
to Model
RXREQFLIT Transactor . . . . .
to Model
RXREQFLITPEND Transactor . . . . .
to Model
RXREQFLITV Transactor . . . . .
to Model
RXREQLCRDV Model to . . . . .
Transactor
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Table A.4: CHIInt* Transactor Signals (continued)

Signal Availability Per Transactor
chanmel Sl Srection | CHI | CHI | CHI Clr'jt' CHI | CHI | cHi
anne 'gna irection Int Int Int Requ Int Int Int
RND | RNF | RNI e:’tgr SNF | SNI | Slave
Xtor | Xtor | Xtor Xtor | Xtor | Xtor
Xtor
RSP TXRSPFLIT Model to . . . . .
Transactor
TXRSPFLITPEND Model to . . . . .
Transactor
TXRSPFLITV Model to . . . . .
Transactor
TXRSPLCRDV Transactor . . . . .
to Model
RXRSPFLIT Transactor . . . . . . .
to Model
RXRSPFLITPEND Transactor . . . . . . .
to Model
RXRSPFLITV Transactor . . . o . . .
to Model
RXRSPLCRDV Model to . . . . . . .
Transactor
SNP TXSNPFLIT Model to . . . .
Transactor
TXSNPFLITPEND Model to . . . .
Transactor
TXSNPFLITV Model to . . . .
Transactor
TXSNPLCRDV Transactor . . . .
to Model
RXSNPFLIT Transactor . .
to Model
RXSNPFLITPEND Transactor . .
to Model
RXSNPFLITV Transactor . .
to Model
RXSNPLCRDV Model to . .
Transactor
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Table A.4: CHIInt* Transactor Signals (continued)

Signal Availability Per Transactor

Y . Srection | CHI | CHI | CHI Clr'jt' CHI | CHI | cHi
anne Signa irection Int Int Int Requ Int Int Int
RND | RNF | RNI e;gr SNF | SNI | Slave
Xtor | Xtor | Xtor Xtor | Xtor | Xtor
Xtor
DAT TXDATFLIT Model to . . . . . N o
Transactor
TXDATFLITPEND Model to . . . . . . .
Transactor
TXDATFLITV Model to . . . . . . .
Transactor
TXDATLCRDV Transactor . . . . . . .
to Model
RXDATFLIT Transactor . . . o o o o
to Model
RXDATFLITPEND Transactor . . . . . . .
to Model
RXDATFLITV Transactor . . . . . . .
to Model
RXDATLCRDV Model to . . . . . . .
Transactor
Control TXLINKACTIVEACK | Transactor . . . . . . .
Signals to Model
TXLINKACTIVEREQ | Modéd to . . . . . . .
Transactor
TXSACTIVE Mode to . . . . . . .
Transactor
RXLINKACTIVEACK | Model to . . . . . . .
Transactor
RXLINKACTIVEREQ | Transactor . . . . . . .
to Model
RXSACTIVE Transactor . . . . . . .
to Model

CHlInt* Parameters
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Parameter: bata Bus Width

Parameter Type: integer value

Lega Values: 128, 256, 512. Default = 128.
Scope: Compile-time

Description: Width of rdata and wdata busses.

Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values:. true, false. Default = false.

Scope: Run-time

Description: When set to true, outputs debug messages while running.

Parameter: Protocol Variant

Parameter Type: string

Legal Values. Fixed. Default = Protocol for this transactor (i.e., CHI-RND).

Scope: Init-time
Description: Specifiesthe protocol variant for the transactor.

ARM DUI 0958E
ID111516

Copyright © 2016 ARM Limited. All rights reserved.
Non-Confidential

207



A.2.7.2 CHINode* Transactors
The CHINode* set of transactors includes;

* CHINodeRNDXtor (CHI Requestor)
e CHINodeRNFXtor (CHI Requestor)
*  CHINodeRNIXtor (CHI Reguestor)

*  CHINodeRequestorXtor (CHI Requestor)

*  CHINodeSNFXtor (CHI Completer)
*  CHINodeSNIXtor (CHI Completer)

* CHINodeSlaveXtor (CHI Completer)

This section describes the available signals and parameters for this set of transactors.

CHINode* Transactor Signals

Table A.5 describes the available signals for each CHINode* transactor.

Table A.5: CHINode* Transactor Signals

Signal Availability Per Transactor
CHI
. . . CHI | CHI | CHI CHI | CHI | CHI
Channel Signal Direction Node | Node | Node gOdS Node | Node | Node
RND | RNF | RNI egqor SNF | SNI | Slave
Xtor | Xtor | Xtor Xtor | Xtor | Xtor
Xtor
REQ TXREQFLIT Model to . . . . .
Transactor
TXREQFLITPEND Model to . . . . .
Transactor
TXREQFLITV Model to . . . . .
Transactor
TXREQLCRDV Transactor . . . . .
to Model
RXREQFLIT Transactor . . . .
to Model
RXREQFLITPEND Transactor . . . .
to Model
RXREQFLITV Transactor . . . .
to Model
RXREQLCRDV Model to . . . .
Transactor
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Table A.5: CHINode* Transactor Signals (continued)

Signal Availability Per Transactor
CHI
. ) i CHI | CHI | CHI CHI | CHI | CHI
Channel Signal Direction Node | Node | Node ';Odj Node | Node | Node
RND | RNF | RNI e:’tgr SNF | SNI | Slave
Xtor | Xtor | Xtor Xtor | Xtor | Xtor
Xtor
RSP TXRSPFLIT Model to . . . . . . .
Transactor
TXRSPFLITPEND Model to . . . . . . .
Transactor
TXRSPFLITV Model to . . . . . . .
Transactor
TXRSPLCRDV Transactor . . . . . . .
to Model
RXRSPFLIT Transactor . . o . .
to Model
RXRSPFLITPEND Transactor . . . . .
to Model
RXRSPFLITV Transactor . . . o .
to Model
RXRRSPLCRDV Model to . . . . R
Transactor
SNP TXSNPFLIT Model to . .
Transactor
TXSNPFLITPEND Model to . .
Transactor
TXSNPFLITV Model to . .
Transactor
TXSNPLCRDV Transactor . .
to Model
RXSNPFLIT Transactor . . . R
to Model
RXSNPFLITPEND Transactor . . . .
to Model
RXSNPFLITV Transactor . . . R
to Model
RXSNPLCRDV Model to . . . R
Transactor
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Table A.5: CHINode* Transactor Signals (continued)

Signal Availability Per Transactor

CHI
. ) i CHI | CHI | CHI CHI | CHI | CHI
Channel Signal Direction Node | Node | Node gOdS Node | Node | Node
RND | RNF | RNI &ftqor SNF | SNI | Slave
Xtor | Xtor | Xtor Xtor | Xtor | Xtor
Xtor
DAT TXDATFLIT Model to . . . . . N o
Transactor
TXDATFLITPEND Model to . . . . . . .
Transactor
TXDATFLITV Model to . . . . . . .
Transactor
TXDATLCRDV Transactor . . o . . . o
to Model
RXDATFLIT Transactor . o . . o o o
to Model
RXDATFLITPEND Transactor . . . . . . .
to Model
RXDATFLITV Transactor . . . . . . .
to Model
RXDATLCRDV Model to . . . . . . .
Transactor
Control TXLINKACTIVEACK | Transactor . . o . . . .
Signals to Model
TXLINKACTIVEREQ | Modéd to . . . . . . .
Transactor
TXSACTIVE Mode to . . . . . . .
Transactor
RXLINKACTIVEACK | Model to . . . . . . .
Transactor
RXLINKACTIVEREQ | Transactor . . . . . . .
to Model
RXSACTIVE Transactor . . . . . . .
to Model
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CHINode* Parameters
Parameter: bata Bus Width
Parameter Type: integer value
Legal Values: 128, 256, 512. Default = 128.
Scope: Compile-time
Description: Width of rdata and wdata busses.
Parameter: Enable Debug Messages
Parameter Type: boolean
Legal Values:. true, false. Default = false.
Scope: Run-time
Description: When set to true, outputs debug messages while running.
Parameter: protocol Variant
Parameter Type: string

Legal Values. Fixed. Default = Protocol for this transactor (i.e., CHI-RND).

Scope: Init-time
Description: Specifiesteh protocol variant for the transactor.
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Appendix B

User-Defined Transactors with SoC Designer

In addition to using the ARM-supplied transactors and the SoC Designer transactors, Cycle
Model Studio aso allows you to define your own transactors. In essence, this allows you to cre-
ate a named object with named input and output ports that can be connected, viathe Cycle
Model Studio, to Cycle Model ports.

This appendix describes how to write your own transactor and incorporate it into the compo-
nent. The first two sections describe the Cycle Model Studio’s requirements for the transactor’s
XML and C++ files. The final section describes how to use the Cycle Model Studio to integrate
your transactor into the component.

B.1 Writing the Transactor XML File

Every transactor must be described so that the Cycle Model Studio wizard can provide user
interface for port connections and generate the connecting code in the component. Your transac-
tor file must contain the following features:

* Thename of your transactor.

This name should be unique; that is, it should not duplicate the name of another transac-
tor.

e The name of the class instantiated by the component.
* Thename of the header file that defines the above class.
» A port definition for each of the transactor’s signal ports, if any.

You can use the transactor definitions found in the file $CARBON HOME/lib/xactors/xac-
tors.xml asaguide.
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Sample user-defined transactor XML file

<?xml version="1.0"?>
<transactors version="1.0">

<!-- Define your transactor with a ‘component’ element. The ‘name’
attribute is the transactor name and shows up in the Cycle
Model Studio menu.

-=>

<component name="MyTransactor"s>

<!--

The name of the class that is instantiated by the component
-->
<className>MyXtorClass</className>

<!--
The header file that contains the definition of the class
given by the className element

-->

<includeFilesuserXtors.h</includeFile>

<!--
Port definitions. A transactor may have any number of ports,
including none. Each port has a name, width, and direction,
as follows:

name: The name of the port. This name is used:
- In the Cycle Model Studio wizard to connect to RTL
signals.
- To find runtime port objects via the 'portFactory' and
'carbonGetPort' interfaces.

width: The width, in bits, of the port.

direction: "input" or "output"

-=>

<port name="input 1" width="1" direction="input"s>
<!-- a description of the port is optional -->
<description>Input One</descriptions>

</ports>

<port name="output 1" width="1" direction="output">
<description>Output One</descriptions>
</port>
</component >

</transactors>
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B.2 Writing the Transactor C++ Code

The structure of a user-defined transactor is similar to the structure of an SoC Designer compo-
nent.

Main transactor class
You must provide a C++ class with these methods:

class MyXtorClass

{

// constructor
MyXtor (sc_mx_module* carbonComp, const char *xtorName,
CarbonObjectID **carbonObj, CarbonPortFactory *portFactory);

// destructor
~MyXtor () ;

// provide input port handles to the Cycle Model component
sc_mx_signal slave *carbonGetPort (const char *name) ;

// similar to sc_mx module

void communicate() ;

void update () ;

void init () ;

void terminate() ;

void reset (MxResetLevel level, const MxFileMapIF *filelist);
void setParameter (const string &name, const string &value) ;

}i

Transactor output ports

Transactor output ports are connected to Cycle Model input ports by the Cycle Model Studio
wizard. The transactor writes signal valuesto the Cycle Maodel by calling the drivesignal
method of output port objects.

Output port handles are obtained by name viathe port Factory function passed to the
constructor. The portFactory function returns a pointer of type
CarbonXtorAdaptorToVhmPort:

MyXtor: :MyXtor (sc_mx module* carbonComp,
const char *xtorName,
CarbonObjectID **carbonObj,
CarbonPortFactory *portFactory)

mOutPort = portFactory (carbonComp,
xtorName, “output 1”, carbonObj) ;

}

Writing to output ports

Portsreturned by the portFactory have the same‘driveSignal’ interface as
sc_mx signal slave:

void driveSignal (MxU32 value, MxU32* extValue)

value = low 32 bits
extValue = pointer to the rest of the bits
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Transactor input ports

Input ports are connected to Cycle Model output signals by the Cycle Model Studio wizard. The
Cycle Model sends signal value changes to the transactor by calling the drivesignal method
of input port objects.

Implement sc_mx_signal slave portsjust asyou would for an SoC Designer component:

* Subclasssc mx_signal slave.

* OveridedriveSignal () to dowhat you need.

Implement carbonGetPort

The component needs to be able to get ahandle to your input ports so that it can write valuesto
them.

sc_mx_signal slave *MyXtor::carbonGetPort (const char *name)

{

sc_mx_signal slave *port = NULL;

if (strcmp("input 1", name) == 0) ({
port = mInputl;

}

return port;

}

init, reset, communicate, update, terminate

The init, reset, communicate, update, and terminate functions are al called by the
component when its own method of the same name isinvoked. See the SOoC Designer User
Guide for information on how these methods are used.

For more information about the C++ classes and member functions used to write your transac-
tor, contact ARM Technical Support.
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B.3 Adding your Transactor to the Component

To connect your transactor appropriately in the Cycle Model Studio tool:

1. Before creating the SoC Designer Component, specify the name of your user-defined

transactor in the Transactor Definition File field on the SoC Designer Component

Properties page.
Properties [ 2
Isoc Designer Componend Fvoperties LI
Zl2Y
MName | Yalue =

omponent Generation
- C++ Compile Flags

ompanent Name “unit

ransactar Definition File Jmy Xactor.2iml
Waveform File
i b Waveforms Mone
Componend Froperlies

Transactor Definition File sets up user defined transactars.

Figure B-1 SoC Designer Component Settings

3.

After you generate the component for SoC Designer, your transactor is available from

the list of available transactorsin Cycle Model Studio.

On the SoC Designer Component Editor Ports tab:
» Click the Add Xtor button.

* Inthe pulldown menu next to the Add Xtor button, select the name of your

transactor.

* Map your transactor portsto RTL ports as outlined in “ Adding Transactors and

Other Interface Entities” on page 94.

On the SoC Designer Component Properties page, add any compiler or linker flags

needed by your transactor.
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Appendix C

ARM-Supplied RTL Models

ARM provides afamily of smple RTL modelsfor usein designs compiled by Cycle Model Stu-
dio. Designed for high performance and easy integration, these models are instantiated directly
in your RTL design and compiled together to form a single Cycle model. When targeting the
SoC Designer platform, Cycle Model Studio automatically detects the presence of one or more
of these Cycle models and adds the appropriate parameters, registers, and memory viewsto the
SoC Designer component.

This appendix includes the following sections:
*  Oveview
» Using ARM-supplied RTL Models
»  Specific Requirements for DDRx Memory Models

C.1 Overview

ARM provides afamily of simple double datarate (DDR) memory models. In this document,
we refer to the family, which includes such models as DDR, DDR2, DDR3, DDR4, and
LPDDR2, as DDRx Memory Models.

Designed for high performance and easy integration, these Verilog memory models connect
directly to RTL-based memory controllers. A wide range of memory configurations are sup-
ported through compile time parameters, and each model’s interface timing can be adjusted to
simplify the connection to the controller’s physical layer interface.

The DDRx Memory Models are simple cycle-accurate functional memory models designed to
be embedded along with amemory controller and its physical layer interface to form asingle
memory subsystem component model. The DDRx Memory Model interfaces with the memory
controller physical layer interface at the pin level, as defined by the appropriate JEDEC stan-
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dard. You must provide the top level wrapper that instantiates the RTL memory controller and
the DDRx Memory Model in asingle module, and compile this using Cycle Model Studio to
create the memory subsystem model. Figure C-1 illustrates this usage.

/ System Level \

Memaory Subsystem Model

Ak 2 Carbon
DNV : E— e

System Bus emory £ —
V E Intarfzce Men"lorv
Controller | = (T Model

N /

Figure C-1 DDRx Memory Model Usage

Figure C-2 illustrates the internal hierarchy of the DDRx Memory Model shown on theright in
Figure C-1.

/ DDRx Memory Model \

|< - Bidirectionzl DO and
Individuzl Chip Selects » DOS signals
and Clock Enables > el
Comman Contro P -
Signals h-* DDRx Rank

Figure C-2 Internal Hierarchy of DDRx Memory Models
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C.1.1 DDRx Memory Model Location

The ARM-supplied RTL models and their command files are distributed as part of the Cycle
Model Studio release and are located in the immediate sub-directories of:

SCARBON HOME/1lib/carbonRTL

For example, the carbon_memory ddr subdirectory contains the following files:

carbon_memory_ ddr.cmd
carbon_memory ddr.v

The readme file for this release contains alist of models that are currently supported. Specific
detail s about the supplied RTL model interface and parameters can be found in the file that
defines the model, located in $CARBON HOME/1lib/carbonRTL/ *.

C.2 Using ARM-supplied RTL Models

To use an ARM-supplied RTL model, you must perform two steps, which are described in the
sections that follow:

1. Instantiate the desired module or modulesin your design with the appropriate parame-
ters (described in the section Instantiating the Module).

2. Add an ARM-supplied command file to the project for each model type you use
(described in the section Adding the ARM-supplied Command File).

This section al so describes:
e Configuring DDRx Size and Signal Timing
» DDRx Mode Registers
» DDRXx Profiling Capabilities

C.2.1 Instantiating the Module

Thefollowing isaVerilog example of instantiating amodule. In this example, an instance of the
carbon_memory_ddr2 moduleisincluded in the module named ddr2_memory_block.

module ddr2 memory block() ;

carbon_memory ddr2 #(.CS_BITS(3),

.DATA BITS (64),

.MAX_ADDR BITS (33),

.DQS_IN DELAY (1),

.DQS_OUT_DELAY (0)) myDDR2 (.ck (ck),
.ckbar (ckbar) ,
.cke (cke) ,
.cs_n(cs_n),
.ras_n(ras_n)
.cas_n(cas_n)
.we_n(we_n),
.dm (dm) ,
.ba(ba),
.addr (addr) ,
.dg(dq) ,
.dgs (dgs) ) ;

7
7
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endmodule

C.2.2 Adding the ARM-supplied Command File

The command file for the module is the module name with a . cmd extension. For example, the
name of the command file for the carbon_memory_ddr2 moduleis:

SCARBON HOME/1lib/carbonRTL/carbon memory ddr2/

carbon_memory ddr2.cmd

This command file for amemory islocated in the immediate sub-directory of $carBoN HOME/
lib/carbonRTL that corresponds to the memory name.

Add thefile to the Cycle Model Studio project by using the -f switch on the SoC Designer Com-
ponent Properties page as follows:

1. Click RTL Sourcesin the Project Explorer pane.
2. Choose Project > Compiler Setting. The Compiler Options screen appears.
3. Under Input File Control, enter the full pathname of the . cmd file.

If your design includes multiple instances of a particular model, only one copy of the . cmd
file needs to be included as an argument to the -f switch.

$CARBON_HOME/lib/carbonRTL/

See the Compiler Settings section “Using the Project Menu” on page 32 for more information
on setting compiler flags.
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C.2.3 Configuring DDRx Size and Signal Timing

Several compile time Verilog parameters are available to configure the size of the DDRx Mem-
ory Model and the timing it uses for the DQS/DQ signaling.

Table C-1 describes the compile time Verilog parameters that are available. “ Specific Require-
ments for DDRx Memory Models’ on page 227 and the pages following describe which must
be specified for each memory model.

Table C-1 Compile-time Verilog parameters

Parameter

Description

CS BITS

The number of chip selects and clock enable inputsto be gen-
erated. These signals are provided in vector form. CS BITS
determines the number of memory ranksin the model. For
any given instance of a DDRx memory model, all ranks have
the same configuration as determined by the other parameters.
If you need different rank configurations, then you must have
different instantiations of the model. Whilethis use caseisnot
precluded, the integration into atarget platform environment
is more complicated.

DATA_BITS

The data bus width. While the underlying Verilog code does
not place any regquirements on the width of the data bus, the
integration-related code assumes 8, 16, 32, 64, and 128 are
the only valid values. Note that widths that include error
checking/correction bits are not supported. Disable error
checking/correction bitsin the controller logic.

MAX_ADDR BITS

The maximum number of bits that together make up the bank,
row, and column address fields. The specific values for the
widths of the bank, row, and column address fields are set
using SoCD parameters and their sum cannot exceed the
MAX_ADDR_BITSvalue.

DQS IN_DELAY

Thisisthe number of % clock cycle delays that should be
applied to the DQS _IN signal before being used internally by
the model as an internal strobe. If the memory controller is
remodeled to generate an early DQS IN signal, set this
parameter to 1, otherwise set it to 0. (DQS IN_DELAY =0
means the signal can already be directly used to strobe in the
data.)
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Table C-1 Compile-time Verilog parameters (continued)

Parameter

Description

DQS OUT_DELAY

Thisisthe number of % clock cycle delays that should be
applied to the DQS_OUT signal. If the memory controller
expects the nominal early DQS signal and adjusts the DQS
timing itself, set DQS_OUT_DELAY to 0. However, if itis
more convenient to remodel the memory controller data cap-
ture circuits to directly use the DQS strobe provided by mem-
ory model, then set DQS OUT_DELAY to 1. For more
details concerning DQS timing and modeling, refer to the
application note Cycle-based Modeling of DDR-style Data
Transfers.

WRITE_PREAMBLE

(DDR3, DDR4, and
LPDDR3 only)

Determines the number of DQS Write preambles the memory
should expect.

* DDR3 defaultsto 1. Allowed values are 0 and 1.
* DDRA4 defaultsto 0. Allowed values are 0, 1, and 2.
* LPDDR3 defaultsto 0. Allowed values are 0 and 1.

READ_PREAMBLE

Determines the number of DQS Read preambles the memory
should expect.

(DDR4 only)
Defaultsto 1. Allowed valuesare 0, 1, and 2.
MR8 SETTING Defines the reset value of Mode Register 8 (also known as
Basic Configuration 4), which definesthe I/O width, Density,
(LPDDR2 and .
LPDDR3 only) and Type of memory. The default is 1.
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C.2.4 DDRx Mode Registers

Each embedded DDRx memory has internal mode registers; they are slightly different for each
memory model type. These registers are implemented according to the JEDEC specification for
each protocol, and configure the operation of the memory — for example, the number of clock
cyclesit takes the memory to respond to Read and Write commands is set by programming the
appropriate values in the mode registers. The Memory Model Mode registers are automatically
made visible via CADI registers for each Chip Select.

Figure C-3 shows the Mode Registers tab for the DDR3 memory model (the Commands, Bank
Commands, and Events tabs display registersrelated to profiling, and are discussed in the next
section). See the individual JEDEC protocol specification for details about the function of each
register.

[51 Registers for ddr3_subsystem_72b_2cs_2x[01.ddr3_data (ddr3_datal

i ddr3_data [ ddr3_data Commands | ddr3 data Bank Commands | ddr3_data Events

|Register |Value

- CS50 MRO Ox0000
- C50 MR1 0x0000
-C50 MRZ 0x0000
~CS0 MR3 Ox0000
-~C51 MRO Ox0000
-C51 MR1 0x0000
-C51 MRZ 0x0000
-C51 MR3 0x0000

Figure C-3 DDRx Mode Registers
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C.2.5 DDRXx Profiling Capabilities

The profiling capabilities discussed in this section are supported by all memory models except
the GDDRS.

The memory models support profiling through the use of countersin the RTL that track DDR
command-related events. These RTL counters and event signals are automatically instrumented
for models built using Cycle Model Studio.

Note that only Read/Write CADI register profiling is supported; CAPI profiling streams are not
generated.

Profiling data includes the following events and counters:
* Command Counters— For each Chip Select:

*  Providesthetotal count of ACTIVATE, READ, WRITE, PRECHARGE, and
REFRESH commands.

» Countsclock cycleswhere READ DATA or WRITE DATA istransferred. For
example, asingle Write Burst 8 DDR3 transfer increments the WRITE count by 1,
and the WRITE DATA by 4.

o Calculatesthe bus utilization percentages (READ, WRITE, and Total) over a
dliding 100 cycle window. In other words, a history of the last 100 cyclesis
maintained, and the utilization is the count of READ DATA/WRITE DATA events
during that time.

+ Bank Command Counters— Provides additional bank-level detail for the ACTI-
VATE, READ, and WRITE commands. This allows analysis of how the accesses are
distributed across banks as well as the efficiency of ACTIVATE commands at the bank
level.

» Events— Raw event registers for each Chip Select including ACTIVATE, READ,
WRITE, BURST, PRECHARGE, REFRESH, READ DATA, and WRITE DATA. Va-
ues are pulsed for one cycle for the event, with the bit position representing the bank
where the command is active. For example, an ACTIVATE Bank 3 command pulsesthe
value 0x0008 on the ACTIVATE Event (bit 3 is asserted).
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C.3 Specific Requirements for DDRx Memory Models

The following sections provide details of the file locations and compile-time parameter require-
ments of each DDRx Memory Model that Cycle Model Studio supports:

« DDR Memory

« DDR2 Memory

+ DDR3/DDR4 Memory
 LPDDR2/LPDDR3 Memory
« GDDR5 Memory

C.3.1 DDR Memory

Directory
$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr

RTL File
$CARBON_HOMFE/lib/carbonRTL/carbon_memory_ddr/carbon_memory_ddr.v

Compilation Command File

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr/carbon_memory_ddr.cmd

Verilog Parameters

See “Configuring DDRx Size and Signal Timing” on page 223 for details.

CS BITS
DATA_BITS
MAX_ADDR BITS
DQS IN_DELAY
DQS OUT_DELAY
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SoC Designer Parametersfor DDR

The following parameters can be changed in the SoC Designer Canvas only. Init-time
parameters can be changed in the SoC Designer Canvas only; run-time parameters can be
changed in the SoC Designer Canvas and at runtime during simulation.

Table C-2 DDR Parameters

Parameter Description

<component_name>_Address Format | Allowsyou to select between
Row_Bank_Column (RBC) or
Bank_Row_Column (BRC) format.

<component_name>_Bank_Bits Sets the number of bits used for the bank
portion of the address. The maximum value
is2.

<component_name> Row_Bits Sets the number of bits used in the row por-
tion of the address. The maximum valueis
16.

<component_name>_Column Bits Sets the number of bits used in the column
portion of the address. The maximum value
is15.
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C.3.2 DDR2 Memory

Directory

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr2

RTL File

$CARBON_HOMFE/lib/carbonRTL/carbon_memory_ddr2/carbon_memory_ddr2.v

Compilation Command File

$CARBON_HOMFE/lib/carbonRTL/carbon_memory_ddr2/carbon_memory_ddr2.cmd

Verilog Parameters

See “Configuring DDRx Size and Signal Timing” on page 223 for details.

CS BITS
DATA_BITS
MAX_ADDR BITS
DQS IN_DELAY
DQS OUT_DELAY

SoC Designer Parametersfor DDR2

The following parameters can be changed in the SoC Designer Canvas only. Init-time parame-
ters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in
the SoC Designer Canvas and at runtime during simulation.

Table C-3 DDR2 Parameters

Parameter

Description

<component_name>_Address Format

Allows you to select between
Row_Bank_Column (RBC) or
Bank_Row_Column (BRC) format.

<component_name>_Bank_Bits

Sets the number of bits used for the bank
portion of the address. The maximum value
is3.

<component_name>_Row_Bits

Sets the number of bits used in the row por-
tion of the address. The maximum valueis
16.

<component_name>_Column Bits

Sets the number of bits used in the column
portion of the address. The maximum value
is15.
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C.3.3 DDR3/DDR4 Memory

Directory

« DDR3— $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr3
« DDR4 — $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr4

RTL File

+ DDR3— $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr4/
carbon_memory_ddr3.v

+ DDR4 — $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr4/
carbon_memory_ddr4.v

Compilation Command File

+ DDR3— $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr3/
carbon_memory_ddr3.cmd

« DDR4 — $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr4/
carbon_memory_ddr4.cmd

Verilog Parameters

See “ Configuring DDRx Size and Signal Timing” on page 223 for details.

CS BITS

DATA_BITS

MAX_ADDR BITS

DQS IN_DELAY

DQS OUT_DELAY
WRITE_PREAMBLE
READ_PREAMBLE (DDR4 only)
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SoC Designer Parametersfor DDR3/DDR4

The following parameters can be changed in the SoC Designer Canvas only. (Init-time parame-
ters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in
the SoC Designer Canvas and at runtime during simulation.)

Table C-4 DDR3/DDR4 Parameters

Parameter

Description

<component_name>_Address Format

Allows you to select between
Row_Bank_Column (RBC) or
Bank_Row_Column (BRC) format.

<component_name>_Bank_Bits

Sets the number of bits used for the bank
portion of the address. The maximum value
is3.

<component_name>_Row_Bits

Sets the number of bits used in the row por-
tion of the address. The maximum valueis
16.

<component_name>_Column Bits

Sets the number of bits used in the column
portion of the address. The maximum value
is 15.
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C.3.4 LPDDR2/LPDDR3 Memory

This section describes both the LPDDR2 and LPDDR3 memory types.

Directory

+ LPDDR2 — $CARBON_HOMFE/lib/carbonRTL/carbon_memory_lpddr2
+ LPDDR3— $CARBON_HOME/lib/carbonRTL/carbon_memory_Ipddr3

RTL File

+ LPDDR2 — $CARBON_HOME/lib/carbonRTL/carbon_memory_|pddr2/
carbon_memory_|pddr2.v

 LPDDR3— $CARBON_HOME/lib/carbonRTL/carbon_memory_|pddr3/
carbon_memory_|pddr3.v

Compilation Command File

+ LPDDR2 — $CARBON_HOME/lib/carbonRTL/carbon_memory_Ipddr2/
carbon_memory_lpddr2.cmd

+ LPDDR3— $CARBON_HOME/lib/carbonRTL/carbon_memory_|pddr3/
carbon_memory_lpddr3.cmd

Verilog Parameters

See “Configuring DDRx Size and Signal Timing” on page 223 for details.

CS BITS
DATA_BITS

MAX_ADDR BITS

DQS IN_DELAY

DQS OUT_DELAY
WRITE_PREAMBLE (LPDDR3 only)
MR8_SETTING
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SoC Designer Parametersfor LPDDR2 and LPDDR3

The following parameters can be changed in the SoC Designer Canvas only. Init-time parame-
ters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in
the SoC Designer Canvas and at runtime during simulation.

Table C-5 LPDDR2 AND LPDDR3 Parameters

Parameter Description

<component_name>_Address Format | Allowsyou to select between
Row_Bank_Column (RBC) or
Bank_Row_Column (BRC) format.

<component_name>_Bank_Bits Sets the number of bits used for the bank
portion of the address. The maximum value
is3.

<component_name>_Row_Bits Sets the number of bits used in the row por-
tion of the address. The maximum value
is16.

<component_name>_Column Bits Sets the number of bits used in the column
portion of the address. The maximum value
is14.

<component_name>_tdgsck Sets the value used to specify any addi-
tional delay from nominal clock cycles.
Note you can specify half cycles. Default
valueis0.0.

C.3.5 GDDR5 Memory

Due to the unique requirements of the GDDRS5 protocol, the GDDR5 Memory Modd is dlightly
different from the other DDRx Memory Models. Rather than modeling the full memory subsys-
tem in an abstract manner with multiple chip selects and common control signals, the GDDR5
Memory Model implements a single logical memory block while exposing the underlying indi-
vidual device model signals. This alowstotal flexibility in integrating the model with a mem-
ory controller, while still providing a consolidated logical debug view of the memory.

For more details concerning the supported features and limitations of the GDDR5 Model,
please examine the RTL sourcefile.

Directory
$CARBON_HOMFE/lib/carbonRTL/carbon_memory_gddr5

RTL File
$CARBON_HOMFE/lib/carbonRTL/carbon_memory_gddr5/carbon_memory_gddr5.v
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Compilation Command File

$CARBON_HOME/lib/carbonRTL/carbon_memory_gddr5/carbon_memory_gddr5.cmd

Verilog Parameters

DEVICE_BYTE_LANES — Number of bytes each underlying device implements. Allowed
values are 2 and 4, representing 16 bit and 32 bit wide devices, respectively.

DEVICES PER_RANK — Number of devices present in this memory system. The total data
width of the memory model is given by 8*DEVICE_BYTE_LANES*DEVICES PER_RANK.

MAX_ADDR_BITS — Aswith other DDRx Memory Models, this parameter represents the
maximum number of bits that together make up the bank, row, and column address fields. Itis
recommended that this parameter is left at its default setting of 24, which is the maximum
allowed by standard GDDR5 devices.

SoC Designer Parameter Description

The following parameters can be changed in the SoC Designer Canvas only. Init-time parame-
ters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in
the SoC Designer Canvas and at runtime during simulation.

Table C-6 GDDR5 Parameters

Parameter Description
<component_name>_Address Allows you to select between
_Format Row_Bank_Column (RBC) or

Bank_Row_Column (BRC) format.

<component_name> Bank_Bits Setsthe number of bits used for the bank portion
of the address. Allowed values are 3 and 4.

<component_name>_ Row_Bits Sets the number of bits used in the row portion
of the address. Allowed values are 12 and 13.

<component_name>_Column Bits | Setsthe number of bits used in the column por-
tion of the address. Allowed valuesare6 and 7.
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